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Preface

I. Overview of     General Science Labs with Computers: Student Workbook    
(CI-7041A)

This manual has thirty activities in the following areas: scientific method, life science, earth
science, and physical science. Most of these activities can be done with the sensors that are
included in the General Science Bundles for the ScienceWorkshop 500 Interface.

Each activity has the following parts:

Equipment List Procedure

Purpose (What Do You Think?) Analyzing the Data

Background Lab Report

Safety Reminders

Equipment List

The list includes PASCO equipment (in bold font), other equipment, consumables (if any), and
quantities.

Purpose (What Do You Think?)

The purpose includes a question for the student to answer in the Lab Report section.

Background

This section provides information about the concepts in the activity.

Safety Reminders

General safety reminders include following instructions for using the equipment and wearing
protective gear (e.g., goggles, gloves, apron).

Procedure

The procedure is a basic outline of how to get started, how to set up equipment, and how to use
DataStudio or ScienceWorkshop to record data. The procedure has four sections:

•  Set up the interface.

•  Open the DataStudio or ScienceWorkshop file.

•  Set up the equipment.

•  Do the experiment (record the data).

Analyzing the Data

This section outlines methods and makes suggestions for using built-in analysis tools in the
software to analyze the data.

Lab Report

The Lab Report section is where students can record their data and answer the questions. The
Student Workbook pages are perforated so the student can easily remove the Lab Report pages.
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II. Safety Reminders

PASCO scientific assumes no responsibility or liability for use of the equipment, materials,
or descriptions in this book.

•  Take safety precautions to protect yourself during    all    activities in the lab, and especially
during the lab activities in this manual.

•  It is not possible to include every safety precaution or warning! Please use extra care when
setting up and using the equipment.

•  Be sure to wear protective gear such as goggles or safety glasses to protect your eyes and
face.

•  Be careful around open flames and when using a hot plate.

•  Use tongs when handling anything hot. Before touching something that you think might be
hot, place the back of your hand near the object to sense its temperature.

•  If you have a question, please ask for help.

SAFETY REMINDERS

•  Wear protective gear.

•  Follow directions for using the equipment.

III. Acknowledgements

The editor thanks all of the people who helped in writing, revising or editing the activities in this
manual.

October 28, 1999.
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Quick Reference Guide for DataStudio
Create an Experiment

(1) Double-click a sensor.

(2) Double-click a display.

What You Want To Do How You Do It Button

Start recording data Click the ‘Start’ button or select ‘Start Data’ on
the Experiment menu (or on the keyboard
press CTRL - R (Windows) or Command - R
(Mac))

Stop recording (or monitoring) data Click the ‘Stop’ button or select ‘Stop Data’ on
the Experiment menu (or on the keyboard
press CTRL - . (period ) (Win) or Command - .
(Mac))

Start monitoring data Select ‘Monitor Data’on the Experiment menu
(or on the keyboard press CTRL - M (Win) or
Command - M (Mac))

none

On the Graph Display In the Graph Toolbar Button

Re-scale the data so it fills the Graph
display window

Click the ‘Scale to Fit’ button.

Pinpoint the x- and y-coordinate
values on the Graph display

Click the ‘Smart Tool’ button. The coordinates
appear next to the ‘Smart Tool’.

‘Zoom In’ or ‘Zoom Out’ Click the ‘Zoom In’ or ‘Zoom Out’ buttons.

Magnify a selected portion of the
plotted data

Click the ‘Zoom Select’ button and drag across
the data section be to magnified.

Create a Calculation Click the ‘Calculate’ button

Add a text note to the Graph Click the ‘Note’ button.

Select from the  Statistics menu Click the Statistics menu button

Add or remove a data run Click the ‘Add/Remove Data’ menu button

Delete something Click the ‘Delete’ button

Select Graph settings Click the ‘Settings’ menu button
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Experiment Setup Window

Graph Display

Sensor icon

Sensors list To ‘Sampling
Options’ window

To ‘Calculator’
window

To ‘Curve Fit’
window

Graph
Toolbar

Legend
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Instructions – Using the Interface and DataStudio
There are several features that make DataStudio a unique and powerful teaching tool for science
and math. Section #1 covers the mechanics of the interface. Section #2 covers setting up an
experiment with the software. Section #3 covers data analysis in more detail.

Hint:  Working at a computer with DataStudio up and running while reading these instructions
will bring a “hands-on” experience to the user and enhance the learning process.

Section # 1: ScienceWorkshop 500 Interface

Data Logging with the ScienceWorkshop  500 Interface Box

If you want to disconnect the interface box and use it for data logging, be sure to install four AA
batteries in the bottom of the interface.

After you have set up an experiment
in DataStudio, click the ‘Logging’
button in the Experiment Setup
window in the software. Follow the
instructions about saving your
experiment. Disconnect the interface
from the computer and the power
supply. (Make sure that the switch on
the back of the interface is in the ON
position.)

After you have disconnected for
logging, use the LOG button  when
you want to record data. Press the
Log button once to begin data
collection, and press it a second time
to end that data run. Repeat this
sequence to collect more sets of data points that will be called RUN #2, RUN #3, etc

Caution: In the remote data-logging mode, the ON switch at the back of the box must remain on
at all times. Loss of power will result in loss of data.

After you have collected data, reconnect the interface to the computer and the power supply.

Click the ‘Connect’ button in the Experiment Setup window in the software. Your data will
download automatically.

The green LED (light-emitting diode) on the front of the interface box indicates the mode of
the interface box. A green light indicates that the power is ON. When you disconnect the
interface for remote data logging the light will flash slowly when in the sleep mode and rapidly
when you are collecting data. (Refer to the label on the top of the interface for details).

The Analog Channels allow up to three analog sensors to be plugged into the 500 interface. You
can plug in an analog sensor’s DIN plug in only one way. The Temperature Sensor is an
example of an analog sensor.

The Digital Channels allow one or two digital sensors to be plugged into the 500 interface. The
Photogate and Motion Sensor are examples of digital sensors. For example, you can connect two
Photogates or one Motion Sensor to a 500 interface.
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Section #2: Setting Up Your Own Experiment in DataStudio

The Summary List and the Setup Window

Start DataStudio. In the ‘Welcome to DataStudio™’ window, click ‘Create Experiment’.

The first step to becoming proficient with DataStudio is to understand the Summary List and the
Experiment Setup window. The Summary List shows runs of data (under ‘Data’) and the
available displays (under ‘Displays’). The Experiment Setup window shows the list of sensors
(under ‘Sensors’) and the interface that is connected.

Select a sensor. The sensors are listed by name. Scroll through the list to find the ‘Voltage
Sensor’, and then double-click the sensor to select it.
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The Voltage Sensor icon appears below Channel A of the interface, and ‘Voltage, ChA (v)’
appears in the Data list.

Now, select a display. Double-click ‘Graph’ in the Displays list.

Graph 1 opens, and ‘Graph 1’ appears in the Displays list. Also, ‘Voltage, ChA NO DATA’

appears in the Graph’s legend.

Finally, click the ‘Start’ button ( ) to begin recording data.

When you are finished, click ‘Stop’.
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The Menu Bar

The menu bar at the top of the Experiment Setup window is very similar to menus bars found in
Macintosh® and Windows® programs.

•  Use the File menu to make a new activity, open an activity, save an activity, save an activity
with a specific filename or in a specific location, import data, export data, select options (for
saving to or opening from a particular directory), setup the page for printing, print, or quit.

•  Use the Edit  menu to undo, cut, copy, paste, delete, or select all.

•  Use the Experiment menu to control the data collection, delete the last data run, disconnect
for data logging or re-connect after data logging, set sampling options, open a new empty
data table, or add a display.

•  Use the Window menu to close, minimize, or maximize a window, to tile or cascade
windows, or to select a window so it ‘pops-to-the-top’.

•  Use the Display menu to export data or a picture of a display or to activate any of the buttons
in a display’s toolbar.

•  Use the Help menu to open the online help files, see the most recent help message, turn on or
turn off the tips and confirmation windows, or change the license key.

Features of the Experiment Setup Window

In addition to the Sensors list, the Experiment Setup window has a button to open the ‘Sampling

Options’ window ( ), a button to open the ‘Timers’ window ( ) (for use

with Photogates), and a ‘Logging’ button ( ) for use when you disconnect the
interface for data logging.

Note: After you click the ‘Logging’ button, a ‘Connect’ button ( ) appears. If you
disconnect for data logging and then re-connect after collecting data, click the ‘Connect’ button
after you re-connect the interface to the computer and power supply.

Use the ‘Sampling Options’ window to set a ‘Delayed Start’, an ‘Automatic Stop’ or to set the
‘Manual Sampling Control’.
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Section #3: Data Analysis

DataStudio offers several ways to analyze data:

•  Use the built-in analysis tools in the Graph display toolbar

•  Use the ‘Calculator’ to create calculations based on your measured data or on a range of
numbers that you select.

•  Use the ‘Curve Fit’ to compare your data to mathematical models.

In the Graph display toolbar, the built-in analysis tools include the ‘Smart Tool’ button (),

the ‘Slope Tool’ button ( ), the ‘Fit’ menu button ( ), the ‘Calculate’ button

( ), and the ‘Statistics’ menu button ( ).

•  Use the ‘Smart Tool’ to see the coordinates of any point.

•  Use the ‘Slope Tool’ to see the slope of a line tangent to a point on a
curve.

•  Use the ‘Fit’ menu button to select a mathematical model.

•  Use the ‘Calculate’ button to create a calculation on the data in your
Graph.

•  Use the ‘Statistics’ menu button to select basic statistics such as
‘Minimum’ or ‘Maximum’ or to find the area under a curve.
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Click the ‘Calculate’ button in the main toolbar ( ) to open the ‘Calculator’
window:

Use the ‘Definition:’ area to create your own calculation, or use the ‘Scientific’, ‘Statistical’, or
‘Special’ menus to select a specific calculation to apply to your data. After you have created the
calculation, click ‘Accept’. Your calculation will appear in the Data list. You can drag your
calculation to a Graph display, for example

Click the ‘Curve Fit’ button in the main toolbar ( ) to open the ‘Curve Fit’
window. Click the ‘New’ button.

Select a mathematical model, or select ‘User Defined’ to create your own.

You can enter values for the coefficients or ‘lock’ a coefficient. After you have created the
mathematical model, click ‘Accept’. Your curve fit will appear in the Data list. You can drag
your curve fit to a Graph display, for example.

Online Help

Click ‘Contents’ or ‘Search…’ in the Help menu to open the online help file. You can use the
online help file to learn about any button, icon, menu, control, function or feature of the program.
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Quick Reference Guide for ScienceWorkshop
In the Experiment Setup Window:

What You Want To Do To How You Do It What the
Button Looks

Like

Begin recording data Click the Record (REC) button
or select Record on the Experiment menu
(or on the keyboard press CTRL - R (Windows)
or Command - R (Mac))

Stop recording (or monitoring) data Click the Stop (STOP) button
or select Stop on the Experiment menu
(or on the keyboard press CTRL - . (period )
(Win) or Command - . (Mac))

Begin monitoring data Click the Monitor (MON) button
or select Monitor on the Experiment menu
(or on the keyboard press CTRL - M (Win) or
Command - M (Mac))

On the Graph Display:

Re-scale the data so it fills the Graph
display window

Click the Graph display and click the Autoscale
button

Pinpoint the x- and y-coordinate
values on the Graph display

Click the Smart Cursor button and move the
cross hairs onto the graph (the exact values for
the coordinates will appear next to each axis
label)

Magnify a selected portion of the
plotted data

Click the Magnify button, and drag across
the data section be to magnified

Activate the Statistics Menu Click the Statistics button

Open the Statistics Menu Click the Statistics Menu button

See a list of all your Data Runs Click the Data button

Select Data Runs for display Click the Run # in the Data menu (Shift-click to
select more than one run)

Add another plot to your Graph
display

Click the Add-A-Plot button and select the
desired input from the pop-up menu

Import match data and plot it on the
Graph display

Copy the match data to the clipboard, click the
Plot Data Options button, and click Paste, OK,
OK
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Experiment Setup Window

Graph Display

Y-axis
(Click to change
range of y-axis.)

Statistics Menu
button

Statistics AreaX-axis
(Click to change
range of x-axis.)

X-axis Input
button

Autoscale
button

Add-A-Plot
menu button

Display Options
button

Smart Cursor  button

Statistics  button

Magnify  button

DATA menu button
(Select Data Runs for
the display.)

Plot Data  Options
(e.g., import match
data.)

Plot Input  menu
button

Monitor  button

Record  button

Stop  button Digital Channe l icons

Analog
Channe l
icons

Minimize
button (click
to show only
the left panel
of the Setup
window)

Analog
plug  icon

Display iconsExperiment
Calculator
button

Digital
plug  icon

Experiment
Notes  button

Click to adjust
sampling rate.

Data Runs  will be
listed here.

Pause  button
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Instructions – Using ScienceWorkshop®
There are several features that make ScienceWorkshop a unique and powerful teaching tool for
science and math. Section #1 covers the mechanics of the software and hardware. Section #2
covers the data analysis tools in more detail.

Hint:  Working at a computer with ScienceWorkshop up and running while reading these
instructions will bring a “hands-on” experience to the user and enhance the learning process.
You should keep the Quick Reference Guide for ScienceWorkshop available as a reference.

Section # 1: Experiment Setup

The ScienceWorkshop  500 Interface
Box

Use the LOG button  when you want
to disconnect the interface from the
computer and take it into the field for
data collection. Press it once to begin
data collection, and press it a second
time to end that data run. Repeat this
sequence to collect more sets of data
points that will be called RUN #2,
RUN #3, etc. If you want to
disconnect the interface box from the
power supply, be sure to install four
AA batteries in the bottom of the
interface. (Make sure that the switch
on the back of the interface is in the
ON position.)

Caution: In the remote data logging mode, the ON switch at the back of the box must remain on
at all times. Loss of power will result in loss of data.

The green LED (light-emitting diode) on the front of the interface box indicates the mode of
the interface box. A green light indicates that the power is ON. When you disconnect the
interface for remote data logging the light will flash slowly when in the sleep mode and rapidly
when you are collecting data. (Refer to the label on the top of the interface for details).

The Analog Channels allow up to three analog sensors to be plugged into the 500 interface. You
can plug in an analog sensor’s DIN plug in only one way. The Temperature Sensor is an
example of an analog sensor.

The Digital Channels allow one or two digital sensors to be plugged into the 500 interface. The
Photogate and Motion Sensor are examples of digital sensors. For example, you can connect two
Photogates or one Motion Sensor to a 500 interface.
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The Experiment Setup Window

The first step to becoming proficient with
ScienceWorkshop is to understand the
various icon and buttons in the Experiment
Setup window. The window is
automatically displayed whenever a new
ScienceWorkshop file is opened. If you get
a “Can’t find interface box” message, the
interface is either missing or not properly
connected. Be sure that the power to the
interface box is ON and that the connector
cables are secure.

The Menu Bar

The menu bar at the top of the Experiment Setup window is very similar to menus bars found in
Macintosh® and Windows® programs.

•  Use the File  menu to open, close, save, print, and import data.

•  Use the Edit  menu to copy, cut, clear, and paste data or runs of data.

•  Use the Experiment menu to control the data collection.

You can also use the Experiment menu to Record, Monitor , Pause, or Stop data collection
(as if you had used the buttons in the Experiment Setup window). You can use this menu to
access the sampling options, disconnect/connect (for remote data logging), display the
Experiment Setup window, or go to the Experiment Notes and Calculator windows.

•  Use the Display  menu to select any of the six display windows (either to set up a new display or
toggle to a display already in use).

Features of the Experiment Setup Window

 The Record button is in the top left corner of the Experiment Setup window. Press this
button to collect data and store the data in memory. The flashing bar below the button shows
when ScienceWorkshop is collecting data.

 The Monitor Data button is next to the Record button. Press this button to collect and
display data in a view mode only. None of the data are saved in memory. For example, use this
feature when you want to check to see if a sensor is working properly, and also when viewing
data in the Scope display.

 Press the Stop button to stop data collection in both the record and monitor modes.

 Press the Pause button to temporarily interrupt data collection. Press it again when you
want to continue collecting data.
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 Press the Sampling Option button to open a window where you can select
the Periodic Samples rate, the Start and Stop Conditions, and Keyboard Sampling. The default
Periodic Samples rate is 10 samples per second (10 Hz) for an analog sensor and 10,000
samples per second for a digital sensor. You can vary the Periodic Samples rate from 20,000 Hz
(Fast) to 3600 seconds (Slow).

Suggested Periodic Sampling rates for common measurements:

Temperature Sensor     2 –  10 Hz
Light Sensor                 10 Hz
Voltage Sensor             10 Hz

 Press the Experiment Calculator button to open the Experiment Calculator window that
allows you to do mathematical operations on collected data. You can also use it as a stand-alone
calculator.

 Drag the digital plug icon to Digital Channel 1 or 2 to add a digital sensor to the
Experiment Setup window, and then select the correct digital sensor from the list of sensors that
opens. Click OK to return to the Experiment Setup window.

 Drag the analog plug icon to Analog Channel A, B, or C to add an analog sensor to the
Experiment Setup window. Then select the correct analog sensor from the list of sensors than
opens. Click OK  to return to the Experiment Setup window.

Setting Up Your Own Experiment in ScienceWorkshop

1. Drag an
analog plug icon
or a digital plug
icon  to the icon that
corresponds to the
channel on the 500
Interface box that
you plugged the
sensor into.
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Note: ScienceWorkshop has many advanced features. Refer to the ScienceWorkshop User’s
Guide that came with the interface for more information.

Section #2: Data Analysis

Analysis: The Smart Cursor  

The Smart Cursor allows you to investigate individual points on a graph.

Procedure: Click the Smart Cursor in any display that has the Smart Cursor icon (for example,
the Graph display). The cursor changes to a cross hair and the y and x values for that individual
position will be displayed on the y-axis and x-axis. If you desire to have the change in y or x
coordinates displayed, click-and-drag the Smart Cursor over the desired area. The difference (y2
- y1 and x2 - x1) will be displayed on the y-axis and x-axis. (This ability to display the change in
x and the change in y in a selected area is called the delta feature.)

2. Choose the sensor
from the sensor list that
pops up. Click OK to return
to the Experiment Setup
window.

3. Drag a
display icon to
the Sensor
icon.

You are
ready to
collect
data!
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The Statistics Tool 

The Table and Graph displays have built-in statistics. Click the Statistics button to open the
statistics area at the bottom of a Table or on the right side of a Graph.

Statistics menu for a Table display

In the Graph display, click the Statistics Menu button to see the
statistics options.

Statistics menu for a Graph display

Curve Fit submenu

Linear Fit  will generate a basic slope equation with the slope of the best-fit line being the a2 value in the
display.

The Experiment Calculator

Use the Experiment Calculator feature of ScienceWorkshop to create a new calculation that is
based on the input data. For example, if data is displayed in degrees Celsius, you can use the
calculator to create a calculation to display the temperature data in degrees Fahrenheit or degrees
Kelvin.

To set up a calculation, click the Calculator button   in the Experiment Setup window. You
can also open the Experiment Calculator by selecting Calculator Window  from the Experiment
menu.
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Experiment Calculator window

Example:
Converting the temperature
data from degrees Celsius to
degrees Fahrenheit for
plotting on the Graph
display.

Changing the plotting
parameters of the
Graph display

                                         

Note: The values for this calculation can also be displayed in any Table, Digits, or Meter display.
To do this, select Calculations, Temperature, (Temp ˚F)  from the Input  menu of the display.

1. Type the
formula here

(Select the variable to
be modified from the
Input Menu)

2. Fill in these
dialog boxes

3. Click = or press
ENTER

4. On the Graph display, click the Plot Input
Menu button, and select
Calculations, Temperature, (Temp ˚F)

(Temperature will be plotted in ºF)
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Tutorial Activities – Exploration of Sensors

Practice using the sensors included in the General Science Bundles.

• Connect the ScienceWorkshop interface to the computer, turn on the interface, and turn on
the computer.

Economy Force Sensor

The Economy Force Sensor measures
forces between +50 and –50 newtons.
The sensor output is +8 volts for a
force of +50 newtons and –8 volts for
a force of –50 newtons. Pushing on
the sensor’s detachable hook
produces a positive voltage and
pulling produces a negative voltage.

The sensor has an attached cable for
connecting to the interface. It also has a built-in over-limit protector in the case so the sensor will
not be damaged if a force above 50 newtons is applied. The housing has a thumbscrew for
mounting the sensor on a rod, and a long thumbscrew for mounting the sensor on a PASCO cart
or onto the Accessory Bracket with Bumpers.

The sensor has one built-in control.

Tare Button: Use the tare button to zero the sensor before making measurements.

To calibrate the sensor you will need an object of known mass, such as one kilogram.

Set up the sensor with the interface

• Plug the sensor cable into Analog Channel A on the interface.

Set up the sensor in the software

•  In DataStudio, double-click the ‘Force
Sensor” in the Sensors list in the Experiment
Setup window. Result: The sensor icon
appears below Channel A of the interface.
The sensor’s parameters (e.g., Force) appear
in the Data list.

• In ScienceWorkshop, click-and-drag the
‘analog sensor plug’ icon to the Channel A
icon in the Experiment Setup window, select
the name of the sensor from the list of
sensors and click ‘OK’ to return to the
Experiment Setup window. Result: The
sensor’s icon appears below Channel A of
the interface.
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Calibrate the sensor

The general method for calibrating the force sensor is as follows:

1. In the Experiment Setup window, double-click the sensor’s icon.

• Result: In DataStudio, the Sensor Properties window opens. Click the ‘Calibration’ tab. In
ScienceWorkshop, the Sensor Setup window opens.

2. Calibrate the software.

• First , arrange the sensor as it will used for making measurements but DO
NOT apply a force to the sensor. Press the ‘tare’ button to zero the sensor.

• Second, check the voltage under ‘Current Reading’ in DataStudio or next to
‘Cur Value:’ in ScienceWorkshop. When the voltage stabilizes, click the ‘Take Reading’
button under ‘Low Point’ in DataStudio or the ‘Read’ button in the row for ‘Low Value:’
in ScienceWorkshop. Enter ‘0’ as the force value.

• Third , use the object of known mass to apply a pulling force on the hook. When the
voltage stabilizes, click the ‘Take Reading’ button under ‘High Point’ in DataStudio or the
‘Read’ button in the row for ‘High Value:’ in ScienceWorkshop. Enter the force value. For
example, enter ‘9.8’ for a one kilogram mass.

3. Click ‘OK’ to return to the Experiment Setup window.
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Set up a display

•  In DataStudio, double-click ‘Graph’ in the Displays list. Result:
The display automatically shows force.

•  In ScienceWorkshop, click-and-drag the ‘Graph’ display icon

( ) to the sensor’s icon in the Experiment Setup window.

Start recording data

• Press the tare button on the sensor to zero it.

•  In DataStudio, click the ‘Start’ button ( ). In ScienceWorkshop, click the ‘REC’

button ( ).

•  Pull and push the hook on the end of the sensor and watch the results on the Graph display.

Stop recording data.

• Click ‘Stop’ to end data recording.

Tare button
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Heart Rate Sensor

The Heart Rate Sensor monitors
the flow of blood through a part
of the body, such as an ear lobe,
by shining a light through it. The
intensity of the light passing
through the ear lobe depends on
the amount of blood flowing
through the blood vessels in the
ear lobe. As the heart contracts
and relaxes, the amount of blood
flowing through the ear lobe
changes and the light intensity
transmitted through the ear lobe
changes.

1. Set up the sensor.

• Plug the DIN connector cable into the sensor’s DIN plug and then
connect the cable into Analog Channel A on the interface.

• Connect the ear clip plug into the top of the sensor.

• Pinch the sides of the ear clip so it opens.

• Place the open ear clip on your ear lobe and release the sides of the
clip.

2. Set up the sensor in the software.

•  In DataStudio, double-click the name of the sensor in the Sensors list in the Experiment
Setup window.

•  The sensor icon will appear below Channel A of the interface. The sensor’s parameters
(e.g., Voltage, Heart Rate, etc.) will appear in the Data list.
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• In ScienceWorkshop, click-and-drag the ‘analog sensor plug’ icon to the Channel A icon in
the Experiment Setup window, select the name of the sensor from the list of sensors and
click ‘OK’ to return to the Experiment Setup window. The sensor’s icon will appear below
Channel A of the interface.

3. Set up a Digits display of ‘Heart Rate’.

•  In DataStudio, click-and-drag the ‘Digits’ icon from the Displays list
and drop it on ‘Heart Rate’ in the Data list.

•  In ScienceWorkshop, click-and-drag the ‘Digits’ display icon to the
sensor’s icon in the Experiment Setup window.

4. Start recording data.

•  In DataStudio, click the ‘Start’ button ( ). In

ScienceWorkshop, click the ‘REC’ button ( ).

•  Note the heart rate in the Digits display.

5. Stop recording data. (Click ‘Stop’ to end data recording.)
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Light Sensor

The Light Sensor measures relative light
intensity. The sensing element is a photodiode
that produces a voltage proportional to the
light intensity across a wide spectrum ranging
from 350 nanometers to 100 nanometers (nm).

The sensor includes a cable for connecting to
the interface. The sensor has one built-in
control.

Gain Select Switch: Use the gain select
switch to set the maximum input light levels
of the sensor. The three settings are as
follows.

Gain Select setting Maximum Input (lux)

1 500

10 50

100 5

Set up the sensor with the interface

• Plug one end of the DIN-to-DIN cable into the sensor and then connect the other end of the
cable into Analog Channel A on the interface.

• Note: You can connect the sensor directly into the interface if needed.

Set up the sensor in the software

•  In DataStudio, double-click the name of
the sensor in the Sensors list in the
Experiment Setup window. Result: The
sensor icon appears below Channel A of
the interface. The sensor’s parameters
appear in the Data list.

• In ScienceWorkshop, click-and-drag the
‘analog sensor plug’ icon to the Channel
A icon in the Experiment Setup window,
select the name of the sensor from the list
of sensors and click ‘OK’ to return to the
Experiment Setup window. Result: The
sensor’s icon appears below Channel A of
the interface.
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Set up a display

•  In DataStudio, double-click the ‘Graph’ icon in the Displays list. Result: The display
automatically shows voltage versus time. To make the Graph show light intensity instead
of voltage, click-and-drag ‘Light Intensity, ChA’ from the Data list to the vertical axis of
the Graph display.

•  In ScienceWorkshop, click-and-drag the ‘Graph display’ icon to the Light Sensor icon in
the Experiment Setup window. Result: The Graph display shows ‘Intensity (% max)’
versus Time (s).

Start recording data

• Set the GAIN switch on the top of the Light Sensor to 1.

•  In DataStudio, click the ‘Start’ button ( ). In ScienceWorkshop, click the ‘REC’

button ( ).

• Move your hand over the Light Sensor, point the sensor at different light sources, and
watch the results on the Graph display.

Stop recording data.

• Click ‘Stop’ to end data recording.

Drag ‘Light Intensity,
Ch A’ to the Y-axis.
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Motion Sensor II

The Motion Sensor II is a sonar ranging device. It sends out ultrasonic pulses and detects echoes
of these pulses that are reflected from an object. The sensor includes a cable for connecting to the
interface. One end of the cable
connects to the sensor. The other end
has two stereo phone plugs that
connect to the interface. The yellow
plug carries the ‘transmit pulse’
signal from the interface. The other
plug returns the echo to the interface.

The sensor can measure objects as
close as 15 cm (0.15 m) or as far as 8
m. You can use the software to set
the number of pulses (the ‘trigger rate’) from as few as five per second to as many as 120 per
second.

The sensor has one built-in control.

Narrow/Standard (Std.) Switch: Set the switch to Narrow for measuring highly reflective
targets (such as a PASCO cart) at distances of 2 m or less. Set the switch to Std for measuring
targets that are poor reflectors or for distances longer than 2 m.

Note: On the Standard setting, you may need to tilt the sensor up by five or ten degrees to avoid
reflections from the front of the sensor housing or from a surface underneath the sensor.

For this activity you will need a meter stick and a highly reflective target, such as a book.

Set up the sensor

• Plug the modular connector on one end of the interface cable into the side of the Motion
Sensor. Connect the yellow phone plug into Digital Channel 1 on the interface. Connect
the other phone plug into Digital Channel 2.

• Place the sensor exactly one meter away from a target. Arrange the sensor and target so the
pulses from the sensor can reflect from the target and be detected by the sensor.
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Set up the sensor in the software

•  In DataStudio, double-click the name of the sensor in the Sensors list in the Experiment
Setup window. Result: The sensor icon appears below the digital channels of the interface.
The sensor’s parameters (e.g., Position, etc.) appear in the Data list.

• In ScienceWorkshop, click-and-drag the ‘digital sensor plug’ icon to the Channel 1 icon in
the Experiment Setup window, select the name of the sensor from the list of sensors and
click ‘OK’ to return to the Experiment Setup window. Result: The sensor’s calibration
window opens and the sensor begins to click a few times per second.

Calibrate the sensor

The general method for calibrating the motion sensor is as follows:

1. In the DataStudio Experiment Setup window, double-click the sensor’s icon. Result: The
Sensor Properties window opens.

2. Click the ‘Motion Sensor’ tab. Result: The calibration window opens and the sensor
begins to click a few times per second.

Find the name
of the sensor.
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3. Calibrate the software.

• First , make sure that the sensor is one meter from the target.

• Second, click the ‘Calibrate’ button in the Motion Sensor window. Result: The software
calculates the speed of sound based on the calibration distance (one meter) and the round
trip time of the pulse and echo

4. Click ‘OK’ to return to the Experiment Setup window.

Set up a display

•  In DataStudio, double-click the ‘Graph’ icon from the Displays list. Result: The Graph
display shows position versus time.

•  In ScienceWorkshop, click-and-drag the ‘Graph’ display icon to the sensor’s icon in the
Experiment Setup window. Select ‘Position, x (m)’ from the list of and click ‘Display’.
Result: The Graph display shows position versus time.

Start recording data

•  In DataStudio, click the ‘Start’ button ( ). In ScienceWorkshop, click the ‘REC’

button ( ).

• Move a target (such as a book) back-and-forth in front of the sensor. Watch the results on
the Graph display.

Stop recording data

• Click ‘Stop’ to end data recording.
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pH Sensor

The pH Sensor has an amplifier and a
pH electrode. The electrode produces
a voltage that is proportional to the
hydrogen ion concentration in a
solution. (Store the electrode in its
soaker bottle when you are not using
it.) The amplifier converts the
electrode voltages into the voltages
required by the ScienceWorkshop
interface.

For this activity you will need a cup
or beaker, some cranberry juice (or other fruit juice), and an antacid tablet (e.g., Alka-Seltzer®).
Fill the cup about half full with juice. Break the antacid tablet in half.

1. Set up the sensor.

• Plug the DIN connector cable into the sensor’s DIN plug
and then connect the cable into Analog Channel A on
the interface.

• Connect the pH electrode to the BNC port on the pH
Sensor. Line up the connector on the end of the cable
with the pin on the BNC port. Push the connector onto
the port and then twist the connector clockwise about
one-quarter turn until it clicks into place.

• Put the end of the pH electrode into the juice.

2. Set up the sensor in the software.

•  In DataStudio, double-click the name of the sensor in the Sensors list in the Experiment
Setup window.

•  The sensor icon will appear below Channel A of the interface. The sensor’s parameters
(e.g., pH, Voltage, etc.) will appear in the Data list.
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• In ScienceWorkshop, click-and-drag the ‘analog sensor plug’ icon to the Channel A icon in
the Experiment Setup window, select the name of the sensor from the list of sensors and
click ‘OK’ to return to the Experiment Setup window. The sensor’s icon will appear below
Channel A of the interface.

3. Set up a Graph display of pH versus Time.

•  In DataStudio, click-and-drag the ‘Graph’ icon from the Displays list and
drop it on ‘pH’ in the Data list.

•  In ScienceWorkshop, click-and-drag the ‘Graph’ display icon to the
sensor’s icon in the Experiment Setup window. Select ‘pH (pH)’ and
click ‘Display.

4. Start recording data.

• Put half of an antacid tablet into the fruit juice and stir with the end of the
pH electrode.

•  In DataStudio, click the ‘Start’ button ( ). In

ScienceWorkshop, click the ‘REC’ button ( ).

•  Note the change in pH in the Graph display.

5. After two minutes, stop recording data. (Click ‘Stop’ to end data recording.)
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Pressure Sensor

The Pressure Sensor includes a cable, a
syringe, tubing, and connectors for the
tubing.

The sensor can measure pressures as high as
700 kilopascals, or about seven atmospheres.
It is designed for non-corrosive gases. Do
not put liquids into the sensor.

For this activity you will need two drops of
glycerin, the syringe, a short piece of tubing,
and a quick-release connector.

Set up the sensor

• Plug the DIN connector cable into the sensor’s DIN plug and then connect the cable into
Analog Channel A on the interface.

• Prepare the syringe. Cut a short piece of tubing
(about 2 cm). Put a drop of glycerin on the barb
end of a quick-release connector. Put the barb
end of the connector into one end of the tubing.
Put a drop of glycerin on the tip of the syringe.
Put the tip of the syringe into the other end of the tubing. Pull out the piston so it is at
about the 10 cc mark.

• Connect the syringe to the sensor. Line up the quick-
release connector with the pressure port on the sensor.
Push the connector onto the port and turn the
connector clockwise until it clicks.

Set up the sensor in the software

•  In DataStudio, double-click the name of the sensor in the Sensors list in the Experiment
Setup window.

•  The sensor icon will appear below Channel A of the interface. Result: The sensor’s
parameters (e.g., Pressure) appear in the Data list.

700 kPa MAX

DRY AIR ONLY

PRESSURE PORT MATING

CONNECTOR:

PASCO PART NO. 640-021

PRESSURE

SENSOR

0-700 kPa

(ABSOLUTE)

CI-6
532A

PASCOscientific

300Interface

ANALOG CHANNELS

Science
Workshop™

Interface

500

scientific

PASCO

Science W
orkshop™

DATA LO G G ING
INSTRUCTIO NS

Find the name
of the sensor.

5 10



General Science Labs with Computers Student Workbook
Tutorial Activities: Pressure Sensor 012-06654B

A - 30 ©1999 PASCO scientific

• In ScienceWorkshop, click-and-drag the ‘analog sensor plug’ icon to the Channel A icon in
the Experiment Setup window, select the name of the sensor from the list of sensors and
click ‘OK’ to return to the Experiment Setup window. Result: The sensor’s icon appear
belows Channel A of the interface.

Set up a Graph display of Pressure versus Time

•  In DataStudio, double click the ‘Graph’ icon in the Displays list. Result: The display
automatically shows pressure versus time.

•  In ScienceWorkshop, click-and-drag the ‘Graph’ display icon to the sensor’s icon in the
Experiment Setup window. Result: The display automatically shows pressure versus time.

Start recording data

•  In DataStudio, click the ‘Start’ button ( ). In ScienceWorkshop, click the ‘REC’

button ( ).

• After a few seconds, push the piston in so it is at the 5 cc mark. Then pull the piston out so
it is at the 20 cc mark.

•  Note the change in pressure in the Graph display.

Stop recording data

• Click ‘Stop’ to end data recording.
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Temperature Sensor

The Temperature Sensor has a temperature
sensitive integrated circuit in its tip that
produces a voltage that is proportional to
temperature. The sensor is covered with
Teflon® tubing that is very chemical
resistant. The sensor includes a removable
Teflon sensor cover that is highly chemical
resistant.

The sensor’s operating range is from –5 ˚C
to 105 ˚C. Do not use the sensor in a direct flame or on a hot plate.

Set up the sensor

• Plug the sensor’s DIN plug into Analog Channel A on the interface.

Set up the sensor in the software

•  In DataStudio, double-click the name of the sensor in the Sensors list in the Experiment
Setup window. Result: The sensor’s icon appears below Channel A of the interface. The
sensor’s parameter (e.g., Temperature) appears in the Data list.

• In ScienceWorkshop, click-and-drag the ‘analog sensor plug’ icon to the Channel A icon in
the Experiment Setup window, select the name of the sensor from the list of sensors and
click ‘OK’ to return to the Experiment Setup window. Result: The sensor’s icon appears
below Channel A of the interface.

Find the name
of the sensor.
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Set up a Graph display of Temperature versus Time

•  In DataStudio, double-click the ‘Graph’ icon in the Displays list. Result: The Graph
display automatically shows ‘Temperature’ versus ‘Time’.

•  In ScienceWorkshop, click-and-drag the ‘Graph’ display icon to the sensor’s icon in the
Experiment Setup window. Result: The Graph display automatically shows ‘Temperature’
versus ‘Time’.

Start recording data

•  In DataStudio, click the ‘Start’ button ( ). In ScienceWorkshop, click the ‘REC’

button ( ).

• Measure the temperature of your hand. Place the tip of the sensor in the palm of your hand
and rub the sensor against your skin for several seconds. Note the temperature in the Graph
display. Then move the tip of the sensor from the palm along one of your fingers to the end
of the finger. Watch the change in temperature in the Graph display as you move the
sensor.

Stop recording data

• Click ‘Stop’ to end data recording.

Rescale the Graph display

• In DataStudio, click the ‘Scale-to-Fit’ button ( ) in the Graph display toolbar.

• In ScienceWorkshop, click the ‘Autoscale’ button ( ) in the Graph tool palette.
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Voltage Sensor

The Voltage Sensor measures voltages from –10 volts to +10
volts. The probe ends are stackable banana plugs. The sensor
comes with two insulated alligator clips.

For this activity you need a 1.5 volt battery.

Set up the sensor with the interface

• Connect the Voltage Sensor’s DIN plug into Analog
Channel A on the interface.

Set up the sensor in the software

•  In DataStudio, double-click the name of
the sensor in the Sensors list in the
Experiment Setup window. Result: The
sensor icon appears below Channel A of
the interface. The sensor’s parameters
appear in the Data list.

• In ScienceWorkshop, click-and-drag the
‘analog sensor plug’ icon to the Channel
A icon in the Experiment Setup window, select the name of the sensor from the list of
sensors and click ‘OK’ to return to the
Experiment Setup window. Result: The
sensor’s icon appears below Channel A of
the interface.

Set up a ‘Meter’ display

•  In DataStudio, double-click the ‘Meter’
icon in the Display list. Result: The
Meter display shows ‘Voltage, ChA’ and
‘Meter 1’ appears in the Display list.

Find the name
of the sensor.
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•  In ScienceWorkshop, click and drag the ‘Meter display’ icon to the Voltage Sensor icon in
the Experiment Setup window. The Meter display shows ‘Voltage (V)’.

Start recording data

•  In DataStudio, click the ‘Start’ button ( ). In ScienceWorkshop, click the ‘REC’

button ( ).

• Touch the red Voltage Sensor lead to one end of the battery and the black Voltage Sensor
lead to the other end. If the Meter display shows negative volts, reverse the Voltage Sensor
leads on the battery.

Stop recording data

• After about 90 seconds, stop recording data.

• Click ‘Stop’ to end data recording.

Remember to Use the Online Help

In DataStudio, click ‘Contents’ or ‘Search…’ in the Help menu to open the online help file. You
can use the online help file to learn about any button, icon, menu, control, function or feature of
the program.

In ScienceWorkshop for Macintosh, click ‘Show Balloons’ in the Help menu.
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Activity GS01: Fruit Battery – Electricity
(Voltage Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Electricity GS01 Fruit Battery.ds G01 Fruit Battery G01_BATT.SWS

Equipment Needed Qty Consumables Qty
Voltage Sensor (CI-6503) 1 Apple or other medium size fruit 1
Copper wire, 2 or 3 inches long 1
Zinc (galvanized) nail 1
Protective gear PS

What Do You Think?

In this activity you will measure the voltage of a "fruit battery*" using a Voltage Sensor. What
type of fruit will produce the most voltage? (*In this activity, the word 'battery' will be used in
place of 'cell'.)

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

One form of energy can be converted into another. For example, the
energy stored in a piece of food can be converted into energy that
helps you grow and move. The energy stored in certain kinds of food
can also be converted into electricity. A piece of fruit such as an apple
or orange can produce a voltage when electrodes made of different
metals are placed into the fruit.

An electrode is made from a material that can conduct electricity.

For You To Do

The Voltage Sensor has a pair of flexible
insulated wires joined by a type of plug called
a DIN plug. The plugs at each end of the
wires are called banana plugs. The Voltage
Sensor comes with a pair of clips called
alligator clips that can be slipped onto the end
of the banana plugs.

For this activity, use the Voltage Sensor to
measure the voltage (or potential difference)
produced by a piece of fruit that has a copper
electrode (copper wire) and a zinc electrode
(galvanized nail) in it. Use DataStudio or
ScienceWorkshop to record and display the measured voltages.

SAFETY REMINDERS

•  Follow directions carefully when using the equipment for this activity.

•  Wear protective gear (e.g., goggles, gloves, apron).

BANANA PLUGS

DIN PLUG

ALLIGATOR  CLIP

ALLIGATOR CLIP

VOLTAGE SENSOR, CI-6503, 
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Prediction

Will the voltage from a piece of fruit be as much as the voltage from a D size dry cell battery
(about 1.5 volts)? Predict what the voltage will be from the piece of fruit. Record your prediction
and the type of fruit you are going to use.

Type of fruit Predicted voltage (V)

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on
the interface, and then turn on the computer.

2. Connect the Voltage Sensor DIN plug into Analog Channel A
on the interface.

3. Open the file as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS01 Fruit Battery.ds G01 Fruit Battery G01_BATT.SWS

•  The DataStudio file has a Workbook display. Read the instructions in the Workbook.

•  The ScienceWorkshop document has an Experiment Setup window and an Experiment
Notes window. It also has a Table display, a Digits display, and a Meter display, all
showing voltage.

•  Data recording is set for ten measurements per second, or 10 Hz.

Experiment Setup window:

The window shows an icon for the kind of sensor. For this activity, the window shows the icon
for the Voltage Sensor below Analog Channel A.

Digits display:
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Meter display:

Table display:

The Table display has a display area that is similar to columns in a spreadsheet.
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PART II: Equipment Setup

1. Stick the piece of copper wire and the galvanized nail into the piece of fruit to turn it into a
battery.

To Interface

Alligator clip
(included with

Voltage
Sensor)

Fruit

Galvanized nail Copper wire

Voltage Sensor

Fruit Battery

2. Put alligator clips on the ends of the Voltage Sensor leads. Connect the red end of the
Voltage Sensor to the copper wire and the black end of the Voltage Sensor to the nail.

PART III: Data Recording

1. Start recording data.

• Watch the values of voltage in the Digits display and Meter display.

2. Record data for about 10 seconds.

3. Stop recording data.

Analyzing the Data

1. Set up the Table to show statistics.

2. Record the Max (maximum) value of voltage in the Data Table.

Record your results in the Lab Report section.
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Lab Report - Activity GS01: Fruit Battery

What Do You Think?

In this activity you will measure the voltage of a "fruit battery*" using a Voltage Sensor. What
type of fruit will produce the most voltage? (*In this activity, the word 'battery' will be used in
place of 'cell'.)

Data Table
Type of Fruit Maximum Voltage (V)

Optional

• Try inserting the electrodes to different depths.

• Try inserting the electrodes closer to each other or farther away from each other.

• Try different kinds of fruit.

• Try different    sizes    of the same kind of fruit.

Questions

1. How does your prediction compare to the actual value of maximum voltage? (Was your
prediction lower, higher, or very close?)

2. If you tried any of the optional activities, what were the results?

a. Did changing how far in the electrodes were make the voltage go up, go down, or stay the
same?

b. Did putting the electrodes closer together make the voltage go up, go down, or stay the
same?

c. Did putting the electrodes farther apart make the voltage go up, go down, or stay the same?
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d. Did a different kind of fruit make any difference? If so, what was the kind of fruit, and was
its voltage higher or lower than your first piece of fruit?

e. Did a different size of your kind of fruit make a difference? If so, did the voltage go up or
go down?

Ending the Activity

• Check with your instructor about putting away the equipment for this activity.

• Check with your instructor about disposing of the pieces of fruit after you are done with
them.

Computer Shutdown

When you have finished, you have several options.

1. You can select Quit  from the File  menu to end the activity.

2. You can select Save or Save As…  from the File menu to save your data for this activity and
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select Open…  from the File  menu, and find the
document for the next activity.
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Activity GS02: Variation of Light Intensity – Optics
(Light Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Optics GS02 Vary Light.DS G02 Light Bulb Intensity G02_BULB.SWS

Equipment Needed Qty Equipment Needed Qty
Light Sensor (CI-6504A) 1 Fluorescent light source (AC) 1
Flashlight (or other DC light source) 1 Incandescent light source (AC) 1

What Do You Think?

The purpose of this activity is to compare the variation in intensity (brightness) of light
from different kinds of light sources. One light source is a flashlight powered by
batteries (direct current  (DC)). Another is a fluorescent light bulb that is powered by
alternating current  (AC) and a third is an incandescent light bulb that is powered by
AC. How does the light from a DC light source compare to light from an AC light
source? How does the light from a fluorescent tube compare to the light from an
incandescent bulb?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Light bulbs convert electric energy into thermal energy and
light energy. We can feel the thermal energy as heat coming
from the light bulb. A flashlight bulb converts electric
energy into thermal energy and light energy when moving
electrons collide with the atoms of the small wire inside the
flashlight bulb. A fluorescent light bulb converts electric
energy when moving electrons collide with atoms of gas
inside the fluorescent light bulb.

In a circuit with a flashlight bulb and a battery, the electron
flow is in one direction. This type of electron flow is called
direct current. Once the flashlight is turned on, the

flashlight bulb shines steadily all the time
that it is on.

In a circuit with a fluorescent light bulb
that is connected to an electric outlet, the
electron flow is back-and-forth. This type
of electron flow is called alternating
current. Each back-and-forth movement of
electrons is called a cycle. In the United
States and other countries, the alternating
current from an electric outlet has sixty
cycles (back-and-forth) each second.

With alternating current (AC), the fluorescent light bulb will shine when the electron flow is in
one direction (to the left, for example) and will not shine while the electron flow    changes   
direction. It will shine again when the electron flow is in the opposite direction (to the right, for
example). The electrons flow in one direction or the other TWICE per cycle. In the U.S. and
other countries where the alternating current has sixty cycles each second, the fluorescent light
bulb turns on and off 120 times each second. Therefore, the light from a fluorescent bulb has a
maximum brightness 120 times each second.

Light bulb

Battery

Fluorescent tube
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One cycle each second is called one “hertz” (pronounced like “hurts”) and one hertz is
abbreviated “Hz”. The number of cycles each second is called the frequency. An alternating
current that has sixty cycles each second has a frequency of 60 hertz, or 60 Hz.

Fluorescent lights blink on and off at a
particular frequency. The light intensity from
incandescent bulbs powered by AC fluctuates
as well. The light intensity from an
incandescent bulb powered by DC should not
vary.

SAFETY REMINDERS

•  Follow directions for using the equipment.

For You To Do

In this activity, use the Light Sensor to measure the intensity of light from light bulbs powered
by AC or DC. There are three parts to the activity: Part A = Fluorescent bulb, AC; Part B =
Incandescent bulb, AC; and Part C = Incandescent bulb, DC.

Use DataStudio or ScienceWorkshop to monitor and display the variations, if any, in the light
intensity. Compare the light intensity of fluorescent and incandescent lights powered by AC, and
an incandescent light powered by DC.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on the
interface, and turn on the computer.

2. Connect the Light Sensor cable into Analog Channel A on the
interface. Connect the Light Sensor to the cable.

3. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS02 Vary Light.DS G02 Light Bulb Intensity G02_BULB.SWS

•  The DataStudio document has a Workbook display. Read the instructions in the
Workbook.

•  The ScienceWorkshop document opens with a Scope display of voltage from the Light
Sensor in Channel A and a Frequency Spectrum (FFT) display for the same sensor. It also
has a Digits display for the voltage from the Light Sensor.

• The data measurement is set at 5000 Hz (set by the Sweep Speed control in the Scope
display). The Frequency Spectrum (FFT) is set to 256 data points.

PASCOscientific

300Interface

ANALOG CHANNELS

Science
Workshop™

Interface

500

scientific

PASCO

Science W
orkshop™

DATA LO G G ING
INSTRUCTIO NS
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Remember, the Scope display is like an oscilloscope. An oscilloscope is a special instrument for
measuring and showing voltage, especially the voltage from something that is changing quickly.
The Scope display looks like a television screen.

The Frequency Spectrum (FFT) display is a special kind of graph. The Frequency Spectrum
shows the frequency (number of cycles per second) of each part of the signal that is being
measured by the ScienceWorkshop interface. The Frequency Spectrum sometimes looks like
many mountain peaks. Each peak stands for the frequency of one part of the signal that is being
measured.

PART II: Sensor Calibration & Equipment Setup

•  You do not need to calibrate the Light Sensor. However, you may need to adjust the
sensitivity of the sensor, depending on the brightness of the light source and how close the
sensor is to the source.

Adjusting Light Sensor Sensitivity

• The Light Sensor has a GAIN switch on the top of the sensor box. The GAIN switch
selects the amount of amplification for the signal that is sent to the interface. The settings
are 1, 10, and 100. The setting of 10 amplifies the signal ten times and the setting of 100
amplifies the signal one hundred times.

Try the following to become more familiar with the Light Sensor:

• Place the Light Sensor on a table so the port on the sensor is
below an overhead light. Set the GAIN switch to 1.

• Start measuring data. Click ‘Start’ in DataStudio or click
‘MON’ in ScienceWorkshop. Move the Digits display of
Input Volts so you can see it clearly.
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• Switch the GAIN to 10 and observe the value of Input Volts in the Digits display. Then
switch to 100 and observe the value of Input Volts.

NOTE: The maximum voltage from the sensor is 4.9 V for any GAIN setting.

• Cover the Light Sensor port and observe the value of Input Volts.

• Return the GAIN setting to 10. Pick up the sensor. Observe the value of Input Volts as you
move the Light Sensor closer to the overhead light source. Observe what happens when
you move the Light Sensor farther from the light source.

• Click STOP to stop measuring data.

Equipment Setup

1. Place the Light Sensor within a few feet of a fluorescent bulb that is powered by AC.

2. Turn on the fluorescent bulb.

PART IIIA: Data Recording – Fluorescent Bulb, AC

1. Start measuring data. (Hint: In DataStudio, click the ‘Start’ button ( ). In
ScienceWorkshop, click the ‘MON’ button.) Arrange the Scope display, the Digits display,
and the Frequency Spectrum (FFT) so you can see them clearly.

• NOTE: It is likely that you will see a value in the Digits display, and a spectrum in the
Frequency Spectrum display, but     nothing     in the Scope display. This is because the trigger
control in the Scope is on, and the trigger level may be set too low for the voltage produced
by the Light Sensor.

2. Adjust the Scope display until you see the trace of voltage from the Light Sensor:

•  First, adjust the trigger level.

In DataStudio, move the small triangle (the ‘Trigger Level’ pointer) on the left side of the
display up or down to the desired voltage level. In ScienceWorkshop, click in the space
along the left edge of the Scope display that is above the Trigger Level pointer. When you

click above or below the Trigger Level Pointer, it “jumps” to the spot you clicked. The
value in the Digits display will indicate the    approximate    trigger level you need.

TRIGGER
LEVEL

POINTER

CLICK ABOVE  TO
RAISE THE

TRIGGER LEVEL

CLICK BELOW TO
LOWER THE

TRIGGER LEVEL

Trigger
Level
pointer

Trigger
menu
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• Second, adjust the vertical position of the trace of voltage.

In DataStudio, click the up or down arrows next to ‘Offset’. In ScienceWorkshp, click the
‘UP/DOWN Arrows’ in the right side of the Scope display.

• Finally, adjust the Sensitivity (volts per division) if needed.

In DataStudio, click the arrows to increase or decrease the sensitivity. In ScienceWorkshop,
click the Vertical Scale buttons in the right side of the Scope display.

UP Arrow: Click 
shift the trace 
voltage upward.

DOWN Arrow: Clic k
to shift the tra
voltage downwar d

POSITION INDICATOR

INCREASE
Sensitivity: Cli
increase the he i

of the trace.

DECREASE
Sensitivity: Cli c
decrease the hei g

of the trace.

SENSITIVITY
(VERTICAL

SCALE)

‘Offset’
arrows

Sensitivity
controls
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3. Use the Frequency Spectrum to measure the frequency of the signal from the Light Sensor.
Record the value of the frequency in the Lab Report section.

• Make the FFT display (Frequency Spectrum) active. In DataStudio, click the ‘Smart Tool’
button. In ScienceWorkshop, click the ‘Smart Cursor’ button. Move the cursor/cross-hair to
the top of the first peak in the display area. In DataStudio, the frequency is the first number
in the ordered pair. In ScienceWorkshop, the frequency is shown below the horizontal axis.

4. Click the STOP button to stop monitoring data.

5. Save the trace that is displayed on the Scope. Click the Scope to make it active.

•  In DataStudio, click the ‘Transfer’ button ( ). The data in the
Scope is automatically added to the data list.

•  In ScienceWorkshop, click the ‘Data Snapshot’ button ( ) in
the right side of the Scope display. The Data Cache
Information  window will open. Enter appropriate information
for the Long Name, Short Name, and Units. Click OK  to
return to the Scope.

• The Short Name for the Data Cache will appear in the Data List in the Experiment Setup
window. (NOTE: You can display and analyze the Data Cache in any display that can
show recorded data such as the Graph, Table, or FFT.)

PART IIIB: Incandescent Light – AC

Repeat the activity using an incandescent light connected to an AC power supply.

PART IIIC: Incandescent Light – DC

Repeat the activity using a battery operated flashlight.

SMART
CURSOR

FREQUENCY
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Analyzing the Data

1. Set up a Graph display to show data for the AC fluorescent light, AC incandescent light,
and DC incandescent light.

•  Hint: In DataStudio, do the following:

•  Click ‘Add Display…’ from the Experiment menu.

•  Select ‘Graph’ from the ‘Please Choose…’ window. Click ‘OK’.

•  Click and drag ‘Data’ from the Data list to the new Graph display.

•  The Graph automatically rescales to fit the data. Repeat the process for the other runs of
data.

•  Hint: In ScienceWorkshop, do the following:

•  Click the Display Menu. Select New Graph from the Display
Menu.

•  In the new Graph display, click the Vertical Axis Input Menu

button ( ). Select Data Cache, Fluorescent AC from the
Input Menu.

•  The Graph will show the data seen in the Scope display for
the fluorescent bulb powered by AC.

•  Click the Add Plot Menu button ( ) in the lower left
corner of the Graph. Select Data Cache, Incandescent AC
from the Add Plot Menu.

Drag and drop
‘Data’ onto the
Graph.
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•  A new plot will be added to the Graph. It will
show the data seen in the Scope display for the
incandescent bulb powered by AC.

•  Click the Add Plot Menu button again. Select
Data Cache, Incandescent DC from the Add
Plot Menu.

•  A third plot will be added to the Graph.

Use your results to answer the questions in the Lab Report section.
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Lab Report - Activity GS02: Variation of Light Intensity

What Do You Think?

The purpose of this activity is to compare the variation in intensity (brightness) of light from
different kinds of light sources. One light source is a flashlight powered by batteries (direct
current  (DC)). Another is a fluorescent light bulb that is powered by alternating current  (AC)
and a third is an incandescent light bulb that is powered by AC. How does the light from a DC
light source compare to light from an AC light source? How does the light from a fluorescent
tube compare to the light from an incandescent bulb?

Data Table

Light Source Frequency

Fluorescent, AC Hz

Incandescent, AC Hz

Incandescent, DC   Hz

Questions

1. How does the frequency of light intensity variation for the fluorescent AC bulb and the
incandescent AC bulb compare to the accepted value for AC frequency?

2. What happens to the relative brightness of a fluorescent light bulb powered by AC? How
does the relative brightness of an incandescent bulb run on powered by AC differ from the
fluorescent bulb?

3. What happens to the relative brightness of a flashlight bulb powered by DC?
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Ending the Activity

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select Quit  from the File  menu to end the activity.

2. You can select Save or Save As…  from the File menu to save your data for this activity and
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select Open…  from the File  menu, and find the
document for the next activity.
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Activity GS03: Mixing Hot and Cold Water – Thermodynamics
(Temperature Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Thermodynamics GS03 Mix Hot and Cold.DS G03 Hot and Cold G03_HOT.SWS

Equipment Needed Qty Consumables Qty
Temperature Sensor (CI-6505A) 1 Water, hot 150 mL
Beaker, 250 mL 2 Water, ice 200 mL
Graduated cylinder, 100 mL 1
Protective gear PS

What Do You Think?

When masses of substances at different temperatures are mixed together, the hotter substance
heats the cooler substance and the resulting final temperature is somewhere between the initial
temperatures of the two substances. Can you predict the final temperature of a mixture of two
substances?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Temperature is a measure of the average
kinetic energy (energy of motion) of the
particles in a substance. The thermal energy
in the substance is the total of all the kinetic
energy of all the particles in the substance.
The thermal energy in a substance depends on
the mass of the substance, the specific heat
capacity of the substance, and the temperature
of the substance.

Heat is the name given to thermal energy
when it moves from a substance with a high
temperature to a substance with a lower
temperature. Heat is energy in transit.

When substances of different temperatures are mixed, the hotter one heats the cooler one until
the temperature of the mixture reaches a balance called thermal equilibrium .

The thermal energy in an object depends on the amount of mass, the specific heat of the object,
and its temperature. In equation form:

∆Q (change in thermal energy) = m c ∆T

where m is the mass in grams, c is the specific heat and ∆T is the change in temperature.

The value for the specific heat, c, of water is 1.0 cal/g ˚C or 4.19 J/g ˚C. This value is constant
between the temperatures of 0˚ C and 100 ˚C.

When a hot substance heats a cooler one, the energy ‘lost” by the hot substance equals the energy
‘gained’ by the cooler one, or (in equation form):

Qlost = Qgained

HOT
WATER

COLD
WATER

ICE

WHAT WILL THE TEMPERATURE OF THE MIXTURE
BE COMPARED TO THE TEMPERATURE OF THE

HOT WATER AND THE COLD WATER?
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For You To Do

For this activity, use mathematical logic and algebra to predict the final temperature of a mixture
of hot and cold water. Then use the Temperature Sensor to measure the temperature of a hot
liquid and the temperature of a cold liquid before they are mixed. Use the Temperature Sensor to
measures the temperature of the mixture. Use insulated containers so that the containers will not
gain or lose thermal energy during the activity.

This activity has two parts. In PART A, the amount of hot liquid    is the same as    the amount of
cold liquid. In PART B, you will use     different amounts    of each liquid. You will make predictions
for the final equilibrium temperature for the mixture based on the temperature of the hot and cold
liquids before they are mixed.

Use DataStudio or Science Workshop to record, display, and analyze the data on a Graph.

Prediction: PART A

Will the temperature of a mixture of hot and cold water be the same as the temperature of the hot
water by itself or the cold water by itself?

•  Predict what the final temperature will be for the mixture of the hot and cold water
compared to the temperature of either the hot water by itself or the cold water by itself.
Imagine that the hot water is at 70 ˚C and the cold water is at 10 ˚C. For PART A assume
that equal amounts of water are mixed together.

Starting temp. of hot water Starting temp. of cold water Predicted temp. of mixture

70 ˚C* 10 ˚C*

(*These temperatures are just examples.)

SAFETY REMINDERS

•  Wear protective gear while handling hot water containers.

•  Follow directions for using the equipment.
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PART I: Computer Setup

1. Connect the ScienceWorkshop interface to
the computer, turn on the interface, and
then turn on the computer.

2. Connect the Temperature Sensor DIN
plug into Analog Channel A on the
interface.

3. Open the file as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS03 Mix Hot and Cold.DS G03 Hot and Cold G03_HOT.SWS

•  The DataStudio document has a Graph display and a Workbook display. Read the
instructions in the Workbook.

•  The ScienceWorkshop document has a Graph display of temperature versus time.

•  Data recording is set for ten measurements per second (or 10 Hz).

See the DataStudio Online Help file or the ScienceWorkshop User’s Guide for more information
about the Graph display.

Plot Input Menu button

Channel Icon

Sensor icon

Plot Data Options
button

DATA Menu
button

Horizontal Axis
Input Menu button

Zoom Out/Zoom In
buttons

Vertical Axis scale

Top Row: Left-to-right
Statistics button

Smart Cursor button
Magnifier button
Autoscale button

Bottom Row: Left-to-right
Graph Setup button

Add Plot Menu button

Horizontal Axis scale

Minimize button
Maximize button

Control Menu
button

*Italics indicate a Windows 3.1 feature.

Graph toolbar

Vertical Axis

Horizontal axis

Scale to Fit

Legend

Smart Tool Statistics menu
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PART IIA: Equipment Setup – Equal Amounts of Hot and Cold Water

1. Put 100 mL (milliliters) of cold
water into the first container so that
it is slightly less than half full.

2. Put 100 mL of hot water into the
second container so that is also
slightly less than half full.

PART IIIA: Data Recording – Equal Amounts of Hot and Cold Water

1. Place the Temperature Sensor into the cold
water. Start recording data. Watch the values
of temperature in the Graph display.

2. After about 40 seconds, move the
Temperature Sensor to the hot water.

3. After a total of 80 seconds,    remove the
Temperature Sensor from the hot water   . Pour
the hot water into the cold water.

4. Quickly place the Temperature Sensor into the
combined liquids. Stir to thoroughly mix the
two liquids.

5. Stop data recording after 120 seconds.

COLD
WATER

HOT
WATER

TEMPERATURE
SENSOR

TO
INTERFACE

HOT AND COLD - THERMODYNAMICS
(TEMPERATURE SENSOR)

STEP 1: MEASURE THE 
TEMPERATURE OF THE 
COLD WATER.

STEP 2: MEASURE 
THE TEMPERATURE 
OF THE HOT WATER.

STEP 3: POUR THE HOT 
WATER INTO THE COLD 
WATER.

STEP 4: MEASURE 
THE TEMPERATURE 
OF THE MIXTURE.
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Analyzing the Data: PART A – Equal Amounts of Hot and Cold Water

1. Rescale the Graph to fit your data.

2. Find and record the LOWEST temperature in the Graph (the Y-coordinate of the lowest
point in the Graph).

•  Hint: Use the Smart Tool in DataStudio or the Smart Cursor in ScienceWorkshop.

3. Find and record the HIGHEST temperature in the Graph (the Y-coordinate of the highest
point in the Graph).

4. Find and record the    final    temperature of the combined liquids (the Y-coordinate at the end
of the plot).

Record your results in the Lab Report section.

Smart Cursor

Y-coordinate 
corresponds to 
Temperature

X-coordinate 
corresponds to 
Time
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Procedure: PART B – Unequal Amounts of Hot and Cold Water

For this part of the activity, measure the temperature of hot water and cold water before and after
they are mixed, but use unequal amounts of hot and cold water.

Prediction: PART B – Unequal Amounts of Hot and Cold Water

Will the final temperature of unequal amounts of hot and cold water be the same as the final
temperature of equal amounts of hot water and cold water?

1. Predict what the final temperature will be for the mixture of the hot and cold water
compared to the temperature of either the hot water by itself or the cold water by itself.
(Imagine that you have 50 mL of hot water at 70 ˚C and 100 mL of cold water at 10 ˚C.)

Temp. of hot water (50 mL) Temp. of cold water (100 mL) Predicted temp. of mixture

70 ˚C* 10 ˚C*

(*These temperatures are just examples.)

PART IIB: Equipment Setup – Unequal Amounts of Hot and Cold Water

1. Put 100 mL (milliliters) of cold water
into the first container so that it is
slightly less than half full.

2. Put 50 mL of hot water into the second
container.

PART IIIB: Data Recording – Unequal
Amounts of Hot and Cold Water

1. Place the Temperature Sensor into the
cold water. Start recording data. Watch
the values of temperature in the Graph
display.

2. After about 40 seconds, move the Temperature
Sensor to the hot water.

3. After a total of 80 seconds,    remove the
Temperature Sensor from the hot water   . Pour the
hot water into the cold water.

4. Quickly place the Temperature Sensor into the
combined liquids. Stir to thoroughly mix the two
liquids.

5. Stop end data recording after 120 seconds.

COLD WATER (100 ml) HOT WATER (50 ml)

TEMPERATURE
SENSOR

TO
INTERFACE

STEP 1: MEASURE THE 
TEMPERATURE OF THE 
COLD WATER.

STEP 2: MEASURE 
THE TEMPERATURE 
OF THE HOT WATER.

STEP 3: POUR THE HOT 
WATER INTO THE COLD 
WATER.

STEP 4: MEASURE 
THE TEMPERATURE 
OF THE MIXTURE.



Name _____________________ Class ______________ Date _________

GS03 ©1999 PASCO scientific p. 23

Analyzing the Data: PART B – Unequal Amounts of Hot and Cold Water

1. Rescale the Graph to fit your data.

2. Find and record the LOWEST temperature in the Graph (the Y-coordinate of the lowest
point in the Graph).

3. Hint: Use the Smart Tool in DataStudio or the Smart Cursor in ScienceWorkshop.

4. Find and record the HIGHEST temperature in the Graph (the Y-coordinate of the highest
point in the Graph).

5. Find and record the    final    temperature of the combined liquids (the Y-coordinate at the end
of the plot).

Record your results in the Lab Report section.

Smart Cursor

Y-coordinate 
corresponds to 
Temperature

X-coordinate 
corresponds to 
Time
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Ending the Activity

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select Quit  from the File  menu to end the activity.

2. You can select Save or Save As…  from the File menu to save your data for this activity and
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select Open…  from the File  menu, and find the
document for the next activity.
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Lab Report - Activity GS03: Mixing Hot and Cold Water

What Do You Think?

When masses of substances at different temperatures are mixed together, the hotter substance
heats the cooler substance and the resulting final temperature is somewhere between the initial
temperatures of the two substances. Can you predict the final temperature of a mixture of two
substances?

Prediction: PART A – Equal Amounts of Hot and Cold Water

Will the temperature of a mixture of hot and cold water be the same as the temperature of the hot
water by itself or the cold water by itself?

•  Predict what the final temperature will be for the mixture of the hot and cold water
compared to the temperature of either the hot water by itself or the cold water by itself.

Starting temp. of hot water Starting temp. of cold water Predicted temp. of mixture

Data Table: PART A – Equal Amounts of Hot and Cold Water

LOWEST Temperature HIGHEST Temperature Final Temperature

Prediction: PART B – Unequal Amounts of Hot and Cold Water

Will the final temperature of unequal amounts of hot and cold water be the same as the final
temperature of equal amounts of hot water and cold water?

•  Predict what the final temperature will be for the mixture of the hot and cold water
compared to the temperature of either the hot water by itself or the cold water by itself.

Temp. of hot water (50 mL) Temp. of cold water (100 mL) Predicted temp. of mixture

Data Table: PART B – Unequal Amounts of Hot and Cold Water

LOWEST Temperature HIGHEST Temperature Final Temperature

Questions

1. In PART A, how does the    final    temperature of the mixture compare to the lowest
temperature of the 100 mL of cold water and the highest temperature of the 100 mL of hot
water?
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2. In PART B, how does the final temperature of the mixture compare to the lowest
temperature of the 100 mL of cold water and the highest temperature of the 50 mL of hot
water?

3. How does the final temperature in PART A compare to your prediction?

4. How does the final temperature in PART B compare to your prediction?

5. If the initial temperatures of the hot and cold water were increased by the same amount,
how would this effect the final temperature of the new mixture?

Conclusion

•  Write a sentence that describes how to predict a final temperature for a mixture of hot and
cold liquids based on the amount of each liquid and the starting temperature of each liquid.

Optional

Predict the final temperature of these mixtures:

100 mL of 10 ˚C water and 100 mL of 40 ˚C water.

200 mL of 10 ˚C water and 100 mL of 40 ˚C water.

100 mL of 10 ˚C water and 200 mL of 40 ˚C water.

300 mL of 10 ˚C water and 100 mL of 40 ˚C water.

100 mL of 10 ˚C water and 300 mL of 40 ˚C water.

100 mL of 0 ˚C water and 100 mL of 100 ˚C water.

100 mL of 20 ˚C water and 200 mL of 50 ˚C water.
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Activity GS04: pH of Household Chemicals – Chemistry
(pH Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Chemistry GS04 Household pH.DS G04 pH of Chemicals G04_PH.SWS

Equipment Needed Qty Chemicals and Consumables Qty
pH Sensor (CI-6507) 1 Egg (raw) 50 mL
Beaker, 250 mL 4 Fruit juice 50 mL
Wash bottle 1 Lemon juice 50 mL
Protective gear PS Milk 50 mL
Chemicals and Consumables Qty Milk of magnesia 50 mL
Buffer solution: high pH 100 mL Soda pop 50 mL
Buffer solution: low pH 100 mL Tissues or paper towels many
Bleach 50 mL Water, distilled 1 L
Detergent (liquid) 50 mL Water, tap 50 mL

What Do You Think?

In this activity you will measure and record the potential for hydronium (pH)  of several
household chemicals such as bleach, lemon juice, and milk. You will put each chemical into a
category: acid, neutral, or base. What is the category for each substance mentioned?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

One way to classify a chemical is to measure whether it is an acid, a base, or is neutral. Acids
and bases have been known since early times. Acids (from Latin acidus, or sharp) have a sharp,
sour taste (for example, vinegar).
Bases have a bitter taste and
neutralize the effects of acids.
(Substances that are bases are
sometimes called “alkaline”.)

Whether a substance is an acid or a
base or is neutral can be measured
using the pH scale. The pH of a
solution is a measure of the potential
for adding more hydronium  (H3O+)
to the solution. Acid solutions already
have a large amount of hydronium in
them, so the potential for hydronium,
or pH, is very low. Basic solutions
have lots of hydroxide (OH-) ions
that would ‘soak up’ lots of
hydronium, so the potential for
hydronium is very high.

Most pH values range from 0 to 14. A
pH value of 7 means a neutral
solution. A pH value below 7 means
an acid. A pH value above 7 means a
base. Rainwater is slightly acidic.
Blood is slightly basic.

POTENTIAL 
FOR 
HYDRONIUM

CONCENTRATION 
OF
HYDRONIUM

ACIDS

NEUTRAL

BASES

pH VERY 
LOW = STRONG 
ACID

pH VERY 
HIGH=STRONG 
BASE

pH = 0

pH = 14

pH = 7 
MEANS 
NEUTRAL
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SAFETY REMINDERS

•  Wear protective gear (apron, gloves, goggles or splash shield).

•  Follow directions for using the equipment.

•  Handle and dispose of all chemicals and solutions properly.

For You To Do

Calibrate the pH Sensor before you begin to make measurements.

Use the pH Sensor to measure the pH of many common chemical solutions such as fruit juice,
raw egg, and liquid detergent. Use DataStudio or ScienceWorkshop to record and display the
values of pH. Use the software to assign a number to identify each chemical.

After you record data you can classify each substance as acid, base, or neutral.

Prediction

Is lemon juice an acid, a base, or neutral? Is liquid detergent an acid, a base, or neutral? How
about raw egg or milk?

• Predict which of the following substances will be acid (A), base (B), or neutral (N). Record
your predictions in the table by putting a letter in the column next to the substance.

Substance A-B-N Substance A-B-N Substance A-B-N
(1) bleach (4) fruit juice (7) milk of magnesia
(2) egg (raw) (5) lemon juice (8) soda pop
(3) detergent (6) milk (9) tap water

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer,
turn on the interface, and turn on the computer.

2. Connect the DIN plug of the pH Sensor to Analog
Channel A on the interface.

3. Open the file titled as shown:

• The document has a Digits display showing pH and a
Table display showing pH and the number of each
chemical.

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS04 Household pH.DS G04 pH of Chemicals G04_PH.SWS

• The DataStudio document also has a Workbook display. Read the instructions in the
Workbook.
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PART II: Sensor Calibration and Equipment Setup

• Why is it important to calibrate the pH Sensor?

When you calibrate a sensor, you use the sensor to make a measurement of something that
you know is a certain value. For example, imagine that you put the pH Sensor into a
solution that has a pH of exactly 7. When you calibrate the sensor, you put the sensor into
the known solution and then tell the program that the sensor is measuring something with a
pH of 7. Then you put the sensor into a solution with another known value of pH. You tell
the program what the new value of pH is. From then on, the program can figure out the pH
of any other solution you used based on what it ‘knows’ about the first two solutions.

• To calibrate the pH Sensor you will need the following:
wash bottle, distilled water, three beakers, buffer solutions
of high pH (e.g. pH 10) and low pH (e.g. pH 4), pH
Sensor.

• Put distilled water into the wash bottle and into one of the
beakers. Put about 100 mL of the high pH buffer solution
in one of the other two beakers and about 100 mL of the
low pH buffer solution into the third beaker.

1. Remove the pH electrode from its bottle of buffer solution. Connect the electrode to the pH
Sensor amplifier. To connect the electrode, push the BNC plug onto the receptacle on the
Sensor amplifier and turn the BNC plug clockwise until it ‘clicks’ into place.

2. Use the wash bottle to rinse the end of the electrode. Soak the pH electrode in the beaker of
distilled water for 10 minutes.

Connect to
the sensor.

Remove
the bottle
of buffer
solution.

pH Electrode

Wash bottle

Beaker
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3. In the Experiment Setup window, double-click the pH Sensor icon.

• In DataStudio, the Sensor Properties window will open. Click the ‘Calibration’ tab. In
ScienceWorkshop, the Sensor Setup window will open.

4. Calibrate with the high pH buffer solution.

•  Put the end of the pH electrode into the high pH buffer solution.

•  Check the voltage under ‘Current Reading’ in DataStudio or next to ‘Cur Value:’ in
ScienceWorkshop.

•  When the voltage stabilizes, click the ‘Take Reading’ button under ‘High Point’ in
DataStudio or the ‘Read’ button in the row for ‘High Value:’ in ScienceWorkshop.

•  Enter the pH value of the buffer solution.

5. Thoroughly rinse the pH electrode with distilled water and dry it with a tissue.

6. Calibrate with the low pH buffer solution.

•  Put the end of the pH electrode in the low pH buffer solution.

•  Check the voltage under ‘Current Reading’ in DataStudio or next to ‘Cur Value:’ in
ScienceWorkshop.

•  When the voltage stabilizes, click the ‘Take Reading’ button under ‘Low Point’ in
DataStudio or the ‘Read’ button in the row for ‘Low Value:’ in ScienceWorkshop.

•  Enter the pH value of the buffer solution. Click OK to return to the Experiment Setup
window.

7. Thoroughly rinse the pH electrode with distilled water and dry gently.
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Equipment Setup

1. Put some of the first household chemical (bleach) you are going to measure in a clean, dry
beaker.

2. Put the pH Electrode into the chemical.

PART III: Data Recording

• Use the calibrated pH Sensor to measure the pH of each household chemical. Use
DataStudio or ScienceWorkshop to also keep track of each chemical by typing in the
following number of each chemical you measure.

Number Chemical

1 bleach

2 detergent (liquid)

3 egg (raw)

4 fruit juice

5 lemon juice

6 milk

7 milk of magnesia

8 soda pop

9 tap water

1. Make the Digits display active and move it so you can see it clearly.

2. Start measuring data. Click ‘Start’ in DataStudio or ‘REC’ ( ) in ScienceWorkshop.

•    In         DataStudio    , the ‘Start’ button changes to ‘Keep/Stop’ ( Note: This
button is explained a little later.) Also, the first value of pH appears in the Table display.

•    In        ScienceWorkshop    , the ‘Keyboard Sampling’ window
opens. (This window is where you can type in a number to
label each chemical as you measure its pH value.) The box
next to Entry #1 has a suggested number that you can ignore.

• The Digits display shows the pH value for the first
chemical.

(Examples ONLY)
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3. When the Digits display stabilizes after a few seconds, record the value.

• In DataStudio, click ‘Keep’ ( ). The
program records the value of pH shown in the first row of
the Table display.

• In ScienceWorkshop, type in 1 in the box next to Entry #1 in the ‘Keyboard Sampling’

window and then click ( ). The pH value of the first chemical is recorded along
with the number you typed in. The ‘Keyboard Sampling’ window will change. The number
you entered will appear in the list of chemicals. The Entry number will be #2. The entry
box will have another suggested value.

• Now you will need to get the second chemical ready so you can measure it.

4. Remove the pH Electrode from the beaker
with the first chemical. Hold the pH
Electrode over an empty beaker (or over a
sink). Use the wash bottle with distilled
water to thoroughly rinse off the pH
Electrode.

5. Dispose of the first chemical as    instructed    .
Don’t pour the chemical into a sink unless
you are told that it is okay to do so.

6. Rinse out the beaker. Dry the inside of the
beaker. Put the second chemical (liquid
detergent) into the clean beaker.

7. Put the pH Electrode into the second
chemical (detergent).

• The Digits display will show a new value.

8. When the Digits display stabilizes, record the value.

• In DataStudio, click ‘Keep’. In ScienceWorkshop, type in 2 in the box next to Entry #2 in

the Keyboard Sampling window and then click Enter ( ).

• The pH value of the second chemical is recorded along with the number that identifies the
chemical.

9. Remove the pH Electrode from the beaker with the second chemical. Hold the pH
Electrode over an empty beaker (or over a sink). Use the wash bottle with distilled water to
thoroughly rinse off the pH Electrode.

pH SENSOR

WASH BOTTLE

BEAKER
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10. Dispose of the second chemical as instructed. Don’t pour the chemical into a sink unless
you are told that it is okay to do so.

11. Repeat the steps described above for the other household chemicals (fruit juice, lemon
juice, etc.).

12. After you record the pH value for the last chemical, stop measuring data.

• In DataStudio, click the ‘Stop’ button next to ‘Keep’ ( ). In
ScienceWorkshop, click the ‘Stop Sampling’ button ( ) in the
Keyboard Sampling window.

• The Keyboard Sampling window will disappear. ‘Run #1’ will appear in the Data list in the
Experiment Setup window.

ENDING THE ACTIVITY (See the section after Questions)

Analyzing the Data

• Now you can decide which chemicals are acids, which are bases, and which are neutral.

1. Click on the Table display to make it active. (NOTE: The numbers in this example are
made up. Ignore them.)

• The first column in your Table display shows the pH values. The second column in your
Table display shows the numbers used to label the chemicals.

2. Based on your measurements, classify each chemical as    acid    ,     base   , or     neutral   .

Record your results in the Lab Report section.
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Lab Report - Activity GS04: pH of Household Chemicals

What Do You Think?

In this activity you will measure and record the potential for hydronium (pH)  of several
household chemicals such as bleach, lemon juice, and milk. You will put each chemical into a
category: acid, neutral, or base. What is the category for each substance mentioned?

Data Table

Number Chemical pH Value Acid, Base, Neutral

1 bleach

2 detergent (liquid)

3 egg (raw)

4 fruit juice

5 lemon juice

6 milk

7 milk of magnesia

8 soda pop

9 tap water

Questions

1. Based on your data, how did your predictions compare to the measured values?

2. What are some characteristics that the acid solutions have in common?

3. What are some characteristics that the basic solutions have in common?

4. Which substance had the pH that surprised you the most?
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Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘Fil’e menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Activity GS05: Mass on a Spring – Mechanics
(Force Sensor, Motion Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Mechanics GS05 Mass on a Spring.DS G05 SHM Mass on a Spring G05_MASS.SWS

Equipment Needed Qty Equipment Needed Qty
Economy Force Sensor (CI-6746) 1 Mass and Hanger Set (ME-9348) 1
Motion Sensor (CI-6742) 1 Meter stick 1
Balance (SE-8723) 1 Support rod (ME-8736) 1
Base and Support Rod (ME-9355) 1 Spring, k ~ 2 to 4 N/m (632-04978) 1
Clamp, right-angle (SE-9444) 1

What Do You Think?

What is the motion of a mass oscillating on a spring? What other motions can you think of that
are similar?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Imagine a spring that is hanging
down. When no mass hangs at the
end of the spring, the spring has a
certain length L (called its rest
length). When a mass is added to
the spring, the spring is stretched a
little bit to a new length. Add some
more mass and the spring stretches
some more.

If you pull the mass down to stretch
the spring and then release the
mass, it bobs up and down on the
end of the spring. It takes a certain
amount of time for the mass to go
from the bottom position all the
way up and back down again one
time. This is called the period of
oscillation (or period for short).

(Eventually the mass will stop moving. Its energy is converted into other forms as the spring
stretches and compresses.)

There are two main factors that determine how long it takes for the mass on the spring to go from
down-to-up-to-down (or one period).

One factor is the amount of mass that the spring has to lift when it moves up. The more mass, the
longer the time. Another factor is the stiffness of the spring. If the spring is very stiff (strong) it
can lift the mass more quickly. The stiffer the spring, the shorter the time.

PERIOD = TIME FOR 
MASS TO MOVE FROM 
DOWN-TO-UP-TO-DOWN

DOWN

UP

DOWN

PULL MASS 
DOWN AND THEN 
RELEASE IT.
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When a spring is stretched or compressed, the
spring exerts a restoring force. The restoring force
causes the mass to bob up and down. The total
amount of restoring force that the spring exerts
depends on how strong (stiff) the spring is and the
amount of distance that it is stretched or
compressed. The formula for the total amount of
restoring force is:

F = -kx

where F is the amount of force, x is the distance
the spring is stretched or compressed, and k is the
strength     of the spring, called the spring constant. (This formula is called Hooke’s Law in honor
of Robert Hooke, an English scientist who lived from 1635 to 1703.) The negative sign indicates
that the force points opposite to the direction that the spring is stretched or compressed. This
means that when you pull on the spring to stretch it, it pulls against you. When you push on the
spring to compress it, it pushes against you again.

You can     predict    how long the period of oscillation will be if you know the      mass    on the end of the
spring and the    spring constant   . The formula that gives the period when you know the mass and
the spring constant is:

T = 2π m
k

where T is the period of oscillation, π is the Greek letter “pi” and represents 3.1415…, m is the
mass, and k is the string constant.

SAFETY REMINDER

• Follow the directions for using the equipment.

MORE MASS 
LENGTHENS THE 
PERIOD

STIFFER SPRING 
SHORTENS THE 
PERIOD
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Pre-Lab For You To Do

In the Pre-lab use the Force Sensor to measure the weight of a hanging mass. Use ‘Keyboard
Sampling’ to enter the displacement of the spring from equilibrium. Use DataStudio or
ScienceWorkshop to determine the spring constant k for the spring.

Pre-Lab PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer,
turn on the interface, and turn on the computer.

2. Connect the DIN plug of the Force Sensor to Analog
Channel A.

3. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
P14 Prelab SHM.DS X19 Spring Constant X19_SPNG.SWS

• The DataStudio document has a Workbook display. Read the instructions in the Workbook.

• The ScienceWorkshop document has a Graph display of Force versus Stretch and a Digits
display of Force.

• Data recording is set for 5 Hz. Use ‘Keyboard Sampling’ to enter the distance stretched in
meters.

Pre-Lab PART II: Sensor Calibration and Equipment Setup

• To calibrate the Force Sensor, refer to the description in the
Force Sensor Manual.

1. Using the rod and support stand, the clamp, and the second
rod, mount the Force Sensor vertically so its hook end is
down.

2. Suspend the spring from the Force Sensor’s hook so that it
hangs vertically.

3. Use the meter stick to measure the position of the bottom end
of the spring (without any mass added to the spring). For
your reference, record this measurement as the spring’s
equilibrium position in the Data Table in the Lab Report
section.
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Pre-Lab PART II: Data Recording

1. Press the tare button on Force Sensor to zero the Force Sensor.

2. Start data recording.

In         DataStudio    , move the Table display so you can see it. Click the ‘Start’ button to start
recording data.

• The ‘Start’ button changes to a ‘Keep/Stop’ and a ‘Stop’ button ( ). The Force
will appear in the first cell in the Table display. Click the ‘Keep’ button to record the force
value.

In        ScienceWorkshop    , click the ‘REC’ button to begin collecting data.

• The ‘Keyboard Sampling’ window will open. Move it so you can also see the Digits
display. ‘Entry #1’ has a default value that you can ignore. Type in ‘0’ as the stretch. Click
‘Enter’ to record the stretch and force values. The entered stretch value will appear in the
Data list.

3. Add 20 grams of mass to the end of the spring (be sure to include the mass of the hanger).

4. Measure the new position of the end of the spring. Enter the difference between the new
position and the equilibrium position as the ∆x, ‘Stretch’ (in meters), and record a Force
value for this Stretch value by clicking on ‘Keep’ in DataStudio, or ‘Enter’ in
ScienceWorkshop.

5. Add 10 grams to the spring (for a total of 30 g additional mass). Measure the new position
of the end of the spring, enter the stretch value and click ‘Keep’ or ‘Enter’ to record the
force value.

6. Continue to add mass in 10 gram increments until you have added 70 grams. Each time
you add mass, measure and enter the new displacement value from equilibrium. Click
‘Keep’ in DataStudio, or ‘Enter’ in ScienceWorkshop to record the force value.

7. End data recording.

• In DataStudio, stop data recording by clicking on the ‘Stop’ button.

• In ScienceWorkshop, stop data recording by clicking the ‘Stop Sampling’ button in the
Keyboard Sampling window.

• The data will appear as Run #1.

Pre-Lab Analyzing the Data

1. Determine the slope of the Force vs. Stretch Graph.

• In DataStudio, click the ‘Scale to fit’ button ( ) to rescale the Graph axes to fit the data.

Next, click the ‘Fit’ menu button ( ). Select ‘Linear’.

• In ScienceWorkshop, click the ‘Autoscale’ button ( ) to rescale the Graph axes to fit the
data. Click the ‘Statistics’ button to open the Statistics area on the right side of the Graph.

In the Statistics area, click the Statistics Menu button ( ). Select ‘Curve Fit, Linear
Fit’  from the Statistics Menu.

2. Record the slope of the linear fit in the Data Table in the Lab Report section.
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For You To Do

Use the Motion Sensor to record the motion of a mass on the end of the spring. Use DataStudio
or ScienceWorkshop to determine the period of oscillation and compare the value to the
theoretical period of oscillation.

PART I: Computer Setup

1. Unplug the Force Sensor’s DIN plug from the
interface.

2. Connect the Motion Sensor’s stereo phone plugs into
Digital Channels 1 and 2 of the interface. Plug the
yellow-banded (pulse) plug into Digital Channel 1 and
the second plug (echo) into Digital Channel 2.

3. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS05 Mass on a Spring.DS G05 SHM Mass on a Spring G05_MASS.SWS

• The DataStudio document has a Workbook display. Read the instructions in the Workbook.

• The ScienceWorkshop document has a Graph display of Position and Velocity vs. Time.

PART II: Sensor Calibration and Equipment Setup

 • You do not need to calibrate the Motion Sensor.

1. Using a support rod and clamp, suspend the
spring so that it can move freely up-and-down.
Put a mass hanger on the end of the spring.

2. Add enough mass to the hanger so that the
spring's stretched length is between 6 and 7
times its unloaded length (about 70 grams if
you are using the harmonic spring from the
PASCO Introductory Dynamics System.)

3. Remove the hanger and masses temporarily.
Measure and record their total in the Data
section. Return the hanger and masses to the
end of the spring.

4. Place the Motion Sensor on the floor directly
beneath the mass hanger.

5. Adjust the position of the spring so that the
minimum distance from the mass hanger to the
Motion Sensor is greater than the Motion
Sensor’s minimum distance at the maximum
stretch of the spring.
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PART III: Data Recording

1. Pull the mass down to stretch the spring about 20 cm. Release the mass. Let it oscillate a
few times so the mass hanger will move up-and-down without much side-to-side motion.

2. Start recording data.

• The Graph displays the plots of the position and velocity of the mass as it moves up and
down.

3. Continue recording for about 10 seconds and then ‘Stop’ data recording.

• The data will appear as ‘Run #1’.

• The position curve should resemble the plot of a sine function. If it does not, check the
alignment between the Motion Sensor and the bottom of the mass hanger at the end of the
spring. You may need to increase the reflecting area of the mass hanger by attaching a
circular paper disk (about 2” diameter) to the bottom of the mass hanger.

• To erase a run of data, select the run in the Data list and press the “Delete” key.

Analyzing the Data

1. Rescale the Graph to fit the data.

• In DataStudio, click on the ‘Scale to Fit’ button ( ).

• In ScienceWorkshop, click on the ‘Autoscale’ button ( ).

2. Find the average period of oscillation of the mass.

In         DataStudio    , click the ‘Smart Tool’ button ( ).

• Move the Smart Tool to the first peak in the plot of position versus time and read the value
of time. Record the value of time in the Data Table in the Lab Report section.

• Move the Smart Tool to each consecutive peak in the plot and record the value of time
shown for each peak.

In        ScienceWorkshop    , in the Graph display, click the ‘Smart Cursor‘ ( ).

• Move the Smart Cursor to the first peak in the plot of position versus time and read the
value of time (shown below the horizontal axis). Record the value of time in the Data
Table in the Lab Report section.

• Move the Smart Cursor to each consecutive peak in the plot and record the value of time
shown below the horizontal axis for each peak.

3. Find the period of each oscillation by calculating the difference between the time for each
successive peak. Find the average of the periods. Record your result in the Data Table.

Record your results in the Lab Report section.
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Lab Report - Activity GS05: Mass on a Spring – Mechanics

What Do You Think?

What is the motion of a mass oscillating on a spring? What other motions can you think of that
are similar?

Pre-Lab Data Table

Item Value

Equilibrium Position m

Spring Constant (slope) N/m

Data Table

Mass  =     _____0.070 kg   

Peak 1 2 3 4 5 6 7

Time (s)

Period (s)

Average period of oscillation  =     __________s   

Questions

1. Calculate the theoretical value for the period of oscillation based on the measured value of
the spring constant of the spring and the mass on the end of the spring.

T = 2π m
k

2. How does your calculated value for oscillation compare to the measured value of the
period of oscillation? What is the percent difference?
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3. When the position of the mass is farthest from the equilibrium position, what is the
velocity of the mass?

4. When the absolute value of the velocity of is greatest, where is the mass relative to the
equilibrium position?

---------------------------

Ending the Activity

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select Quit  from the File  menu to end the activity.

2. You can select Save or Save As…  from the File menu to save your data for this activity and
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select Open…  from the File  menu, and find the
document for the next activity.
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Activity GS06: Boyle’s Law – Gas Laws (Pressure Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Gas laws GS06 Boyle’s Law.DS G06 Boyle’s Law G06_BOYL.SWS

Equipment Needed Qty Other Qty
Pressure Sensor (CI-6532) 1 Glycerin 1 mL
Coupling, quick-release (w/sensor) 1
Syringe (w/sensor) 1
Tubing (w/sensor) 1

What Do You Think?

What happens to the pressure in a container of air as its volume is changed while the temperature
remains constant?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Robert Boyle was an English scientist who discovered a basic fact
about gasses. When a gas is inside a cylinder and a piston moves
up or down in the cylinder to change the volume of the gas,
something also happens to the pressure of the gas.

Boyle’s Law states that the pressure of a gas in a container is
related to the volume of the gas. In other words, as the volume
changes, the pressure changes. For a given amount of a gas at a fixed temperature the pressure of
the gas is inversely proportional to the volume. One way to verify this is to graph the inverse of
gas volume versus gas pressure.

Prediction

Will the relationship between the volume and the pressure be a direct one or will it be something
else? The shape of a graph of two quantities can tell what their relationship might be.

If the two quantities have a     direct    relationship, their formula might be y = ax, where a is a
constant. If the two quantities have an    inverse     relationship, their formula might be xy = b, where
b is a constant.

Here are two examples of ‘Direct Relationship’ (on the left) versus ‘Inverse Relationship’:

• Predict what the relationship will be between pressure and volume:

prediction _____________
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SAFETY REMINDERS

•  Wear protective gear.

•  Follow directions for using the equipment.

For You To Do

Use the Pressure Sensor to measure the change in pressure of the air in a syringe as you change
the volume of the air in the syringe. Use DataStudio or ScienceWorkshop to record and analyze
the data. Determine the relationship of pressure to volume for the air in the syringe

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer,
turn on the interface, and turn on the computer.

2. Connect the Pressure Sensor’s DIN plug into Analog
Channel A on the interface.

3. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS06 Boyle’s Law.DS G06 Boyle’s Law G06_BOYL.SWS

• The DataStudio file has a Workbook display. Read the instructions in the Workbook.

• The document has a Digits display of Pressure, a Graph display of Volume and Inverse
Volume versus Pressure, and a Table of Pressure, Volume and Inverse Volume.

• Data recording is set for one measurement per second. Use the keyboard to enter the
volume of the air inside the syringe (in milliliters).
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PART II: Sensor Calibration and Equipment Setup

You do not need to calibrate the sensor.

1. Put a drop of glycerin on the barb end of a quick release coupling. Put the end of the
coupling into one end of a short piece (about 2.5 cm) of plastic tubing that comes with the
Pressure Sensor.

2. Put a drop of glycerin on the end of the syringe. Connect the end of the syringe to the other
end of the small piece of plastic tubing.

3. Align the quick-release coupling on one end of the plastic tubing with the pressure port of
the Pressure Sensor. Push the coupling onto the port, and then turn the coupling clockwise
until it clicks (about one-eighth turn).

4. Check that the syringe and Pressure Sensor have a secure seal by adjusting the volume
between 20 mL and 10 mL. It should get harder to push as the volume decreases.

5. Adjust the volume of air in the syringe to 20.0 mL. (Note: To set the initial position of the
piston in the syringe, disconnect the quick-release connector from the sensor, move the
piston to the first position (20 mL), and then re-connect the quick-release connector to the
sensor.)
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PART III: Data Recording (for DataStudio )

• In DataStudio, the Table display shows values for the gas volume in the syringe (for
example, 20, 18, 16 and so on).

1. When everything is ready, start recording data. (Hint: In DataStudio, click ‘Start’).

• In DataStudio, the ‘Start’ button changes to ‘Keep’ ( ) and the Table display
shows the value of pressure next to the first volume (20 mL).

2. Click ‘Keep’ to record the pressure.

• The Table display changes to show the next value of volume (18 mL).

3. Move the piston to the 18 mL mark and click ‘Keep’ to record the pressure.

4. Continue to move the piston to each new position and then click ‘Keep’ to record the
corresponding pressure.

5. After you record the pressure for the last volume, click ‘Stop’ () to end data recording.

6. If time permits, repeat the procedure.
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PART III: Data Recording (for ScienceWorkshop )

1. In ScienceWorkshop, click ‘REC’ to start recording data.

• The Keyboard Sampling window opens.

2. When the pressure reading stabilizes, type “20” for the volume of air in the syringe and
click ‘Enter’ to record the pressure.

3. Reduce the volume to 18 mL. Type 18 for the volume and click ‘Enter’. (Note:
ScienceWorkshop will prompt you for the third volume based on the pattern of the first two
volumes.)

4. Continue reducing the volume by 2.0 mL each time, checking the pressure, and entering the
new volume until your last entered volume is 10.0 mL.

5. After you enter the last volume, click ‘Stop Sampling’ to end data recording.

6. If time permits, repeat the procedure.

Analyzing the Data

1. Set up the Graph display so you can examine the plot of Volume versus Pressure and also
the plot of Inverse Volume versus Pressure.

2. Set up the Table display so you can examine the Pressure, Volume and Inverse Volume.

Use your observations to answer the questions in the Lab Report.

Ending the Activity

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select Quit  from the File  menu to end the activity.

2. You can select Save or Save As…  from the File menu to save your data for this activity and
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select Open… from the File menu, and find the
document for the next activity.
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Lab Report - Activity GS06: Boyle’s Law – Gas Laws

What Do You Think?

What happens to the pressure in a container of air as its volume is changed while the temperature
remains constant?

Questions

1. From looking at your data, do the pressure and volume seem to have a direction
relationship or an inverse relationship? Does this agree with Boyle’s Law?

2. What happened to the pressure when the volume went from 20 mL to 10 mL?

3. What are possible sources of error or limitations in this experiment? For each one, try to
decide what effect it might have on the experimental results.
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Activity GS07: Food Energy
(Temperature Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Biochemistry GS07 Food Energy.DS G07 Food Energy G07_FOOD.SWS

Equipment Needed Qty Equipment Needed Qty
Temperature Sensor (CI-6505A) 1 Slit stopper 1
Balance (SE-8723) 1 Stirring rod 2
Base and Support Rod (ME-9355) 1 Protective gear PS
Container (metal can), small 1 Chemicals and Consumables Qty
Clamp, Buret (SE-9446) 1 Food samples 2
Food holder 1 Matches 2
Graduated cylinder, 100 mL 1 Water 100 mL
Ring, 4 inch 1 Wood splint 2

Imagine the Following

A sports team at your school needs to find out what kind of ‘snack food’ can give them the most
energy. The team has asked you for help. Can you measure the amount of energy in a sample of
food?

What Do You Think?

All human activity requires “burning” food for energy. When samples of different
kinds of food are burned, which of the food samples will produce the most energy?

•  Marshmallow? Peanut? Cashew? Popcorn?

•  How will you compare one food sample to another?

•  Does the amount of the food sample make a difference?

•  Does the time that the food takes to burn make a difference?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

When burning food heats a known quantity of water, the amount of heat given off by the food is
theoretically equal to the amount of heat gained by the water. The following is an equation that
describes this idea:

Q = m × c × ∆T

where Q is the amount of heat, m is the mass of the water, c is the specific heat of the water, and
∆T is the change in temperature of the water.

The specific heat of water is:

c 1
calorie
gram˚C

4.18
joule

gram˚C
= =

SAFETY REMINDERS

•  Follow directions carefully when using the equipment for this activity.

•  Take care when using matches and wooden splints.

•  Wear protective gear (e.g., goggles, gloves, apron).
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For You To Do

In this activity, burn a sample of food under a container of water to heat the water. Use a
Temperature Sensor to measure the change in temperature of the water as it is heated by the
burning food. Use DataStudio or ScienceWorkshop to record and analyze the data.

Compare the amount of heat given off by one type of food to the amount of heat given off by a
different type of food.

PART I: Computer Setup

1. Connect the ScienceWorkshop
interface to the computer, turn on
the interface, and turn on the
computer.

2. Connect the DIN plug of the
Temperature Sensor into Analog
Channel A of the interface.

3. Open the file titled as shown:

DataStudio ScienceWorkshop  (Mac) ScienceWorkshop  (Win)
B01 Food Energy.DS B02 Food Energy B02_FOOD.SWS

• The file has a Digits display, a Graph display, and a Table display of Temperature versus
Time.

• The DataStudio file also has a Workbook display. Read the instructions in the Workbook.
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PART II: Sensor Calibration and Equipment Setup

You do not need to calibrate the Temperature Sensor.

1. Set up the equipment as shown.

2. Put the bottom of the container about 2.5 cm above the food holder.

Do you need to measure the amount of water that will be heated?

Do you need to record the type of food being tested?

Do you need to measure the initial mass of the food sample that will be burned?

TO INTERFACE

TEMPERATURE SENSOR

SLIT STOPPER

UTILITY CLAMP

STIRRING ROD

IRON RING

CAN

FOOD SAMPLE

FOOD HOLDER

PART IIIA: Data Recording

1. Start recording data.

2. Light the wooden splint with a match and use the splint to light your food sample. Quickly
place the burning food sample directly under the center of the container. Leave the sample
under the container until the food sample stops burning.

CAUTION:  Keep hair, clothing, and other items away from open flames.

3. Leave the sensor in the water for at least 45 seconds after the food has stopped burning. Stir
the water until the temperature stops rising. Stop recording data when the temperature stops
rising.

Do you need to measure the final mass of the remains of the burned food sample?

4. Repeat the data recording process for the second food sample. Use a new quantity of cold
water.

What measurements do you need to record?
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Analyze the Data

1. Use your recorded data to find the change in temperature of the water heated by the first
food sample.

What measurements do you need to record?

2. Repeat the analysis for the second run of data.

3. Calculate the heat absorbed by the water, Q, for each food sample. Remember the equation:

Q = m × c × ∆T

For water, the specific heat “ c”  is 4.18 J/g°C.

How would you convert the heat absorbed from joules  to kilojoules  (kJ)?

4. Determine the mass of the food that burned.

5. Calculate the energy content, or ratio of heat (in kilojoules) divided by the mass of burned
food (in grams), for each food sample.

How do your results compare with others in your class?

Record your results in the Lab Report section.

---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this activity.
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Lab Report - Activity GS07: Energy Content of Foods

What Do You Think?

All human activity requires “burning” food for energy. When samples of different kinds of food
are burned, which of the food samples will produce the most energy?

Data Table
Item Sample 1

marshmallow
Sample 2
popcorn

Sample 3
__________

Sample 4
___________

mass of empty container g g g g

mass of container + water g g g g

mass of water g g g g

initial mass, sample + holder g g g g

final mass, sample + holder g g g g

change of mass, food sample g g g g

initial temperature C C C C

final temperature C C C C

temperature change, ∆T C C C C

heat, Q kJ kJ kJ kJ

energy content kJ/g kJ/g kJ/g kJ/g

Class Results Table: Average Energy Content for each food type:

Food Type Marshmallows Peanuts Cashews Popcorn

Energy content kJ/g kJ/g kJ/g kJ/g

Questions

1. Which food had the highest energy content?

2. Which food had the lowest energy content?
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3. Food energy is expressed in a unit called a Calorie. There are 4.18 kilojoules (or 4180
joules) in one Calorie. Based on the class average for peanuts, calculate the number of
Calories in a 50-gram package of peanuts.

4. Two of the foods in the activity have a high fat content (peanuts and cashews) and two
have a high carbohydrate content (marshmallows and popcorn). From your results, what
can you conclude about the relative energy content of fats and carbohydrates?

5. What advice would you give to a sports team about the energy content of these foods?

6. Do you think that all of the energy released by the burning food sample was absorbed by the
water?

Why or why not?

7. What are some things you would do to change the procedure in this activity?
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Activity GS08: Catalase Activity – Enzyme Action
(Pressure Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Biochemistry GS08 Catalase. ActivityDS G08 Catalase Activity G08_CATA.SWS

Equipment Needed Qty Chemicals and Consumables Qty
Pressure Sensor – Abs. (CI-6532) 1 Chicken liver extract 10 mL
Balance (SE-8723) 1 Glycerin 1 mL
Connector (640-030) 1 Hydrogen peroxide, 3% 100 mL
Flask, 250 mL 1 Sodium fluoride, solid 0.1 g
Graduated cylinder, 100 mL 1 Sodium carbonate, solid 1 g
Magnetic stirrer & spin bar  1  Water, distilled  500 mL
Stopper, one hole, for flask  1   
Test tube  1   
Tubing (w/ sensor)  1   
Protective gear PS

What Do You Think

What are some factors that can influence the rate of enzyme activity in an organism?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

In this activity you will study some of the factors that influence the rate
of reaction of an enzyme activity. The enzyme is called catalase . It
changes poisonous hydrogen peroxide to water and oxygen.

When cells convert food into energy (in the process called cellular
respiration), one of the by-products is hydrogen peroxide. Hydrogen
peroxide is a very active chemical. It can poison other chemicals in a
cell causing the cell to die. Catalase is an enzyme that can break down
the poisonous hydrogen peroxide.

Catalase reduces the peroxide part of the hydrogen peroxide molecule
into water and oxygen by the following reaction:

2H O 2H O O (gas)2 2 2 2
Catalase → +

(substrate) (products)(enzyme)

Since catalase is not used up in the chemical reaction, the same enzyme can start another
reaction. This activity will measure the rate at which the catalase enzyme can reduce the toxic
hydrogen peroxide to the harmless products of water and oxygen.

Since the breakdown of hydrogen peroxide produces oxygen gas, what is a way to measure the
rate of the production of that gas?

Take time to write an answer to this question in the Lab Report section.
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SAFETY REMINDERS

•  Wear protective gear while handling chemicals.

•  Follow directions for using the equipment.

•  Dispose of all chemicals and solutions properly.

For You To Do

Use the Pressure Sensor to measure the change in gas pressure inside a flask containing
hydrogen peroxide and a source of catalase enzyme. The first trial will show how pure crude
catalase reacts with the hydrogen peroxide solution. The other three trials will show what
happens if other chemicals are added to change the hydrogen peroxide or dilute the catalase. Use
DataStudio or ScienceWorkshop to record and analyze the data.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on the
interface, and turn on the computer.

2. Connect the Pressure Sensor DIN plug into Analog Channel A on the
interface.

3. Open the file titled as shown;

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS08 Catalase. ActivityDS G08 Catalase Activity G08_CATA.SWS

• The DataStudio file has a Workbook display. Read the instructions in the Workbook. The
file has a Graph of Pressure versus Time and a Digits display of Pressure.

• The ScienceWorkshop document opens with a Graph display of Pressure (kPa) versus Time
(s).

• Data recording is set for 1 measurement per second with a ‘Stop’ condition at 150 s.
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PART II: Sensor Calibration and Equipment Setup

Sensor Calibration

•  You do not need to calibrate the Pressure Sensor for this activity.

Set Up the Equipment

1. Put a drop of glycerin on the barb end of the quick-
release connector and insert the barb into one end
of the plastic tubing.

2. Put a drop of glycerin on the smaller diameter end
of the connector that will go into the stopper.
Insert the small diameter end into the plastic tubing. 

3. Put a drop of glycerin on the larger diameter end of the connector
that will go into the stopper, and insert the end into the stopper.

4. Carefully put a spin bar into the flask and place the flask on the
magnetic stirrer.

PART III: Data Recording

•  There are four parts to the data recording.

Part Catalase
Sodium
Fluoride

Sodium
Carbonate

Hydrogen
Peroxide

A 2 mL crude catalase none none 15 mL diluted to 100 mL

B 2 mL crude catalase 0.1 g none 15 mL diluted to 100 mL

C 2 mL crude catalase none 1.0 g 15 mL diluted to 100 mL

D 1 mL crude catalase diluted with 1 mL
of distilled water

none none 15 mL diluted to 100 mL

CONNECTOR
(640-030)

RUBBER
STOPPER

Magnetic Stirrer

Spin bar

QUICK-RELEASE 
CONNECTOR

(640-021)

CONNECTOR
(640-030)
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Sensor

Pressure port

Quick release
connector

Tubing

PART IIIA: Catalase  + Hydrogen Peroxide

Prepare the Mixture

1. Pour 15 mL of 3% hydrogen peroxide in a 100 mL graduated cylinder.
Fill the cylinder to the 100-mL mark with 85 mL of distilled water.

2. Transfer the diluted peroxide solution to the flask.

3. Turn on the stirrer.

4. Add 2 mL of catalase extract to the dilute peroxide solution in the flask.

5. Put the one-hole stopper into the flask.

6. Align the quick-release connector on the end of the
plastic tubing with the connector on the pressure
port of the Pressure Sensor. Push the connector onto
the port, and then turn the connector clockwise until
it clicks (about one-eighth turn).

Record the Data

7. Start recording data. (Hint: Click ‘Start’ in DataStudio or ‘REC’ in ScienceWorkshop.)

• Data recording will stop automatically at 150 seconds.

Clean Up

8. Disconnect the tubing from the Pressure Sensor. Remove the stopper from the flask.

9. Dispose of the peroxide mixture as directed and clean the flask thoroughly.

Part IIIB: Catalase  + Hydrogen Peroxide + Sodium Fluroide

Make a prediction:

What effect do you think adding an inhibitor to the hydrogen peroxide will have on the
enzymes’s ability to catalyze the breakdown of the peroxide? Put your prediction and a brief
explanation in the Lab Report.

Prepare the mixture

1. Repeat the data recording procedure. Put 100 mL of dilute peroxide solution in the flask.
Add the spin bar.

2. Add 0.1 g of sodium fluoride to the peroxide solution. Add 2 mL of catalase extract to the
flask and stopper the flask.

3. Re-connect the tubing to the Pressure Sensor.

Hydrogen
Peroxide
 (15 mL)

Add 85 mL of
Distilled Water

Dilute Hydrogen
Peroxide + Catalase

Stopper
Tubing to
sensor
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Record the data

4. Start recording data. (Data recording will stop automatically at 150 seconds.)

Clean Up

5. Disconnect the tubing from the Pressure Sensor. Remove the stopper from the flask.

6. Dispose of the peroxide mixture as directed and clean the flask thoroughly.

Part IIIC: Catalase  + Hydrogen Peroxide + Sodium Carbonate

Make a prediction:

What effect do you think adding a base to the hydrogen peroxide will have on the enzymes’s
ability to catalyze the breakdown of the peroxide? Put your prediction and a brief explanation in
the Lab Report.

Prepare the mixture

1. Repeat the data recording procedure. Put 100 mL of dilute peroxide solution in the flask.
Add the spin bar.

2. Add 1.0 g of sodium carbonate to the peroxide before you add the catalase. Add 2 mL of
catalase extract to the flask and stopper the flask.

3. Re-connect the tubing to the Pressure Sensor.

Record the data

4. Start recording data. (Data recording will stop automatically at 150 seconds.)

Clean Up

5. Disconnect the tubing from the Pressure Sensor. Remove the stopper from the flask.

6. Dispose of the peroxide mixture as directed and clean the flask thoroughly.

Part IIID: Diluted Catalase  + Hydrogen Peroxide

Make a prediction:

What effect do you think diluting the catalase will have on the enzymes’s ability to catalyze the
breakdown of the peroxide? Put your prediction and a brief explanation in the Lab Report.

Prepare the mixture

1. Repeat the data recording procedure. Put 100 mL of dilute peroxide solution in the flask.
Add the spin bar.

2. Put 1 mL of crude catalase extract into the test tube. Add 1 mL of distilled water to dilute
the catalase. Add the diluted catalase extract to the flask and stopper the flask.

3. Re-connect the tubing to the Pressure Sensor.

Record the data

4. Start recording data. (Data recording will stop automatically at 150 seconds.)

Clean Up

5. Disconnect the tubing from the Pressure Sensor. Remove the stopper from the flask.

6. Dispose of the peroxide mixture as directed and clean the flask thoroughly.

ENDING THE ACTIVITY (See the section after Questions)
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Analyzing the Data

1. Set up the Graph display to show all your data

• Hint: DataStudio automatically shows all the runs of data. In ScienceWorkshop, do the
following to put two runs of data in the top plot and two runs of data in the bottom plot.

• Click the ‘Add Plot Menu’ button ( ) to add a second plot to the Graph window.
Select Analog Channel A, Pressure  from the Add Plot
Menu.

• Click the ‘Add Plot Menu’ button again to add a third
plot to the Graph window. Select Analog Channel A,
Pressure  from the Add Plot Menu.

• Click the ‘DATA Menu’ button ( ) in the top plot. Select Run
#1 from the DATA Menu. Repeat to select Run #2 from the DATA
menu.

• Click the ‘DATA Menu’ button in the middle plot. Select No Data
first.

• Use the Data Menu in the second plot to select Run #3 and then Run #4.

2. Use the built-in statistics for the Graph display to find the minimum pressure and the
maximum pressure for each run of data.

• Hint: In DataStudio, click the ‘Statistics Menu’ button ( ). The default statistics are
‘Minimum’ and ‘Maximum’. The values appear in the legend in the display area.

In ScienceWorkshop, click the ‘Statistics’ button ( ) to open the statistics area. Click

the ‘Statistics Menu’ button ( ). Select ‘Maximum’ from the menu. Repeat and select
‘Minimum’ from the menu.

3. Record the minimum pressure as the starting pressure. Record the maximum pressure as
the ending pressure.

4. Calculate the difference in pressure.

5. Calculate the enzyme activity. Divide the difference in pressure by the amount of time (in
minutes).

Catalase Activity =
Ending Pressure - Starting Pressure

2.5 minutes

Record your results in the Lab Report section.
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Lab Report - Activity GS08: Catalase Activity – Enzyme Action

What Do You Think

What are some factors that can influence the rate of enzyme activity in an organism?

Since the breakdown of hydrogen peroxide produces oxygen gas, what is a way to measure the
rate of the production of that gas?

Predictions

Part IIIB: Catalase + Hydrogen Peroxide + Sodium Fluoride

What effect do you think adding an inhibitor to the hydrogen peroxide will have on the
enzymes’s ability to catalyze the breakdown of the peroxide?

Part IIIC: Catalase + Hydrogen Peroxide + Sodium Carbonate

What effect do you think adding a base to the hydrogen peroxide will have on the enzymes’s
ability to catalyze the breakdown of the peroxide?

Part IIID: Diluted Catalase + Hydrogen

What effect do you think diluting the catalase will have on the enzymes’s ability to catalyze the
breakdown of the peroxide?

Data Table

Item Part IIIA Part IIIB
Sodium Fluoride

Part IIIC
Sodium Carbonate

Part IIID
Diluted

Starting Pressure kPa kPa kPa kPa

Ending Pressure kPa kPa kPa kPa

Pressure Difference kPa kPa kPa kPa

Activity (kPa/min)
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Questions

1. What happens to the pressure inside the flask when pure crude catalase is added to diluted
hydrogen peroxide?

2. What is the effect of adding sodium fluoride to the solution of hyrodgen peroxide? Is there
as much reaction, more reaction, or less reaction than without the sodium fluoride?

3. What is the effect of adding sodium carbonate to raise the pH of the solution of hydrogen
peroxide? Is there as much reaction, more reaction, or less reaction than without the
sodium carbonate?

4. What is the effect of diluting the catalase before you added it to the solution of hydrogen
peroxide? Is there as much reaction, more reaction, or less reaction than when you used
pure crude catalase?

---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Activity GS09: Fermentation in Grape Juice
(Pressure Sensor – Absolute, Temperature Sensor)

Concept DataStudio ScienceWorkshop  (Mac) ScienceWorkshop (Win)
Cellular respiration GS09 Fermentation. DS G09 Glycolysis G09_GLYC.SWS

Equipment Needed Qty Equipment Needed Qty
Pressure Sensor – Abs. (CI-6532) 1 Stopper, one hole, for flask 1
Temperature Sensor (CI-6505) 1 Tubing (w/ sensor)
Balance (SE-8723) 1 Protective gear PS
Beaker, 250 mL 1 Chemicals and Consumables Qty
Connector (640-030) 1 Glycerin 1 mL
Flask, 250 mL 1 Grape juice 300 mL
Graduated cylinder 1 Sodium fluoride, solid 1 g
Hot plate 1 Weighing paper 1
Magnetic stirrer & spin bar 1 Yeast suspension 20 mL

What Do You Think?

How does the pressure inside a closed vessel change as yeast converts the
sucrose in grape juice into ethanol and carbon dioxide?

What factors can alter the rate of the fermentation of grape juice and what
changes would you expect to see as you apply those factors?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

All life forms need to convert or transform energy-rich organic
molecules like sugars into forms of energy that can be used to
perform cell work. Cellular respiration  is the set of chemical
reactions during which molecules are broken down to release
energy. For example, yeast cells break down sugar (sucrose) in
grape juice. They produce carbon dioxide gas and alcohol
(ethanol).

There are two types of cellular respiration – aerobic and
anaerobic – and both begin with glycolysis. Prior to glycolysis, an enzyme (zymase) breaks a
molecule of sucrose into glucose and fructose. During glycolysis, the glucose breaks down into
pyruvic acid. Animal cells and some one-cell organisms convert the pyruvic acid to lactic acid
(lactic acid fermentation). Some
plant cells and one-cell organisms
convert the pyruvic acid to alcohol
(ethanol) and carbon dioxide gas
(alcoholic fermentation).

As in most biological reactions,
cellular respiration is controlled by
a series of enzymes (such as
zymase). The enzymes that help this
system of chemical events are often
sensitive to physical and chemical
conditions such as temperature and
pH.

O

O

O

CH2OH

Zymase enzyme attacks here.

CH2OH

CH2OH

Sucrose

Glucose Fructose

Glucose
(6-carbon compound)

Energy
(2 ATP)

Pyruvate
(3-carbon compound)

Alcoholic Fermentation

Ethanol + Carbon Dioxide
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Lactic Acid
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Anaerobic Cellular
Respiration

…or…
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SAFETY REMINDERS

•  Wear protective gear while handling chemicals.

•  Follow directions for using the equipment.

•  Dispose of all chemicals and solutions properly.

For You To Do

Use the Pressure Sensor to measure the change in pressure in a flask containing a mixture of
activated yeast and grape juice. Then repeat the measurement for a mixture of activated yeast,
grape juice, and a small amount of a chemical – sodium fluoride. Use DataStudio or
ScienceWorkshop to record and display the data. Use the software to analyze the data.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on the
interface, and turn on the computer.

2. Connect the Pressure Sensor DIN plug into Analog Channel A on the
interface.

3. Connect the Temperature Sensor DIN plug into Analog Channel B
on the interface.

4. Open the file titled as shown:

DataStudio ScienceWorkshop  (Mac) ScienceWorkshop (Win)
GS09 Fermentation. DS G09 Glycolysis G09_GLYC.SWS

• The DataStudio file has a Workbook display. Read the instructions in the Workbook.

• The ScienceWorkshop file has a Graph display of Pressure versus Time.

• Data recording for the Pressure Sensor is set at 1 measurement per five seconds.

NOTE: In the DataStudio file, data recording for the Temperature Sensor is set at 2
measurements per second (or 2 Hz). See the pages at the end of the activity for instructions about
how to set up the ScienceWorkshop file to measure temperature.
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PART II: Sensor Calibration and Equipment Setup

Sensor Calibration

• You do not need to calibrate the Pressure Sensor for this activity since you will measure the change in
pressure.

Prepare the Grape Juice

1. Put 150 mL of grape juice in a beaker. Place the beaker on a hot
plate. Place the Temperature Sensor in the grape juice.

2. Turn on the hot plate. Warm the juice to a temperature of 35˚
Celsius. Use the software to monitor the temperature of the grape
juice.

• Hint: In DataStudio, click ‘Monitor’ in the Experiment menu. In ScienceWorkshop, click
the MON button. Watch the temperature in the Digits display.

•  Do not warm the grape juice above 40°C. The yeast will begin to die at around 42°C. The
optimum temperature for the yeast is around 35°C.

Set Up the Equipment

3. Put a drop of glycerin on the barb end of the quick-release connector and insert the barb
into one end of the plastic tubing.

4. Put a drop of glycerin on the smaller diameter end of the connector that will go into the
rubber stopper. Insert the small diameter end into the plastic tubing. 

5. Put a drop of glycerin on the larger diameter end of the connector that
will go into the rubber stopper, and insert the end into the rubber
stopper.

6. Align the quick-release connector on the end of the plastic tubing with
the connector on the pressure port of the pressure sensor. Push the
connector onto the port, and then turn the connector clockwise until it
clicks (about one-eighth turn). 

QUICK-RELEASE 
CONNECTOR

(640-021)

CONNECTOR
(640-030)

CONNECTOR
(640-030)

RUBBER
STOPPER

Sensor

Pressure port

Quick release
connector

Tubing
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Part IIIA: Data Recording – Graph Juice and Yeast Suspension

1. Remove the Temperature Sensor from the beaker. In the software, stop monitoring the
temperature of the grape juice.

2. Transfer the warmed grape juice to the flask. Add a spin bar to the
flask.

3. Gently add 10 mL of yeast suspension to the juice. (Remember, the
yeast are alive!)

4. Stopper the flask with the rubber stopper. Use a twisting motion to get
a tight fit. Place the flask on the magnetic stirrer. Turn on the stirrer
and adjust to a moderately fast stirring rate.

5. Start recording data.

•  Hint: In DataStudio, click the ‘Start’ button ( ). In ScienceWorkshop, click the

‘REC’ button ( ).

• What happens to the pressure in the flask? What do you think the yeast are doing to the
grape juice that causes this effect?

6. Allow the yeast to metabolize the grape juice for about 40 minutes and then stop recording
data.

• Be sure you have stopped recording before you carefully remove the stopper from the flask.

7. Dispose of the grape juice/yeast mixture as instructed.

Pressure
Sensor

Magnetic
Stirrer

Spin bar
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Part IIIB: Data Recording – Grape Juice, Yeast Suspension and Sodium Fluoride

Prepare the Grape Juice and Sodium Fluoride

1. Put 150 mL of grape juice in a beaker. Add 1.0 g of
sodium fluoride to the grape juice.

2. Place the beaker on a hot plate. Place the Temperature
Sensor in the grape juice.

3. Turn on the hot plate. Warm the juice to a temperature
of 35˚ Celsius. Use the software to monitor the
temperature of the grape juice.

• Hint: In DataStudio, click ‘Monitor’ in the Experiment
menu. In ScienceWorkshop, click the MON button. Watch the temperature in the Digits
display.

•  Do not warm the grape juice above 40°C. The yeast will begin to die at around 42°C. The
optimum temperature for the yeast is around 35°C.

Record Data

1. Remove the Temperature Sensor from the beaker. In the software, stop monitoring the
temperature of the grape juice.

2. Transfer the warmed grape juice/sodium fluoride mixture to the flask. Add a spin bar to the
flask.

3. Gently add 10 mL of yeast suspension to the juice. (Remember, the yeast are alive!)

4. Stopper the flask with the rubber stopper. Use a twisting motion to get a tight fit. Place the
flask on the magnetic stirrer. Turn on the stirrer and adjust to a moderately fast stirring
rate.

5. Start recording data.

• What happens to the pressure in the flask?

6. Allow the yeast to metabolize the grape juice for about 40 minutes and then stop recording
data.

• Be sure you have stopped recording before you carefully remove the stopper from the flask.

7. Dispose of the grape juice/yeast mixture as instructed.

Optional

• Variations to this activity can be performed by different lab teams and the results can be shared
and analyzed by the entire class.

1. Vary the pH Level: Vary the pH level in the yeast/juice mixture by adding 25 mL of any of
the following buffer solutions to 125 mL of grape juice: (a) pH buffer 2, (b) pH buffer 3,
(c) pH buffer 4, and (d) pH buffer 6. (e) pH buffer 10

2. Vary the Yeast Concentration: Vary the amount of yeast by mixing and using suspensions
of 100 mL of water and (a) 1 g, (b) 3 g, (c) 6 g, (d) 12 g, or (e) 20 g of dry yeast.

Weighing paper
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Analyzing the Data:

1. Set up your Graph display so it shows your data.

2. Use the Graph display’s built-in statistics to determine the Ending Pressure, the Starting
Pressure, the Ending Time and the Starting Time for the first run of data.

•  Hint: In DataStudio, click the ‘Statistics’ menu button ( ) and select ‘Show All’. In
ScienceWorkshop, click the ‘Statistics’ button to open the statistics area of the Graph.

Click the ‘Statistics Menu’ button ( ) and select ‘All of the Above’ from the Statistics
menu.

3. Record the minimum X as Starting Time in the Data Table in the Lab Report section.
Record the maximum X as Ending Time.

4. Record the minimum Y as Starting Pressure in the Data Table. Record the maximum Y as
Ending Pressure.

5. Calculate the difference/change in pressure and record it in the Data Table. Calculate the
difference/change in time and record it in the Data Table.

6. Calculate the rate of production of carbon dioxide by the yeast from grape juice and record
the rate.

Divide the difference in Pressure readings by the difference in Time.

Rate of Carbon Dioxide Production =
Ending Pressure - Starting Pressure

Ending Time - Starting Time
7. Repeat the process for the second run of data (grape juice and sodium fluoride).

Optional:

•  Collect the data from the other experimental runs conducted in class and record them.
Calculate the rate of production of carbon dioxide for each of the experimental runs.

Record your results in the Lab Report section.

---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Lab Report - Activity B02: Fermentation of Grape Juice

How does the pressure inside a closed vessel change as yeast converts the sucrose in grape juice
into ethanol and carbon dioxide?

What factors can alter the rate of the fermentation of grape juice and what changes would you
expect to see as you apply those factors?

Data Table

Item Initial Trial With NaF

Starting Time min min

Ending Time min min

Difference in Time min min

Starting Pressure kPa kPa

Ending Pressure kPa kPa

Difference in Pressure kPa kPa

Rate of CO2 Production kPa/min kPa/min

Questions

1. What is the rate of production of carbon dioxide gas for the grape juice and yeast mixture?

2. What happens to the rate of carbon dioxide production in the flask when the sodium
fluoride is added to the grape juice?
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Appendix: Set Up ScienceWorkshop

Modify the ScienceWorkshop file to monitor temperature as you warm the grape juice.

Set Up the Sensor

In the Experiment Setup window, click and drag the analog sensor plug to Channel B.

Select ‘Temperature Sensor’ from the list of sensors. Click ‘OK’ to return to the Experiment
Setup window

Set Up the Display

In the Experiment Setup window, click and drag the Digits display icon to the Temperature
Sensor icon.

Arrange the windows so you can see the Digits display of temperature.



Name _____________________ Class ______________ Date _________

GS10 © 1999 PASCO scientific p. 75

Activity GS10: Heart Rate, Carbon Dioxide, and Exercise
(Heart Rate Sensor, pH Sensor)

Concept DataStudio ScienceWorkshop  (Mac) ScienceWorkshop (Win)
Physiology GS10 Heart Rate. DS G10 Heart Rate G10_RATE.SWS

Equipment Needed Qty Chemicals and Consumables Qty
Heart Rate Sensor (CI-6543B) 1 Buffer solution: high pH 100 mL
pH Sensor (CI-6507A) 1 Buffer solution: low pH 100 mL
Balance (SE-8723) 1 Straw 1
Beaker, 250 mL 3 Water, distilled 500 mL
Cup 1
Wash bottle 1
Protective gear PS

NOTE: This activity requires the person whose heart rate is being measured to perform exercise
(e.g., jogging in place) for several minutes. Do NOT perform this activity if vigorous activity will
cause discomfort or be hazardous to the health of the person.

What Do You Think?

How will mild exercise affect your heart rate and recovery time and how will it affect the amount
of carbon dioxide in your breath?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

You probably have experienced the sensation of
your heart beating strongly and your chest
heaving after you participate in strenuous
physical activity.

Your nervous system monitors your entire body
and signals your heart to beat faster in response
to increased activity. You also increase your rate
of breathing in order to keep up with your body’s
demands for more oxygen and for the removal of
carbon dioxide.

Pulse rate, as measured by a Heart Rate Sensor
using the ScienceWorkshop interface or manually
at the wrist, measures how fast your heart is
beating. Recovery time is how long it takes for the heart to return to its normal resting rate. If
you blow through a straw into water, some of the carbon dioxide in your exhaled breath is
dissolved into the water and changes the pH (measure of acidness) of the water.

The Heart Rate Sensor is a small device that sends light through your ear lobe. As your heart
pumps blood through your ear, the sensor measures changes in the amount of light transmitted
through your ear lobe. The measurements correspond to beats of your heart and are recorded as
voltage changes that the program can use to calculate your pulse rate.

The pH Sensor is a special type of electrode that measures the pH (potential of hydronium) of
a substance. The pH of a substance is a measure of whether it is an acid, a base, or neutral. When
carbon dioxide gas dissolves in water, it turns the water into a weak acid. The pH Sensor
measures the change in pH of the water.

HEART RATE

BREATHING RATE
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For You To Do

Use the Heart Rate Sensor to measure the heart rate of a person before and after mild exercise.
Record the resting heart rate, the heart rate after mild exercise, and the amount of time it takes
for the person’s heart rate to return to normal after exercise (called the recovery time).

Use the pH Sensor to measure the change in the pH of water that the same person will blow
through before and after mild exercise. The carbon dioxide gas in the person’s breath will
dissolve in the water and turn it into a weak acid.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer,
turn on the interface, and turn on the computer.

2. Connect the DIN plug of the Heart Rate Sensor to Analog
Channel A on the interface.

3. Connect the DIN plug of the pH Sensor to Analog Channel
B on the interface.

4. Open the file titled as shown:

DataStudio ScienceWorkshop  (Mac) ScienceWorkshop (Win)
GS10 Heart Rate. DS G10 Heart Rate G10_RATE.SWS

• The document will open with a Digits display for heart rate, a Digits display for pH, a
Table display for heart rate and pH, and a Graph display for heart rate and pH versus time.

The DataStudio file also has a Workbook display. Read the instructions in the display.

• Data recording is set at 50 measurements per second (50 Hz) and will stop automatically at
60 seconds.

PART II: Sensor Calibration and Equipment Setup

Sensor Calibration: pH Sensor

• To calibrate the pH Sensor you will need the following:
wash bottle, distilled water, three beakers, buffer solutions
of high pH (e.g. pH 10) and low pH (e.g. pH 4), pH
Sensor.

• Put distilled water into the wash bottle and into one of the beakers. Put about 100 mL of
the high pH buffer solution in one of the other two beakers and about 100 mL of the low
pH buffer solution into the third beaker.

1. Remove the pH electrode from its bottle of buffer solution. Connect the electrode to the pH
Sensor amplifier. To connect the electrode, push the BNC plug onto the receptacle on the
Sensor amplifier and turn the BNC plug clockwise until it ‘clicks’ into place.
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2. Use the wash bottle to rinse the end of the electrode. Soak the pH electrode in the beaker of
distilled water for 10 minutes.

3. In the Experiment Setup window, double-click the pH Sensor icon.

• In DataStudio, the Sensor Properties window will open. Click the ‘Calibration’ tab. In
ScienceWorkshop, the Sensor Setup window will open.

4. Calibrate with the high pH buffer solution.

•  Put the end of the pH electrode into the high pH buffer solution.

•  Check the voltage under ‘Current Reading’ in DataStudio or next to ‘Cur Value:’ in
ScienceWorkshop.

•  When the voltage stabilizes, click the ‘Take Reading’ button under ‘High Point’ in
DataStudio or the ‘Read’ button in the row for ‘High Value:’ in ScienceWorkshop.

•  Enter the pH value of the buffer solution.

5. Thoroughly rinse the pH electrode with distilled water
and dry it with a tissue.

6. Calibrate with the low pH buffer solution.

•  Put the end of the pH electrode in the low pH buffer
solution.

•  Check the voltage under ‘Current Reading’ in
DataStudio or next to ‘Cur Value:’ in
ScienceWorkshop.

•  When the voltage stabilizes, click the ‘Take Reading’ button under ‘Low Point’ in
DataStudio or the ‘Read’ button in the row for ‘Low Value:’ in ScienceWorkshop.

pH Electrode

Wash bottle

Beaker
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•  Enter the pH value of the buffer solution. Click OK to return to the Experiment Setup
window.

7. Thoroughly rinse the pH electrode with distilled water and dry gently.

• You do not need to calibrate the Heart Rate Sensor. You will have a chance to check the
Heart Rate Sensor before you begin recording data.

Equipment Setup

1. Gently put the ear clip of the Heart Rate Sensor onto an ear lobe of the person who is to be
tested. Connect the phone plug on the end of the ear clip cable into the side of the Heart
Rate Sensor box.

TO
INTERFACE

EAR CLIP ON
EAR LOBE

HEART RATE
SENSOR

2. Put distilled water into the cup. Put a straw into the water. Put the pH Electrode into the
water.

STRAW

pH
SENSOR

TO
INTERFACE

CUP OF
WATER

Sensor Check

DO NOT blow into the straw during the Sensor Check.

1. Monitor data to check the Heart Rate Sensor and the pH Sensor. (In DataStudio, select
‘Monitor Data’ in the Experiment menu. In ScienceWorkshop, click ‘MON’.)

2. Watch the Digits displays for Heart Rate and pH. The Digits display for Heart Rate may
take a few moments before it shows a number. Be patient.

3. After a few moments, click the STOP button to end the Sensor Check.

• If the Heart Rate value remains at zero, try adjusting the ear clip on the ear lobe.
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PART IIIA. Data Recording for Resting Heart Rate

1. Have the person who is being tested relax in a chair for about a minute. When the person is
ready, begin recording data while the person is at rest.

• Data recording begins immediately, but the value of Heart Rate in the Digits display may
not change for a few seconds.

2. Have the person take a few relaxed, deep breaths and then blow through the straw into the
cup of water that has the pH Sensor in it. The person should blow at a steady rate for as
long as possible without feeling uncomfortable.

• Data recording will end automatically after 60 seconds.

• Run #1 will appear in the Data list.

PART IIIB. Data Recording After  Mild Exercise

• In this part of the activity you will measure Heart Rate and the change in pH of the water
after the person being tested has done mild exercise.

1. Remove the ear clip from the ear lobe of the person being tested.

2. Have the person stand up and do mild exercise such as “jogging in place” to raise the heart
rate and the breathing rate for at least one minute.

3. After one minute of exercise, have the person sit down again. Quickly put the ear clip back
on the person’s ear lob and begin recording data again.

• Data recording begins immediately, but the value of Heart Rate in the Digits display may
not change for a few seconds.

4. Have the person take a few deep breaths and then blow through the straw into the cup of
water that has the pH Sensor in it. The person should blow at a steady rate for as long as
possible without feeling uncomfortable.

• Data recording will end automatically after 60 seconds.

• Run #2 will appear in the Data list.

--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this activity
and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Analyzing the Data

1. Rescale the Graph display to fit the data. (Click ‘Scale to Fit’ in DataStudio or ‘Autoscale’
in ScienceWorkshop.)

2. Use the ‘Statistics’ feature in the Table display to find the ‘Mean’ heart rate and the ‘Min’
(minimum) value of pH for each run of data. (Click the ‘Statistics’ menu in DataStudio, or

the ‘Statistics’ button ( ) in ScienceWorkshop. The bottom part of the Table will show
the values. Note: The numbers in this example are “made up”. Your numbers will probably
be very different.)

3. Record the Mean heart rate for both runs of data. Record the Min (minimum) value of pH for
both runs of data.

Record your results in the Lab Report section.
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Lab Report - Activity GS10: Heart Rate, Carbon Dioxide, and Exercise

What Do You Think?

How will mild exercise affect your heart rate and recovery time and how will it affect the amount
of carbon dioxide in your breath?

Data Table

Trial Mean heart rate (bpm) Minimum pH

Run #1 (rest)

Run #2 (post-exercise)

Questions

1. What was the control in your experiment?

2. What is the influence of exercise on your heart rate?

3. What is the influence of exercise on the amount of carbon dioxide gas in your exhaled
breathe?

4. Are there any differences between male and female heartbeat rates and carbon dioxide
amounts among the students of your class?

5. How do you explain the pH value in the water before exercise to the pH value in the water
after exercise?
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Activity GS11: The Effect of Respiration on Dissolved O 2 Concentrations
(Dissolved Oxygen Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Environment GS11 Dissolved O2.DS (See end of activity) (See end of activity)

Equipment Needed Qty Chemicals and Consumables Qty
Dissolved Oxygen Sensor (CI-6542) 1 Sugar 5 g
Temperature Sensor (CI-6505A) 1 Water, distilled or deionized 400 mL
Balance (SE-8723) 1 Weighing paper 1
Beaker, 600 mL 1 Yeast suspension 5 mL
Bottle, about 1 L, with cap 1
Graduated cylinder 1
Stirring rod 1
Protective gear PS

What Do You Think?

The purpose of this activity is to study the effect of respiration on dissolved oxygen
concentrations. What effect do you think yeast will have on the dissolved oxygen concentration
in water?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

During cellular respiration, organisms break apart carbohydrates (such as
sugar) to release energy. There are two types of cellular respiration –
anaerobic and aerobic. Both types begin with glycolysis in which glucose is
converted to pyruvic acid.

C H O O H O CO6 12 6 2 2 26 6 6+ → + + energy

Aerobic cellular respiration requires oxygen. If yeast in a sugar solution break
down the sugar during aerobic cellular respiration, the concentration of
oxygen in the solution should decrease.

Yeast are ectotherms whose metabolism is determined in part by the temperature of their
surroundings. The aerobic cellular respiration in yeast is particularly sensitive to temperature.

SAFETY REMINDERS

•  Wear protective gear while handling chemicals.

•  Follow directions for using the equipment.

•  Dispose of all chemicals and solutions properly.

For You To Do

Use a Dissolved Oxygen Sensor to measure the concentration of dissolved oxygen in a dilute
sugar solution before and after a small amount of yeast suspension is added to the solution. Use
DataStudio or ScienceWorkshop to record and display the measured data.

Compare the concentration of dissolved oxygen in the solution before and after the yeast are
added.
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Pre-Lab

Put 400 mL of room temperature deionized or distilled water into a beaker. Put the Temperature
Sensor into the water.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on
the interface, and turn on the computer.

2. Connect the Dissolved Oxygen Sensor DIN plug into Analog
Channel A on the interface.

3. Connect the Temperature Sensor DIN plug into Analog Channel
B.

4. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS11 Dissolved O2.DS (See end of activity) (See end of activity)

• The DataStudio file has a Digits display of temperature, a Graph display of dissolved
oxygen concentration versus time, and a Workbook display. Read the instructions in the
Workbook.

NOTE: If you use ScienceWorkshop you need to create the ScienceWorkshop document before
you record data. See the pages at the end of the activity.

• Data recording is set at 10 measurements per second (10 Hz).

PART II: Sensor Calibration and Equipment Setup

Sensor Calibration

• For calibration you will need the following: one-liter bottle, Dissolved Oxygen Sensor and
soaker bottle, graduated cylinder, Temperature Sensor, water, and the table of
‘Concentration (mg/L) of Dissolved O2 at Saturation by Temperature and Barometric
Pressure’ (see the last page of the Instruction Manual for the Dissolved Oxygen Sensor).

1. Use the software to measure the temperature of the water in the beaker.

• Hint: In DataStudio, select ‘Monitor Data’ from the Experiment menu. In
ScienceWorkshop, click the ‘MON’ button ().

Monitor the temperature for about thirty seconds and then record the value of the
temperature. Stop measuring temperature and then remove the Temperature Sensor.

2. Pour the 400 mL of room temperature deionized or distilled water into the bottle. Cap the
bottle and shake it vigorously for about 10 seconds to oxygenate the water.
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3. Put 5 mL of the oxygenated water from the bottle into the Dissolved Oxygen Sensor’s
soaker bottle. Insert the end of the sensor into the bottle and screw on the lid. Adjust the
end of the sensor to about 2-cm above the water in the soaker bottle.

4. Use the software to calibrate the Dissolved Oxygen Sensor.

• In the Experiment Setup window, double-click the Dissolved Oxygen Sensor icon.

• In DataStudio, the Sensor Properties window will open. Click the ‘Calibration’ tab.

• In ScienceWorkshop, the Sensor Setup window will open.
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5. Shake the soaker bottle vigorously for about ten seconds. Shake off any
large water drops from the membrane on the end of the sensor.

• Check the voltage under ‘Current Reading’ in DataStudio or next to
‘Cur Value:’ in ScienceWorkshop.

• When the voltage stabilizes, click the ‘Take Reading’ button under
‘High Point’ in DataStudio or the ‘Read’ button in the row for ‘High
Value:’ in ScienceWorkshop.

• Refer to the table of Concentration (mg/L) of Dissolved O2 at Saturation
by Temperature and Barometric Pressure. Find the value of
concentration that matches the temperature of the water. (If you know
the barometric pressure, use it. Otherwise, use 760 mm Hg as the
pressure). Enter the value in the Sensor Setup window under ‘High Point’ in DataStudio or
in the row labeled ‘High Value’ in ScienceWorkshop.

• Click OK to return to the Experiment Setup window.

Equipment Setup

1. Pour the water from the bottle back into the beaker. Dissolve 5 g of sugar into the water.

2. Prepare to put 5 mL of the activated yeast suspension into the water.

PART III: Data Recording

1. Put the Dissolved Oxygen Sensor into the beaker with the sugar
solution and begin stirring gently.

2. Start recording data. Hint: In DataStudio, click ‘Start’. In
ScienceWorkshop, click ‘REC’).

3. After 30 seconds, add the activated yeast suspension to the beaker.
Continue to stir the solution with the sensor while you are recording
data.

4. Record data for ten minutes or until the dissolved oxygen level reaches
a minimum value and stops changing.

Analyzing the Data

1. Use the Graph display to view your data.

• Hint: In DataStudio, click ‘Scale to Fit’ ( ) in the Graph toolbar. In ScienceWorkshop,

click ‘Autoscale’ ( ) in the lower left corner of the display.

2. Determine the minimum and maximum values of dissolved oxygen.

• Hint: In DataStudio, click the ‘Statistics Menu’ button ( ) in the Graph toolbar. The
minimum and maximum values appear in the Graph legend. Hint: In ScienceWorkshop,

click the ‘Statistics’ button ( ) to open the statistics area. In the statistics area, click the

‘Statistics Menu’ button ( ). Select ‘Minimum’, open the menu again, and select
‘Maximum’.

Record your results in the Lab Report Section
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Lab Report - Activity GS11: The Effect of Respiration on Dissolved O 2

Concentrations

What Do You Think?

The purpose of this activity is to study the effect of respiration on dissolved oxygen
concentrations. What effect do you think yeast will have on the dissolved oxygen concentration
in water?

Data Table

Item Maximum Minimum

Dissolved O2 Concentration mg/L mg/L

Questions

1. What is the evidence that the yeast cells are alive and respiring?

2. What happens to the yeast when the dissolved oxygen concentration reaches a minimum?
Is there any evidence that the yeast cells are still alive?

---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Appendix: Create a ScienceWorkshop  document for GS11 Dissolved O2

Set Up the Sensors

1. In the Experiment Setup window, click-and-drag the analog sensor plug icon to Analog
Channel A. Select ‘Dissolved Oxygen Sensor’ from the list of sensors. Click ‘OK’ to
return to the Experiment Setup window.

2. Click-and-drag the analog sensor plug icon to Analog Channel B and select ‘Temperature
Sensor’ from the list of sensors. Click ‘OK’ to return to the Experiment Setup window.
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Set Up the Displays

3. In the Experiment Setup window, click-and-drag the Graph display icon to the Dissolved
Oxygen Sensor icon.

4. Return to the Experiment Setup window and click-and-drag the Digits display icon to the
Temperature Sensor icon.
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Activity GS12: Organisms and pH (pH Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Biochemistry GS12 Organisms and pH.DS (See end of activity) (See end of activity)

Equipment Needed Qty Chemicals and Consumables Qty
pH Sensor (CI-6507A) 1 Buffer solution, high pH 100 mL
Base and support rod (ME-9355) 1 Buffer solution, low pH 100 mL
Beaker, 50 mL 1 Egg white, diluted 1:5 with water 50 mL
Beaker, 250 mL 3 Gelatin suspension, 2%, warm 50 mL
Buret, 50 mL 1 Hydrochloric acid (HCl), 0.1M 10 mL
Clamp, buret (SE-9446) 2 Liver homogenate 50 mL
Graduated cylinder, 50 mL 1 Potato homogenate 50 mL
Stir rod 1 Sodium hydroxide (NaOH), 0.1M 10 mL
Wash bottle 1 Sodium phosphate buffer solution, pH 7 50 mL
Protective gear PS Water 50 mL

Water, distilled 500 mL

For instructions on preparing the solutions and materials, see the Notes section at the end of this lab.

What Do You Think

Which of the following substances can act as a buffer (maintain its pH within a relatively narrow
range)? The substances are egg white, gelatin, liver, potato and water.

How do organisms maintain a stable internal environment?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

In order to survive, living organisms must maintain a relatively
stable internal environment. Both organisms and cells have learned
to adapt to many environmental factors that would normally affect
their internal environment.

The pH in the organism’s environment is determined by the
concentration of hydrogen ions (H+) and hydroxide ions (OH-). The
pH plays an important role in many biochemical processes and can affect internal and external
environments of living tissue. Living organisms have developed mechanisms to maintain a
normal pH for each cell or organ system (usually between pH 6 and pH 8).

A buffer is a solution of a weak acid in the presence of its salt. A buffer maintains its pH within a
relatively narrow range despite changes in the concentration of hydrogen ions or hydroxide ions.

SAFETY REMINDERS

•  Wear protective gear while handling chemicals.

•  Follow directions for using the equipment.

•  Dispose of all chemicals and solutions properly.
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For You To Do

Use the pH Sensor to measure the change in pH of water, a buffer solution, and a variety of
biological materials when a strong acid or strong base is added to them. Use DataStudio or
ScienceWorkshop to record and analyze the data.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on
the interface, and turn on the computer.

2. Connect the DIN plug of the pH Sensor into Analog Channel A of
the interface.

3. Open the file titled as shown:

DataStudio ScienceWorkshop  (Mac) ScienceWorkshop  (Win)
GS12 Organisms and pH.DS (See end of activity) (See end of activity)

• The DataStudio file has a Workbook display. Read the instructions in the Workbook.

• See the pages at the end of the activity for information about setting up a ScienceWorkshop
file with a Digits display, a Table display, and a Graph display of pH.

• Data recording is set at ten measurements per second (10 Hz).

PART II: Sensor Calibration and Equipment Setup

Calibrate the Sensor

• To calibrate the pH Sensor you will need a wash bottle,
distilled water, three beakers, and buffer solutions of
high pH (e.g. pH 10) and low pH (e.g. pH 4). Put
distilled water into the wash bottle and into one of the
beakers. Put buffer solutions in the other two beakers.

1. Remove the pH electrode from its bottle of buffer solution. Connect the electrode to the pH
Sensor amplifier. To connect the electrode, push the BNC plug onto the receptacle on the
Sensor amplifier and turn the BNC plug clockwise until it ‘clicks’ into place.

Connect to
the sensor.

Remove
the bottle
of buffer
solution.
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2. Use the wash bottle to rinse the end of the electrode. Soak the pH electrode in the beaker of
distilled water for 10 minutes.

3. In the Experiment Setup window, double-click the pH Sensor icon.

• In DataStudio, the Sensor Properties window will open. Click the ‘Calibration’ tab. In
ScienceWorkshop, the Sensor Setup window will open.

4. Calibrate with the high pH buffer solution.

•  Put the end of the pH electrode into the high pH buffer solution.

•  Check the voltage under ‘Current Reading’ in DataStudio or next to ‘Cur Value:’ in
ScienceWorkshop.

•  When the voltage stabilizes, click the ‘Take Reading’ button under ‘High Point’ in
DataStudio or the ‘Read’ button in the row for ‘High Value:’ in ScienceWorkshop.

•  Enter the pH value of the buffer solution.

5. Thoroughly rinse the pH electrode with distilled water and dry it with a tissue.

6. Calibrate with the low pH buffer solution.

•  Put the end of the H electrode in the low pH buffer solution.

•  Check the voltage under ‘Current Reading’ in DataStudio or next to ‘Cur Value:’ in
ScienceWorkshop.

•  When the voltage stabilizes, click the ‘Take Reading’ button under ‘Low Point’ in
DataStudio or the ‘Read’ button in the row for ‘Low Value:’ in ScienceWorkshop.
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•  Enter the pH value of the buffer solution. Click OK to return to the Experiment Setup
window.

7. Thoroughly rinse the pH electrode with distilled water and dry gently.

Set Up the Equipment

1. Set up the pH electrode in a 50-mL beaker. Use a base and support
rod and a clamp to mount the pH electrode so the end of the
electrode is in the beaker.

2. Set up the buret so it is above the 50-mL beaker. Use a clamp to
mount the buret so the tip of the buret is over the mouth of the
beaker.

3. Put a stir rod in the beaker.

PART III: Data Recording

There are six parts to data recording.

Part Description
A Add 1.5 mL of hydrochloric acid to tap water
B Add 1.5 mL of hydrochloric acid to sodium phosphate buffer solution
C Add 1.5 mL of hydrochloric acid to a biological material
D Add 1.5 mL of sodium hydroxide to tap water
E Add 1.5 mL of sodium hydroxide to sodium phosphate buffer solution
F Add 1.5 mL of sodium hydroxide to a biological material

Follow the same basic procedure in each part:
•  Put 25 mL of the substance to be tested into the beaker.
•  Slowly but steadily add 1.5 mL of the acid (Parts A, B, and C) or base (Parts D, E, and F)

drop-by-drop into the substance that is being tested.
•  Stir the substance as you slowly add the acid or base. Use the sensor to record the pH.

Sensor

Buret
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Using the Buret

Turn the valve on the buret to the ‘off’ position. Carefully pour enough
acid into the buret so the level of the liquid is 10 mL above the lowest
mark on the buret. For example, in a 50-mL buret, add fluid so the
bottom of the meniscus is at the 40 mL mark.

When you are ready to begin adding the acid (or the base) to the
substance you are testing, open the valve just enough so that the fluid
drips into the substance one drop at a time.

PART IIIA: Add Hydrochloric Acid to Tap Water

First, fill the buret with acid so the level of the acid is 10 mL above the
lowest mark on the buret.

Make a prediction:

What will happen to the pH of the water as you add the acid? Write
your prediction and a brief explanation in the Lab Report.

1. Put 25 mL of tap water into the beaker.

2. When everything is ready, start recording data. (Hint: In
DataStudio, click ‘Start’. In ScienceWorkshop, click ‘REC’.)

3. After 5 seconds, open the valve on the buret enough so the acid can begin dripping into the
substance. Stir the mixture with the stir rod.

4. Add 1.5 mL of acid (or 30 drops) and then close the buret valve.

5. Stop data recording.

6. Dispose of the tap water/acid mixture as directed. Rinse and
clean the beaker and the stir rod.

7. Place an empty beaker under the pH electrode. Use the wash
bottle with distilled water to thoroughly rinse the pH electrode.
Dispose of the rinse water in the beaker as directed.

PART IIIB: Add Hydrochloric Acid to A Buffer Solution

Make a prediction:

What will happen to the pH of the buffer solution as you add the acid? Write your prediction and
a brief explanation in the Lab Report.

1. Put the beaker back under the pH electrode and buret. Put 25 mL of sodium phosphate
buffer solution into the beaker.

2. When everything is ready, start recording data.

3. After 5 seconds, open the valve on the buret enough so the acid can begin dripping into the
substance. Stir the mixture with the stir rod.

4. Add 1.5 mL of acid (or 30 drops) and then close the buret valve.

5. Stop data recording.

6. Dispose of the buffer solution/acid mixture as directed. Rinse and clean the beaker and the
stir rod.

7. Place an empty beaker under the pH electrode. Use the wash bottle with distilled water to
thoroughly rinse the pH electrode. Dispose of the rinse water in the beaker as directed.
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PART IIIC: Add Hydrochloric Acid to A Biological Material

1. Select one biological material (egg white, liver homogenate, potato homogenate, or warm
gelatin). Note: Your teacher may select the biological material for you or your group to
use.

Record the type of biological material you are testing.

Substance = _________________________________

Make a prediction:

What will happen to the pH of the biological material as you add the acid? Write your prediction
and a brief explanation in the Lab Report.

2. Put the beaker back under the pH electrode and buret. Put 25 mL of your biological
material into the beaker.

3. When everything is ready, start recording data.

4. After 5 seconds, open the valve on the buret enough so the acid can begin dripping into the
substance. Stir the mixture with the stir rod.

5. Add 1.5 mL of acid (or 30 drops) and then close the buret valve.

6. Stop data recording.

7. Dispose of the material/acid mixture as directed. Rinse and clean the beaker and the stir
rod.

8. Place an empty beaker under the pH electrode. Use the wash bottle with distilled water to
thoroughly rinse the pH electrode. Dispose of the rinse water in the beaker as directed.

PART IIID: Add Sodium Hydroxide to Tap Water

First, fill the buret with sodium hydroxide solution so the level of the solution is 10 mL above
the lowest mark on the buret.

Make a prediction:

What will happen to the pH of the water as you add the sodium hydroxide? Write your prediction
and a brief explanation in the Lab Report.

1. Put the beaker back under the pH electrode and buret. Put 25 mL of tap water into the
beaker.

2. When everything is ready, start recording data.

3. After 5 seconds, open the valve on the buret enough so the base (sodium hydroxide) can
begin dripping into the substance. Stir the mixture with the stir rod.

4. Add 1.5 mL of base (or 30 drops) and then close the buret valve.

5. Stop data recording.

6. Dispose of the tap water/base mixture as directed. Rinse and clean the beaker and the stir
rod.

7. Place an empty beaker under the pH electrode. Use the wash bottle with distilled water to
thoroughly rinse the pH electrode. Dispose of the rinse water in the beaker as directed.
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PART IIIE: Add Sodium Hydroxide to A Buffer Solution

Make a prediction:

What will happen to the pH of the buffer solution as you add the base? Write your prediction and
a brief explanation in the Lab Report.

1. Put the beaker back under the pH electrode and buret. Put 25 mL of sodium phosphate
buffer solution into the beaker.

2. When everything is ready, start recording data.

3. After 5 seconds, open the valve on the buret enough so the base can begin dripping into the
substance. Stir the mixture with the stir rod.

4. Add 1.5 mL of base (or 30 drops) and then close the buret valve.

5. Stop data recording.

6. Dispose of the buffer solution/base mixture as directed. Rinse and clean the beaker and the
stir rod.

7. Place an empty beaker under the pH electrode. Use the wash bottle with distilled water to
thoroughly rinse the pH electrode. Dispose of the rinse water in the beaker as directed.

PART IIIF: Add Sodium Hydroxide to A Biological Material

Note: Use the same biological material for Part IIIF that you used in Part IIIC.

Make a prediction:

What will happen to the pH of your biological material as you add the base? Write your
prediction and a brief explanation in the Lab Report.

1. Put the beaker back under the pH electrode and buret. Put 25 mL of your biological
material into the beaker.

2. When everything is ready, start recording data.

3. After 5 seconds, open the valve on the buret enough so the base can begin dripping into the
substance. Stir the mixture with the stir rod.

4. Add 1.5 mL of base (or 30 drops) and then close the buret valve.

5. Stop data recording.

6. Dispose of the material/base mixture as directed. Rinse and clean the beaker and the stir
rod.

7. Place an empty beaker under the pH electrode. Use the wash bottle with distilled water to
thoroughly rinse the pH electrode. Dispose of the rinse water in the beaker as directed.
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Analyzing the Data

1. Set up your Graph display so you can see all your data. (Hint: In DataStudio the Graph

already shows all the runs. In ScienceWorkshop, use the ‘Add a Plot’ menu ( ) to add a
second plot to the Graph. Then use the ‘Data’ menu in each plot to select Runs #1, #2, and
#3 for one plot and Runs #4, #5, and #6 for the other plot.)

2. Set up your Table display so you can see all your data. (Hint: In DataStudio, use the ‘Data’

menu button ( ) to select each run. In ScienceWorkshop, click the ‘Add a Column’

menu button ( ) to add more columns to the Table. Then click the ‘Data’ menu ()
to select Run #1 for the first column, Run #2 for the second column, and so on for all the
data.)

3. Use the built-in analysis tools of the Graph or Table display to find the beginning pH and
the ending pH for each trial.

•  Hint for Graph display: In DataStudio, click the ‘Smart Tool’ button ( ) in the Graph.
The ‘Smart Tool’ displays the coordinates of its position as you move it to any position in
the Graph display. When the ‘Smart Tool’ is on a data point, the ‘y’ coordinate is the pH
value at that point.

In ScienceWorkshop, click the ‘Smart Cursor’ button ( ) and move the cursor into the
display area. The coordinates of the cursor are displayed in the label area of the Y-axis and
the X-axis.

•  Hint for Table display: Look at the beginning value of pH and then scroll to the end of the
column to see the ending value of pH.

4. Record the values of the beginning pH and the ending pH for each of your runs of data.

5. Obtain the pH data for other biological materials from your classmates and record them in
your data table in the Lab Report.

6. Calculate the change in pH (if any) for each substance. Record the change in the data table.

7. Finally, calculate the percent difference between the beginning pH and the ending pH for
each substance (tap water, buffer solution, egg white, gelatin, liver and potato). Record the
percent difference in the data table.

Record your results in the Lab Report section.
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Appendix: Set Up ScienceWorkshop

Create a ScienceWorkshop file to measure pH.

Set Up the Sensor

In the Experiment Setup window, click and drag the analog sensor plug to Channel A.

Select ‘pH Sensor’ from the list of sensors. Click ‘OK’ to return to the Experiment Setup
window.

Set Up the Displays

In the Display menu, select ‘New Digits’ from the list of displays. Return to the Display menu
and select ‘New Table’. Finally, return to the menu and select ‘New Graph’.

Arrange the windows so you can see the Digits display of pH.
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---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Lab Report - Activity GS12: Organisms and pH

What Do You Think?

Which of the following substances can act as a buffer (maintain its pH within a relatively narrow
range)? The substances are egg white, gelatin, liver, potato and water.

How do organisms maintain a stable internal environment?

Predictions:

Part IIIA: What will happen to the pH of the water as you add the acid?

Part IIIB: What will happen to the pH of the buffer solution as you add the acid?

Part IIIC: What will happen to the pH of the biological material as you add the acid?

Part IIID: What will happen to the pH of the water as you add the base (sodium hydroxide)?

Part IIIE: What will happen to the pH of the buffer solution as you add the base?

Part IIIF: What will happen to the pH of the biological material as you add the base?
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Data Table

0.1 M hydrochloric acid (HCl) 0.1 M sodium hydroxide (NaOH)

Substance Begin pH End pH ∆pH % diff. Begin pH End pH ∆pH % diff.

Tap Water

Buffer

Egg White

Gelatin

Liver

Potato

Questions

1. What was the total pH change when HCl is added to your biological material? Compare
this change to the pH change for the tap water and acid.

2. What was the total pH change when NaOH is added to your biological material? Compare
this change to the pH change for the tap water and base.

3. Describe how each biological material responded to changes in pH.

4. How does the buffer solution respond to HCl and NaOH? Is it more like the tap water or a
biological material?

5. Suggest a mechanism for pH regulation in organisms.
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Activity GS13: Acid Rain (pH Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Environment GS13 Acid Rain.DS G13 Acid Rain G13_RAIN.SWS

Equipment Needed Qty Chemicals and Consumables Qty
pH Sensor (CI-6507A) 1 Buffer solution: high pH 100 mL
Base and support rod (ME-9355) 1 Buffer solution: low pH 100 mL
Beaker, 250 mL 3 Sodium hydrogen carbonate, NaHCO3, solid 5 g

Beaker, 100 mL 4 Sodium hydrogen sulfite, NaHSO3, solid 5g

Berol-type pipette, 15 cm stem 3 Sodium nitrite, NaNO2 , solid 5g

Berol-type pipette, 2 cm stem 3 Water 12 mL
Berol-type pipette with 1.0 M HCl 1 Water, distilled 1 L
Clamp, buret (SE-9446) 1
Test tube, 20 by 150 mm 1
Wash bottle 1
Protective gear PS

What Do You Think?

The purpose of this activity is to “create” acid rain. What is acid rain and what causes it? How
much will the pH of water be changed by different gases such as carbon dioxide and nitrogen
dioxide?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Water vapor in the air can combine with other gases found in the air. You
may be surprised to learn that rain water is slightly acidic. One reason is that
water vapor can combine with carbon dioxide gas to form carbonic acid. The
natural pH value of rainwater is usually between 6.0 and 6.9. Rainfall
accumulates in rivers and streams causing a slight acidification.

Other gases found in the air can also combine with water vapor to form “acid
rain”. For example, gases in automobile exhaust and other gases given off by
combustion of fossil fuels can combine with water vapor to form sulfurous
acid, nitrous acid, and nitric acid.

You will produce four of the constituents of acid rain and monitor their effect on the pH of water
samples.
•  carbonic acid, H 2CO3

•  nitrous acid, HNO 2
•  nitric acid, HNO 3
•  sulfurous acid, H 2SO3

Carbonic acid is formed when carbon dioxide gas dissolves in rain
droplets of unpolluted air:

CO2(g) + H2O(l)  =====> H2CO3(aq)
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Nitrous acid and nitric acid result from a common air pollutant, nitrogen dioxide (NO2). Most
nitrogen dioxide in our atmosphere is produced from automobile exhaust. Nitrogen dioxide gas
dissolves in rain drops and forms nitrous and nitric acid: 

2 NO2(g) + H2O(l)  =====> HNO2(aq) + HNO3(aq)

Sulfurous acid is produced from another air pollutant, sulfur dioxide (SO2). Most sulfur dioxide
gas in the atmosphere results from burning coal containing sulfur impurities. Sulfur dioxide
dissolves in rain drops and forms sulfurous acid:

SO2(g) + H2O(l)  =====> H2SO3(aq)

If large amounts of these gases are in the air, the pH of rainwater can drop drastically. Rainfall of
low pH values directly affects the aquatic life in the rivers and streams where this water
accumulates. Acid rain can also cause damage to plant life.

SAFETY REMINDERS

•  Wear protective gear while handling chemicals.

•  Follow directions for using the equipment.

•  Dispose of all chemicals and solutions properly.

CAUTION : Hydrochloric acid is an irritant and can ruin clothing. Avoid contact to eyes or skin. Do Not
Drink. Immediately flush spills with water for 15 minutes. Notify your instructor of any contact on your skin
with these chemicals.

For You To Do

First, calibrate the pH Sensor. Then build three ‘gas generators’ using Berol-type pipettes
partially filled with three different compounds: sodium hydrogen carbonate, sodium hydrogen
sulfite, and sodium nitrite. Each compound produces a different gas when hydrochloric acid is
added (carbon dioxide from the sodium hydrogen carbonate, sulfur dioxide from the sodium
hydrogen sulfite, and nitrogen dioxide from the sodium nitrite).

In the second part of the activity, add a small amount of hydrochloric acid to each gas generator
to activate each generator.

Finally, collect the gas produced by each generator and bubble the gas through tap water. Use the
pH Sensor to measure the change in pH of the water as the gas mixes with it.

Use DataStudio or ScienceWorkshop to record and display the pH. Compare the change in pH
created by carbon dioxide gas to the change in pH created by sulfur dioxide gas and nitrogen
dioxide gas.
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PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on
the interface, and turn on the computer.

2. Connect the pH sensor DIN plug into Analog Channel A on the
interface.

3. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS13 Acid Rain.DS G13 Acid Rain G13_RAIN.SWS

• The DataStudio file has a Workbook display, a Graph display, and a Table display. Read
the instructions in the Workbook.

• The ScienceWorkshop document has a Graph of pH versus Time and a Table display of
pH.

• Data recording is set at ten measurements per second (10 Hz) and a ‘Stop Condition’ at
100 seconds.

PART II: Sensor Calibration and Equipment Setup

Calibrate the Sensor

• To calibrate the pH Sensor you will need a wash bottle, distilled water, three beakers, and
buffer solutions of high pH (e.g. pH 10) and low pH (e.g. pH 4). Put distilled water into the
wash bottle and into one of the beakers. Put buffer solutions in the other two beakers.

1. Remove the pH electrode from its bottle of buffer solution. Connect the electrode to the pH
Sensor amplifier. To connect the electrode, push the BNC plug onto the receptacle on the
Sensor amplifier and turn the BNC plug clockwise until it ‘clicks’ into place.

2. Use the wash bottle to rinse the end of the electrode. Soak the pH electrode in the beaker of
distilled water for 10 minutes.

• NOTE: While the electrode is soaking you can set up the equipment.
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3. In the Experiment Setup window, double-click the pH Sensor icon.

• In DataStudio, the Sensor Properties window will open. Click the ‘Calibration’ tab. In
ScienceWorkshop, the Sensor Setup window will open.

4. Calibrate with the high pH buffer solution.

•  Put the end of the pH electrode into the high pH buffer solution.

•  Check the voltage under ‘Current Reading’ in DataStudio or next to ‘Cur Value:’ in
ScienceWorkshop.

•  When the voltage stabilizes, click the ‘Take Reading’ button under ‘High Point’ in
DataStudio or the ‘Read’ button in the row for ‘High Value:’ in ScienceWorkshop.

•  Enter the pH value of the buffer solution.

5. Thoroughly rinse the pH electrode with distilled water and dry it with a tissue.

6. Calibrate with the low pH buffer solution.

•  Put the end of the H electrode in the low pH buffer solution.

•  Check the voltage under ‘Current Reading’ in DataStudio or next to ‘Cur Value:’ in
ScienceWorkshop.

•  When the voltage stabilizes, click the ‘Take Reading’ button under ‘Low Point’ in
DataStudio or the ‘Read’ button in the row for ‘Low Value:’ in ScienceWorkshop.

•  Enter the pH value of the buffer solution. Click ‘OK’ to return to the Experiment Setup
window.

7. Thoroughly rinse the pH electrode with distilled water and dry gently.
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Equipment Setup

[   ] Prepare the gas generators.

1. Label three short-stem Berol pipettes with the formula of the solid they will contain:
“NaHCO3” (for sodium hydrogen carbonate), “NaNO2” (for sodium nitrite) and “NaHSO3”
(for sodium hydrogen sulfite).

2. Label three long-stem Berol pipettes with the formula of the gas they will contain: “CO2” (for
carbon dioxide), “NO2” (for nitrogen dioxide) and “SO2” (for sodium dioxide). Use the 100-
mL beaker to support the pipettes.

3. Your teacher will supply a beaker containing powdered NaHCO3 (sodium hydrogen
carbonate). Squeeze the bulb of the short-stem pipette labeled “NaHCO3” to push the air
out of the bulb. Place the open end of the pipette into the powdered NaHCO3. Release the
bulb to draw some of the powdered NaHCO3 into the pipette. Draw the powder into the
pipette until there is just enough powder to fill the curved end of the bulb of the pipette
when you hold the pipette with the bulb end down (see the diagram).

4. Repeat the previous step to fill the “NaNO2” and “NaHSO3” short-stem Berol pipettes
with the corresponding powdered compounds.

5. Get a Berol pipette with 1.0 Molar hydrochloric acid (HCl) from your teacher.

•  Caution: HCl is a strong acid. Hold the pipette gently, with the stem pointing up, so that HCl
doesn’t drip out.

Insert the narrow stem of the HCl pipette into the larger opening of the pipette with the
NaHCO3 (see the diagram.) Gently squeeze the HCl pipette to add about 20 drops of HCl
solution to the powdered NaHCO3.

Pipette
with HCl

Gas
generator
pipette

Squeeze the
bulb gently.

Add about
20 drops.

Release the bulbPush out the air

Fill to this
level
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When finished, remove the HCl pipette. Gently swirl the pipette that contains NaHCO3 and
HCl.

Carbon dioxide gas, CO2, is generated in this pipette. Place the pipette bulb down in the
100-mL beaker to prevent spillage.

6. Repeat this same procedure to add HCl to the pipette with the powdered NaHSO3 (sodium
hydrogen sulfite). Sulfur dioxide, SO2, is generated in this pipette. Place this pipette bulb
down in the 100-mL beaker to prevent spillage

7. Repeat this procedure a third time to add HCl to the powdered NaNO2 (sodium nitrite)
pipette. Nitrogen dioxide, NO2, is generated in this pipette. Return the HCl pipette to your
teacher. Leave the three gas-generating pipettes in a 100-mL beaker until needed.

[   ] Set up the pH Sensor

8. Attach a 20 by 150 mm test tube to the base and support rod using a clamp.
Add about 4 mL of tap water to the test tube. Rinse the pH electrode with
distilled water and place the electrode into the tap water in the test tube.

[   ] Collect the gas

9. Squeeze all of the air from the bulb of the long-stem pipette labeled “CO2”.
Keep the bulb completely collapsed and insert the long stem of the pipette
down into the gas-generating “NaHCO3” pipette. The tip of the long-stem
pipette should not touch the liquid in the “NaHCO3” pipette (see the
diagram). Release the pressure on the bulb so that it draws gas up into it.
Store the long-stem pipette and the “NaHCO3” pipette in the 100-mL
beaker.

10. Repeat the ‘gas collection procedure’ using the “NaNO2” and “NO2” pipettes.

11. Repeat the ‘gas collection procedure’ using the “NaHSO3” and “SO2” pipettes.
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Push out
ALL the air.

Release the
bulb to draw
in the gas.
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generator
pipette



Name _____________________ Class ______________ Date _________

GS13 ©1999 PASCO scientific p. 109

PART III: Data Recording

1. Insert the long-stem pipette labeled “CO2” into the test tube, alongside the pH sensor, so
that its tip extends into the water near the bottom of the test tube (see the diagram.)

2. Start recording data. After 15 seconds, gently squeeze the bulb of the pipette so that
bubbles of CO2 slowly bubble up through the solution. Use both hands to squeeze all of the
gas from the bulb. Data recording automatically stops at 100 seconds.

3. Remove the pH electrode from the test tube and rinse the electrode thoroughly with
distilled water and return it to the sensor storage solution.

4. Discard the contents of the test tube as directed by your teacher. Rinse the test tube
thoroughly with tap water.

5. Add 4 mL of tap water to the test tube.

6. Repeat the data recording process using NO2 gas.

7. Repeat the data recording process using SO2 gas.

8. When you are finished, rinse the pH electrode with distilled water and return it to the
sensor storage bottle. Dispose of the six pipettes as directed
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Analyzing the Data

1. Examine each run of data in your Table display to determine the minimum pH value and
maximum pH value for the water for each gas. Record the values.

• Hint: In DataStudio, click the ‘Statistics Menu’ button ( ). In ScienceWorkshop,

click the ‘Statistics’ button ( ).

2. For each of the three gases, calculate the change in pH and record it.

3. Record your conclusion and answer the questions in the Lab Report.

Record your results in the Lab Report Section

---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Lab Report - Activity GS13: Acid Rain

What Do You Think?

The purpose of this activity is to “create” acid rain. What is acid rain and what causes it? How
much will the pH of water be changed by different gases such as carbon dioxide and nitrogen
dioxide?

Data Table

Gas Initial pH Final pH Change in pH ( ∆pH)

CO2

NO2

SO2

Questions

1. In this activity, which gas caused the smallest change in pH?

2. Which gas (or gases) caused the largest change in pH?

3. Coal from western states, like Montana and Wyoming, has a lower percentage of sulfur
impurities than coal found in the eastern United States. How would burning low-sulfur coal
decrease rainfall acidity? Use specific information about gases and acids to answer this
question.

4. High temperatures in the automobile engines cause nitrogen and oxygen gases from the air
to react and form nitrogen oxides. What two acids in acid rain result from the nitrogen
oxides found in automobile exhaust?

5. Which gas and resulting acid in this experiment would cause rainfall in unpolluted air to
have a pH value less than 7 (sometimes as low as 5.6)?
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6. Why would acidity levels usually be lower (pH higher) in actual rainfall than the acidity
levels you recorded in this experiment? Rainfall in the United States generally has a pH
between 4.5 and 6.0.
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Activity GS14: Acceleration Due to Gravity
(Motion Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Linear motion GS14 Gravity.ds G14 Gravity G14_GRAV.SWS

Equipment Needed Qt y Other Qty
Motion Sensor (CI-6742) 1 Ball, rubber 1
Base and Support Rod (ME-9355) 1 Level (optional) 1
Meter stick 1

What Do You Think?

How can a Motion Sensor be used to measure the acceleration due to gravity of a falling object?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Over twenty-two centuries ago, a Greek philosopher and scientist named
Aristotle proposed that there is a natural force that causes heavy objects to fall
toward the center of Earth. He called this force “gravity”. In the seventeenth
century, the English scientist Isaac Newton was able to show that gravity is a
universal force that extends beyond Earth. It is the force that causes the moon
to orbit the Earth and the Earth to orbit the Sun.

When an object is in “free fall”, it means that the only force acting on it is the
force of gravity. As an object falls freely, it accelerates. For a falling object
near the surface of Earth, the rate of change of velocity is a constant value. This
value is the acceleration due to gravity. If you ignore air resistance, a falling
ball accelerates as if it is in free fall. You can measure the motion of the falling
ball to find the value of the acceleration due to gravity.

SAFETY REMINDER .

• Follow directions for using the equipment.

For You To Do

Use the Motion Sensor to measure the motion of a ball as it falls and bounces. Use DataStudio or
ScienceWorkshop to record and display the position and velocity of the ball. Examine the slope
of the line on a velocity versus time graph to find the acceleration of the ball.
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About the Motion Sensor

The Motion Sensor sends out pulses of
ultrasound and picks up the echoes of
ultrasound that bounce back from objects in
front of it.

The software program keeps track of the
time when the pulses go out and the time
when the echoes come back. One-half of the
round trip time is the time that it took for the
ultrasound to reach the object. Since
ultrasound travels at the speed of sound, or
about 344 meters per second (or about 700 miles per hour), the program figures out how far
away the object is as follows:

distance to object = round − trip time
2

× speed of sound

The speed of sound through air depends on several factors, including the temperature of the air.
Because the temperature of air can change, the speed of sound can change. You can calibrate the
Motion Sensor so it uses an accurate measurement of the speed of sound.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the
computer, turn on the interface, and turn on the
computer.

2. Plug the modular connector on one end of the
interface cable into the side of the Motion
Sensor. Connect the stereo phone plugs of the
Motion Sensor to Digital Channels 1 and 2 on the
interface. Connect the yellow plug to Digital
Channel 1 and the other plug to Digital Channel 2.

3. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS14 Gravity.ds G14 Gravity G14_GRAV.SWS

• The DataStudio document has a Workbook display. Read the instructions in the Workbook.

• The ScienceWorkshop document has a Graph display of Position and Velocity versus
Time.

• The Trigger Rate for the Motion Sensor is 60 times per second (60 Hz).

OBJECT

MOTION SENSOR

PULSE

ECHO
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PART II: Sensor Calibration and Equipment Setup

Sensor Calibration

• Calibrate the Motion Sensor so it can use an accurate
measurement of the speed of sound in air. You will need a
meter stick and a flat surface that can be used as a target to
reflect the pulses from the Motion Sensor.

Set Up the Sensor

1. Place the Motion Sensor so it is exactly one meter away
from a flat surface that can reflect the pulses from the
Motion Sensor. Set the range select switch on top of the
sensor to ‘Far’.

• For example, put the Motion Sensor on a support rod near
the edge of a table. Aim the Motion Sensor so it sends
pulses down to the floor. If the floor has a rug or carpet on
it, put a flat, smooth piece of wood or some other flat
surface on the floor directly below the Motion Sensor.

(• NOTE: Remove the meter stick after you use it to measure
the distance from the Motion Sensor to the reflector.)

Calibrate the Software

2. In the Experiment Setup window, double-click the sensor’s icon.

• Result: In DataStudio, the Sensor Properties window opens.

Click the ‘Motion Sensor’ tab. Result: The calibration window opens and the sensor
begins to click a few times per second.

• Result: In ScienceWorkshop, the sensor’s calibration window opens and the sensor begins
to click a few times per second.
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3. Calibrate the software.

• First , make sure that the sensor is one meter from the target.

• Second, click the ‘Calibrate’ button in the Motion Sensor window. Result: The software
calculates the speed of sound based on the calibration distance (one meter) and the round
trip time of the pulse and echo

4. Click ‘OK’ to return to the Experiment Setup window.

Equipment Setup

• Make sure that the floor is level. If it is not, put a
hard flat surface on the floor and put pieces of
paper or shims under the edges of the hard flat
surface to level it.

1. Put a base and support rod near the edge of a table.
Mount the Motion Sensor on the support rod so the
Motion Sensor is aimed downward at the floor.

2. Adjust the position of the Motion Sensor on the
support rod so that there is about 1.5 meters
between the Motion Sensor and the floor.

PART III: Data Recording

1. Prepare to drop the ball so it falls straight down
beneath the Motion Sensor. Hold the ball between
your finger and thumb under the Motion Sensor no
closer than 15 cm (about 6 inches) below the
Motion Sensor.

2. Start recording data. (Hint: In DataStudio, click
‘Start’. In ScienceWorkshop, click ‘REC’.) Drop
the ball. Let the ball bounce several times.

• NOTE: Be sure to move your hand out of the way as soon as you release the ball.

3. After the ball bounces several times on the floor, stop recording data.
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Analyzing the Data

• The position plot of the Graph shows a “mirror image” of a ball bouncing on a flat surface.
The velocity plot shows a “sawtooth” pattern. Notice in the velocity plot that the velocity
of the ball is positive part of the time and negative part of the time. The Motion Sensor
records motion away from it as positive and motion towards it as negative.

1. In the plot of Velocity versus Time, use the cursor to click-and-draw a rectangle around a
region that is relatively straight.

2. Use the Graph display’s built-in analysis tools to determine the slope of the region you
selected.

• Hint: In DataStudio, select ‘Linear’ from the ‘Fit’ menu ( ).

• Hint: In ScienceWorkshop, click the ‘Statistics’ button ( ) to open the statistics area.

Select ‘Curve Fit, Linear Fit’ from the ‘Statistics Menu’ ( ).

CLICK-AND-DRAG A 
RECTANGLE AROUND A 
REGION THAT IS 
STRAIGHT.
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3. Record the value of the slope in the Data Table. This is the value for the acceleration due to
gravity on the falling object.

• Hint: In DataStudio, the slope appears in the ‘Fit’ window.

• Hint: In ScienceWorkshop, the Statistics area shows the general formula for a line (y = a1
+ a2 x), the constant a1, and the linear coefficient a2. The linear coefficient is the slope of
the line.

---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.

Record your results in the Lab Report section.

STATISTICS AREA:
a1 IS THE CONSTANT
a2 IS THE “LINEAR 
COEFFICIENT”
chi^2 IS A MEASURE OF THE 
CLOSENESS OF FIT
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Lab Report - Activity GS14: Acceleration Due to Gravity

What Do You Think?

How can a Motion Sensor be used to measure the acceleration due to gravity of a falling object?

Data Table

‘g’ (slope of velocity versus time) = _________

Questions

1. How does your value for ‘g’ (slope of velocity versus time) compare to the accepted value
of the acceleration of a free falling object (9.8 m/s2)?

• Reminder: percent difference = 
accepted value - experimental value

accepted value
x100%

2. What factors do you think may cause the experimental value to be different from the
accepted value?
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Activity GS15: Oxygen Content of Air
(Pressure Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Gas laws C12 Partial Pressure.DS C12 Dalton’s Law C12_DALT.SWS

Equipment Needed Qty Chemicals and Consumables Qty
Pressure Sensor (CI-6532A) 1 Calcium hydroxide solution 15 mL
Bottle (or flask), 250 mL 1 Candle 1
Connector, rubber stopper (w/sensor) 1 Clay, modeling 10 g
Graduated cylinder 1 Matches 1 bk
Rubber stopper, one-hole 1 Tape 1 roll
Tubing, plastic (w/sensor) 1
Protective gear PS

(*SAFETY CAUTION! Be very careful around any flame!)

What Do You Think?

The purpose of this activity is to use Dalton’s Law of Partial Pressure for a gas to determine the
approximate    percentage of oxygen and nitrogen in the air. What do you think is the approximate
percentage of oxygen in the air?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

The Earth’s atmosphere is a complex multi-layered blanket of air that surrounds our planet. Most
of the air is concentrated in the lowest levels of the atmosphere. For example, over ninety percent
of the mass of the atmosphere is in the bottom twenty kilometers (about twelve miles) of the
atmosphere.

The air is made up of different gasses
such as oxygen, nitrogen, and water
vapor. There are several other gases in
the atmosphere but they make up a very
minor amount of the air.

Dalton's Law of Partial Pressure states
that the    total    pressure of a gas is equal to
the sum of each of the individual gases'
pressures at a specific temperature.

The sum of all the partial pressures of
the gases that make up the atmosphere
gives the total pressure of the
atmosphere. The average pressure of the
atmosphere is 101,000 pascals where 1
pascal is 1 newton per square meter.
This translates to about 14.7 pounds per
square inch. Most of the total pressure is due to the nitrogen in the air. The second most common
gas in the atmosphere is oxygen. The other gases such as water vapor, carbon dioxide, argon,
helium and xenon add very little to the overall pressure of the atmosphere.

Remove the oxygen in the atmospheric mixture in order to determine the amount of nitrogen in
the atmosphere.

OZONE LAYER
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Caution! Be careful with matches and be careful with the burning candle.

SAFETY REMINDERS

•  Wear protective gear.

•  Follow directions for using the equipment.

•  Handle and dispose of all chemicals and solutions properly.

For You To Do

A burning candle consumes oxygen. If the candle burns in a closed container and you use a
chemical to remove the carbon dioxide produced, the pressure in the container should decrease
due to the removal of oxygen. The remainder of the partial pressure will be assumed to be due to
nitrogen.

Use the Pressure Sensor to measure the change in pressure as a candle burns inside a container.
Use calcium hydroxide to absorb carbon dioxide gas released during combustion. Use
DataStudio or ScienceWorkshop to record and display the data.
Use your data to determine the approximate percentage of
oxygen in air.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer,
turn on the interface, and turn on the computer.

2. Connect the DIN plug of the Pressure Sensor to Analog
Channel A on the interface.

3. Open the file titled as shown;
DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
C12 Partial Pressure.DS C12 Dalton’s Law C12_DALT.SWS

• The DataStudio file has a Graph display. Read the Workbook display for more information.

• The ScienceWorkshop document has a Graph display with a plot of the pressure versus
time.

• Data recording is set at two measurements per second (2 Hz).

PART II: Sensor Calibration and Equipment Setup

You do not need to calibrate the sensor.

Set Up the Equipment

• For this part you will need the following: glycerin, quick-release
coupling, connector, plastic tubing, one-hole rubber stopper,
Pressure Sensor, clay, straw, tape, candle.

1. Put a drop of glycerin on the barb end of a quick release coupling.
Put the end of the quick release coupling into one end of a piece of

plastic tubing (about 15 cm) that comes with the Pressure Sensor.
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2. Put a drop of glycerin on the barb end of the connector. Push the barb end of the connector
into the other end of the plastic tubing.

3. Fit the end of the connector into the hole in the rubber stopper.

4. Align the quick-release coupling on the end of the plastic tubing with the pressure port of
the Pressure Sensor. Push the coupling onto the port, and then turn the coupling clockwise
until it clicks (about one-eighth turn).

5. Use a piece of clay to attach the candle to bottom of the rubber stopper. (Note: Do not let
the clay cover the hole.) Make sure that when the rubber stopper is put into the bottle (or
flask), the tip of the candle is at least halfway into the bottle. (Note: Use a straw and tape to
extend the distance of the candle into the bottle if needed.)

Set Up the Bottle

6. Put 15 mL of saturated calcium hydroxide solution into the bottle.

• When you are ready to record data you will hold the bottle sideways. Then you will light
the candle and put the candle/rubber stopper into the bottle.
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PART III: Data Recording

1. When you are ready, light the candle. Start recording data. (Hint: Click ‘Start’ in
DataStudio or click ‘REC’ in ScienceWorkshop.)

2. Tilt the bottle sideways. Insert the burning candle and then CAREFULLY but quickly force
the rubber stopper into the top of the bottle. Be sure there is a tight seal between the rubber
stopper and the bottle. Hold the bottle sideways as the candle flame burns.

3. When the candle flame is completely extinguished, stop recording data.

4. Remove the candle/rubber stopper from the bottle. Fill the bottle with water to rinse out the
products of combustion.

5. Dispose of the water as instructed.

Analyzing the Data

1. Use the Graph display to find the initial pressure inside the bottle and the final pressure
after the candle flame went out.

• (Hint: Use the ‘Smart Tool’ ( ) in DataStudio or the ‘Smart Cursor’ ( ) in
ScienceWorkshop.)

2. Record the initial and final pressures in the Lab Report section.

Record your results in the Lab Report section.

Smart Cursor

“Y” coordinate of
cursor position “X” coordinate of

cursor position
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Lab Report - Activity GS15: Oxygen Content of Air

What Do You Think?

The purpose of this activity is to use Dalton’s Law of Partial Pressure for a gas to determine the
approximate    percentage of oxygen and nitrogen in the air. What do you think is the approximate
percentage of oxygen in the air?

Data Table

Data Measurement Value

1 Starting pressure (O2 + N2) kPa

2 Ending pressure (N2 alone) kPa

3 Change in pressure (O2 alone) kPa

4 Percentage of O2 in air
(Data 3 ÷ Data 1)

5 Percentage of N2 in air
(Data 2 ÷ Data 1)

Questions

1. How does your calculated value for the percentage of oxygen in air compare to the
accepted value?

2. How does your calculated value for the percentage of nitrogen in air compare to the
accepted value?

3. What are possible sources for error in this experiment?
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Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this activity.
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Activity GS16: Insolation – Solar Radiation
(Temperature Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Energy GS16 Insolation.DS G16 Insolation G16_SUN.SWS

Equipment Needed Qty Chemicals and Consumables Qty
Temperature Sensor (CI-6505A) 1 Cardboard, 15 by 15 cm 1
Clock 1 Ice, cube 2 – 3
Cup 1 Paper towel 1
Lamp (optional), 100 or 150 W 1 Straw 1
Protractor (for measuring angles) 1 Tape 1 roll

Water 100 mL

This activity can be done outdoors on a sunny day. The best time is at noon.

What Do You Think?

Skin doctors warn us that over exposure to the radiation from the sun is harmful to our skin and
can possibly lead to skin cancer. What time of the day are the sun’s rays most absorbed by our
skin? What do you think? Is there a relation to the amount of radiation absorbed and the angle at
which the sun’s rays strike the skin?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

The Sun accounts for 99.9% of the energy that Earth gets at its surface. (Heat moving upward
from Earth’s core makes up the small remainder). Insolation is solar radiation, or energy
received from the Sun. Insolation is made up of ultraviolet  and visible light and infrared  solar
radiation.

The amount of
energy that the entire
Earth receives from
the Sun remains
fairly constant from
year to year, but the
amount of energy
that a particular spot
on Earth receives
may change a great
deal from day to day.
One thing that makes
a difference is the
angle of the sunlight
that hits the Earth’s surface.

If the angle at which the sunlight hits the Earth’s surface is almost vertical (90˚), the amount of
energy that is soaked up by a square meter of area at that part of the Earth’s surface is a
maximum. If the sunlight hits the Earth’s surface at a smaller angle than ninety degrees, the
amount of energy that is soaked up by a square meter of area is less.

At higher latitudes on the Earth’s surface, the angle can be very small, so the amount of energy
that is soaked up can also be very small.

ENERGY FROM THE SUN
100%

EARTH’S ALBEDO -
30% REFLECTED AND 
SCATTERED

20% 4% 4% BY EARTH’S SURFACE

20% BY CLOUDS

6% BY  THE ATMOSPHERE

TOP OF ATMOSPHERE

19% ABSORBED 
BY ATMOSPHERE 
AND CLOUDS

51% ABSORBED AT SURFACE

6%
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If three surfaces of equal area start
with the same temperature and are
exposed to sunlight for the same
amount of time, but the three surfaces
are at     different    angles to the sunlight,
the    change    in temperature for each
surface should also be different.

(The amount of solar radiation, or
insolation, received by the Earth is
enormous. The amount of energy
received each second over each
square meter of area that is at right
angles (90˚) to the Sun’s rays at the
top of the atmosphere is 1400 joules.
In power units, this is 1400 watts per
square meter, or 1.4 kilowatts per square meter.)

SAFETY REMINDERS

•  Protect your eyes and skin from direct sunlight.

•  Follow directions for using the equipment.

•  If you do this activity using a lamp, be careful not to tough it when it gets hot.

For You To Do

In this activity, measure the amount of energy from the sun’s rays as it strikes a piece of paper at
different angles. Use a temperature sensor to measure the temperature of the paper and compare
data of angle of incidence and temperature. Use DataStudio or ScienceWorkshop to record and
display your data.

NOTE: One option for this activity is to use the
ScienceWorkshop 500 Interface out-of-doors.
The ScienceWorkshop 500 Interface can be
programmed to record data, and then
disconnected from the computer. You can carry it
outdoors, record the data, and then re-connect it
to the computer to analyze the data.

This procedure will describe how to use the
Science Workshop 500 Interface and the
Temperature Sensor to measure the insolation
(solar radiation) outdoors. The last section of this
activity will describe how to record data using a
lamp as a simulation of the Sun.

In this activity the Temperature Sensor measures
the temperature at the surface of a piece of
cardboard that is exposed to solar radiation
(sunlight) at three different angles. 

You will use the protractor and straw to measure
the angle that the sunlight makes with the piece
of cardboard.

1. PROGRAM THE 
INTERFACE WHILE 
CONNECTED TO THE 
COMPUTER

2. DISCONNECT THE 
INTERFACE AND GO 
COLLECT DATA

3 . RE-CONNECT THE 
INTERFACE AND ANALYZE 
THE DATA

ANGLE OF SUNLIGHT IS 30˚

ANGLE OF SUNLIGHT IS 60˚

ANGLE OF SUNLIGHT IS 90˚
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The Science Workshop 500 Interface records the temperature data. The program downloads the
data from the interface and then displays the data for analysis.

PART I: Computer Setup

1. Connect the ScienceWorkshop
interface to the computer, turn on the
interface, and turn on the computer.

2. Connect the DIN plug of the
Temperature Sensor into Analog
Channel A on the interface.

3. Open the file titled as shown;

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS16 Insolation.DS G16 Insolation G16_SUN.SWS

•  The DataStudio document has a Workbook display. Read the instructions in the
Workbook.

•  The ScienceWorkshop document has a Graph display of Temperature versus Time.

•  Data recording is set at 1 sec (or one measurement per second).

PART II: Sensor Calibration and Equipment Setup

•  You do not need to calibrate the Temperature Sensor.

1. Use a piece of cardboard that is approximately square and
about 15 x 15 cm (or 6 x 6 inches). Tape the protractor at
the center of one edge of the piece of cardboard so the
protractor is at right angles to the piece of cardboard.

2. Put some ice and water into the cup.

•  You will use the ice water to cool the tip of the
Temperature Sensor before each trial of data recording.

PART III: Data Recording

NOTE: Data recording for this activity has several steps:

•  The first step in data recording is to get the interface ready to make measurements and
disconnect it from the computer.

•  The second step in data recording is to line up the Temperature Sensor and cardboard with
the sunlight.

•  The third step in data recording is to make measurements of the change in temperature for
three different angles of sunlight. You will do this by lining up the cardboard at 90˚, 60˚,
and 30˚ to the sunlight.

•  The final step in data recording is to reconnect the interface to the computer.

PASCOscientific

300Interface

ANALOG CHANNELS

Science
Workshop™

Interface

500

scientific

PASCO

Science W
orkshop™

DATA LO G G ING
INSTRUCTIO NS
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Prepare the Interface

•  Make sure that there are four AA alkaline batteries in the interface battery compartment.

•  Make sure that the POWER switch on the back panel of the interface is ON.

1. Click the Experiment  menu in the
menu bar. Select Disconnect for
Logging…  from the Experiment
menu.

• The Data Logging Setup window
will open. If your computer is
connected to a printer, click Print
Checklist .

2. Click Begin Logging .

•  The interface goes into “sleep” mode. The green light-emitting
diode (LED) on the front panel of the interface will go out, and
then will blink once every five seconds.

3. Disconnect the interface from the computer. Unplug the power
cord and the interface cable from the back of the interface box.

4. Take the interface with Temperature Sensor, a straw, the cup of
ice water, tape, paper towels, the clock, and the
protractor/cardboard setup outside. Find an open area next to a
sunny, south-facing wall.

ON

DATA LOGGING 
BUTTON

LIGHT-EMITTING 
DIODE (LED)

LED BLINK RATES:
SLEEP MODE = ONE BLINK EVERY FIVE SECONDS
WAKE UP MODE = ONE BLINK EVERY SECOND FOR ABOUT TEN SECONDS
DATA LOGGING MODE = SEVERAL BLINKS EVERY SECOND

INTERFACE

PLUG FROM 
POWER 
SUPPLY

INTERFACE 
CABLE

POWER SWITCH = ON
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√ Line Up the Temperature Sensor

1. Place the protractor/cardboard setup at the base of the wall so that the cardboard is at about
right angles to the sunlight.

2. Hold the straw against the side of the
protractor. Put the end of the straw
next to the center line of the protractor.

•  Keep a small gap between the end of
the straw and the cardboard. Line up
the straw with the 90 degree mark
along the curved edge of the
protractor. Use a piece of tape to help
hold the straw in place.

3. Adjust the protractor/cardboard setup
up or down along the wall until the
straw makes no shadow and is     directly
in line with the sunlight   .

•  When the straw is directly in line with the sunlight, a
spot of sunlight shows up on the cardboard below the
end of the straw.

4. Put pieces of tape at the top and bottom edges of the
cardboard to temporarily hold it in place against the
wall.

5. Put the end of the Temperature Sensor into the cup of
ice water for about ten seconds to cool it down.
Remove the Temperature Sensor and dry it off.

6. CAREFULLY tape the Temperature Sensor onto the
cardboard so the tip of the sensor is about in
the center of the piece of cardboard. (See the
diagram.)

7. Get the clock ready to keep track of the time.
You will record data for ten minutes for each
angle.

PROTRACTOR

SPOT OF SUNLIGHT 
BELOW THE END  
OF THE STRAW

STRAW

TEMPERATURE 
SENSOR

PROTRACTOR

TAPE

CARDBOARD

SUNLIGHT

STRAW

TEMPERATURE SENSOR & 
CARDBOARD SETUP

WALL

PROTRACTOR

90˚ on PROTRACTOR
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√ Record the Data

1. When you are ready to record data, press the
Data Logging     button on the front panel of the
interface to “wake up” the interface.

• The green LED on the interface will blink once
per second for    ten seconds    as the interface
wakes up.

Get ready to record the time on the clock when the LED begins to blink rapidly.

• The green LED will blink rapidly (several times per second) when the interface starts to
record data.

2. Record the starting time for data recording. Let the interface record data for    ten     minutes.

3. At the end of ten minutes, press and hold the Data Logging button until the LED goes out
to stop recording data.

• The green LED will blink once every five seconds. The interface is in “sleep” mode.

4. Remove the Temperature Sensor from the protractor/cardboard setup.

5. Remove the tape from the straw. Move
the straw so the end of the straw is next
to the center line of the protractor, but
the straw is lined up with 60˚ on the
curved edge of the protractor. Re-attach
the tape to the straw to hold the straw in
place.

6. Remove the tape from the top and
bottom edges of the cardboard. Adjust
the cardboard until the straw makes no
shadow and a spot of sunlight shines
through the straw onto the cardboard.
Re-attach the tape to hold the cardboard
in place.

7. Put the Temperature Sensor into the ice water for about ten seconds to cool it down.
Remove the sensor and dry it off.

8. CAREFULLY tape the Temperature Sensor back into position on the cardboard.

9. Get ready to record data for ten minutes.

10. Press the Data Logging button to “wake up” the interface.

• The green LED will blink once per second for ten seconds as the interface “wakes up”.

11. Data recording begins when the LED starts blinking rapidly. Let the interface record for
ten minutes.

12. At the end of ten minutes, press and hold the Data Logging button until the LED goes out
to stop data recording.

• The green LED will blink once every five seconds. The interface is in “sleep” mode.

13. Remove the Temperature Sensor from the protractor/cardboard setup.

ON

DATA LOGGING 
BUTTON

LIGHT-EMITTING 
DIODE (LED)

SUNLIGHT
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WALL

PROTRACTOR

60˚ on PROTRACTOR
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14. Remove the tape from the straw. Move the straw
so the end of the straw is next to the center line
of the protractor, but the straw is lined up with
30˚ on the curved edge of the protractor. Re-
attach the tape to the straw to hold the straw in
place.

15. Remove the tape from the top and bottom edges
of the cardboard. Adjust the cardboard until the
straw makes no shadow and a spot of sunlight
shines through the straw onto the cardboard. Re-
attach the tape to the wall to hold the cardboard
in place.

16. Put the Temperature Sensor into the ice water for about ten seconds to cool it down.
Remove the sensor and dry it off.

17. CAREFULLY tape the Temperature Sensor back into position on the cardboard.

18. Get ready to record data for ten minutes.

19. Press the Data Logging button to “wake up” the interface.

• The green LED will blink once per second for ten seconds as the interface “wakes up”.

20. Data recording begins when the LED starts blinking rapidly. Let the interface record for
ten minutes.

21. At the end of ten minutes, press and hold the Data Logging button until the LED goes out
to stop data recording.

• The green LED will blink once every five seconds. The interface is in “sleep” mode.

22. Take the interface and the rest of your equipment indoors.

√ Re-connect the Interface

1. Plug the interface cable and the power cord into the back panel on the interface.

NOTE: The LED will continue to blink once every five seconds.

2. Download the data from the interface box to your computer.

•  In the program, select Connect To Interface  from the Experiment  menu.

•  The green LED will stay ON.

SUNLIGHT

STRAW

WALL

30˚ on PROTRACTOR
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Analyzing the Data

1. Set up you Graph display to show Statistics for the Minimum and Maximum values of
temperature.

•  Hint: In DataStudio, click the Statistics Menu button. In ScienceWorkshop, click the
Statistics button to open the Statistics area on the right side of the Graph. Then click the
Statistics Menu button.

2. Record the Minimum y as the Initial Temperature for Run #1. Record the Maximum y as
the Final Temperature for Run #1.

3. Repeat the procedure to find the initial and final temperatures for Run #2.

4. Repeat the procedure to find the initial and final temperatures for Run #3.

5. Calculate the Change in Temperature for each run by subtracting the initial temperature
from the final temperature.

Record your results in the Lab Report section.

--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Lab Report - Activity GS16: Insolation – Solar Radiation

What Do You Think?

Skin doctors warn us that over exposure to the radiation from the sun is harmful to our skin and
can possibly lead to skin cancer. What time of the day are the sun’s rays most absorbed by our
skin? What is the relationship between the amount of radiation absorbed and the angle at which
the sun’s rays strike the skin?

Data Table

The data for this activity are dependent on the location, time of year, weather conditions, etc. The
following are typical changes in temperature for each angle:

Angle Initial Temp. Final Temp. Change in Temp.

90˚

60˚

30˚

Questions

1. Which angle exposed the cardboard to the MOST solar radiation?

2. Which angle exposed the cardboard to the LEAST solar radiation?

3. Which angle best represents the Earth in the summer?

4. Which angle best represents the Earth in the winter?

Ending the Activity

•  Check with your instructor about putting away the equipment for this activity.
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Alternate Method

•  If you cannot go outdoors to record data, use a 100-watt or 150 watt lamp as a substitute
for the Sun.

1. Place the protractor/cardboard setup 25 cm (or about 10 inches) from the lamp.

2. Do not select Disconnect for Logging…  from the Experiment  menu.

3. Record and analyze data as described before.



Name _____________________ Class ______________ Date _________

GS17 © 1999 PASCO scientific p. 137

Activity GS17: Half-Life of a Radioactive Substance
(Nuclear Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Radioactivity GS17 Half-Life.DS G17 Half-Life G17_HALF.SWS

Equipment Needed Qty Equipment Needed Qty
Nuclear Sensor (SN-7927) 1 Graduated cylinder 1
Base and Support Rod (ME-9355) 2 Watch glass 1
Beaker, 50 mL 1 Protective gear PS
Clamp, buret (SE-9446) 1 Other Equipment and Consumables Qty
Clamp, right angle (SE-9444) 1 Isogenerator (SE-7995) 1
Clamp, three-finger (SE-9445) 1 Water, de-ionized or distilled 10 mL

What Do You Think?

The purpose of this activity is to determine the half-life  of a radioactive substance. How can
you use a nuclear sensor (like a Geiger-Müller tube) to determine the half-life of a substance?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Radioactive substances randomly give off high-energy bits of matter and high-intensity bits of
energy. Alpha particles and beta particles are examples of the high-energy bits of matter.
Gamma rays are high-intensity bits of energy. Nuclear sensors such as Geiger-Müller tubes can
detect these forms of radioactivity. Each detected bit of radioactivity is called an “event”. The
number of events can be counted over a period of time to get an idea of how radioactive one
substance is relative to another.

The half-life  of a radioactive substance is the
time required for the number of “counts”
from a radioactive substance to go down to
half of its original value. For example, if the
original number of counts is 70, the half-life
is the time it takes for the number of counts
to become 35.

All radioactive substances have count rates
which decrease toward zero counts per time
period. Eventually, even the most dangerous
radioactive substance becomes safe. This
might take only minutes, or it could take
thousands or even millions of years,
depending on the kind of substance involved.

Think about popping popcorn. The number of kernels of popcorn that pop is fairly constant as
the corn starts to pop, but soon the popping decreases until just a few kernels explode per second.
For popcorn, the same fraction  of un-popped kernels will pop during each time period. For
example, let's assume that one half of the un-popped kernels pop each minute. If you start with
100 kernels, then 50 kernels will pop and 50 kernels will not pop by the end of one minute. In the
next minute, half of the un-popped 50 kernels will pop, and half will not, so there are 25 kernels
left un-popped, and so on. Fewer kernels per second actually pop but the same fraction of un-
popped kernels pop each second. This is similar to the way that radioactive substances give off
radioactivity. In each period of time, the same fraction  of unchanged radioactive atoms give off
radioactivity and change into different elements. Half-life is the time required for the counts per
time period of a radioactive sample to fall to half of its original value.

?
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SAFETY REMINDERS

•  Wear protective gear.

•  Follow directions for using the equipment.

•  Dispose of all chemicals and solutions properly.

 Caution!  Do not let radioactive substances get on your skin or into your eyes or mouth. Inform
your instructor of any spills or if you come in contact with the radioactive substance.

For You To Do

In the     Pre-Lab     for this activity, prepare an “isotope generator” (called an isogenerator). This
device produces the radioactive substance that you will measure. The Pre-Lab takes about ninety
minutes.

In the     Procedure     for this activity, use the Nuclear Sensor to measure the counts (radioactive
“events”) from a radioactive substance that has a short half-life. Use DataStudio or
ScienceWorkshop to record and display the data from the Nuclear Sensor.

Use a Graph of counts and time to determine the    initial    number of counts per time period, and
then find the time at which the number of counts is one-half of the inital number. This time is the
half-life     of the radioactive substance.

Pre-Lab

About the SN-7995 Isogenerator

The isogenerator (short for “isotope generator”) is a device that has a radioactive substance
cemented into a porous plug of epoxy. The radioactive substance itself cannot come out of the
plug of epoxy. However, the radioactive substance (Cesium-137) produces a radioactive by-
product (Barium-137) that has a short half-life. The Barium-137 can be “flushed” out of the plug
of epoxy using a special liquid. You can measure the half-life of the Barium-137 by measuring
the counts of radioactivity coming from the liquid.

NOTE: Because the special liquid drains through the isogenerator and picks up the radioactive
Barium-137 along the way, the isogenerator is sometimes referred to as a “nuclear cow”.

The isogenerator kit includes three parts:

• ion exchange column

• stopcock

• 0.1 Molar EDTA eluant (special liquid) with pH
= 9

The ion exchange column is filled with de-ionized
water when it is shipped from the factory.

ION EXCHANGE 
COLUMN

STOPCOCK

EDTA 
ELUANT
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Preparing the Isogenerator

  REMINDER: Be sure to wear protective clothing (gloves, apron, goggles) when handling or using
the isogenerator or the special liquid after it drains through the isogenerator. Follow all instructions for
handling and using the isogenerator.

You will need the following items: isogenerator kit, 50-mLbeaker, base and support rod, buret
clamp.

1. Remove the large cap at the top of the reservoir on the
ion exchange column. Hold the column upright
securely in one hand. Use your thumb to push the
large cap upward. Do this slowly so that none of the
liquid inside spills out.

• Keep the large cap so you can cover the ion exchange
column again when you are done with it.

2. Put a buret clamp on a base and support rod. Put the
ion exchange column into the buret clamp. Turn the
ion exchange column so you can see the small marks
that are on the back of the reservoir.

3. Place the beaker under the small cap at the bottom of
the ion exchange column.

4. Carefully remove the small cap from the bottom of the ion exchange column. Let the de-
ionized water drain out of the ion exchange column into the beaker.

5. Put the stopcock onto the end of the
ion exchange column. Turn the
valve on the stopcock so the valve
is horizontal and the stopcock is
closed    .

6. Remove the small cap from the top
of the squeeze bottle that contains
the EDTA eluant. Fill the ion
exchange column with the EDTA
eluant to the 5 mL mark on the
reservoir of the ion exchange
column.

7. Allow the ion exchange column to
sit for one hour with the EDTA
eluant in it. (This allows more of
the Barium-137 to move down the
column.)

LARGE CAP

SMALL CAP

RESERVOIR

EPOXY COLUMN

ION EXCHANGE 
COLUMN

BEAKER

BURET CLAMP

STOPCOCK
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Computer and Equipment Setup

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on the interface and then turn
on the computer.

2. Connect the Nuclear Sensor stereo phone plug to Digital Channel 1.

3. Open the file titled as shown;

DataStudio ScienceWorkshop (Mac ScienceWorkshop (Win)
GS17 Half-Life.DS G17 Half-Life G17_HALF.SWS

• The document opens with a Digits display and a Graph display of Counts versus Time.

• The DataStudio document also has a Workbook display. Read the instructions in the
display.

• Data recording is set at one sample per second and will stop automatically at 600 seconds.

PART II: Sensor Calibration and Equipment Setup

• You do not need to calibrate the Nuclear Sensor.

Equipment Setup

1. Put the Nuclear Sensor into a three-finger
clamp. Use a right angle clamp to mount the
Nuclear Sensor on a base and support rod. Turn
the Nuclear Sensor so it is vertical and the
Geiger-Müller tube is pointing down.

2. Carefully remove the protective plastic cap
from the end of the Nuclear Sensor. Place the
watch glass below the end of the Nuclear
Sensor.

3. Adjust the position of the Nuclear Sensor so
that the end of the sensor is 1 or 2 cm above the
watch glass.

4. Remove the watch glass temporarily and place
it under the stopcock at the bottom end of the
ion exchange column that has 5 ml of EDTA
eluant in it. Adjust the ion exchange column so
the bottom end is 3 to 4 cm (less than 2 inches)
above the watch glass.

5. Open the stopcock and let     2 ml    of eluant drain down into the watch glass. Close the
stopcock again as soon as the eluant drains out.

• If the isogenerator is going to be used again right away, refill the reservoir with eluant to the 5 ml
mark. Wait between 15 and 30 minutes before draining more of the eluant out of the ion exchange
column.

• If the isogenerator is NOT going to be used again right away, drain the rest of the eluant into a
beaker. Close the stopcock. Fill the reservoir to the 10 ml (top mark) mark with de-ionized water.
Put the large cap back on the reservoir tightly. Store the isogenerator in an air tight container.

6. Put the watch glass back underneath the end of the Nuclear Sensor.

TO
INTERFACE

NUCLEAR
SENSOR

WATCH GLASS

THREE-
FINGER
CLAMP
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PART III: Data Recording

1. Start recording data. (Click ‘Start’ in DataStudio or click ‘REC’ in ScienceWorkshop .)

• Data recording will stop automatically after ten minutes. Run #1 will appear in the Data
list.

--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Follow all instructions for the handling and disposal of the chemical used in this activity.
DO NOT pour any chemicals down the drain unless you are told to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the ‘File’ menu to save your data for this
activity and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Analyzing the Data

1. Rescale the Graph to fit the data. (Use ‘Scale to Fit’ in DataStudio or ‘Autoscale’ () in
ScienceWorkshop.)

2. Use the Graph’s built-in analysis tools to find the half-life of the substance.

• Hint: Use the ‘Smart Tool’ or ‘Smart Cursor’ to find the value of counts at the beginning
of the run. Move the ‘Smart Tool’ or ‘Smart Cursor’ along the plot of counts until the ‘Y’
coordinate is approximately     one-half    of the original value. Record the value of the ‘X’
coordinate as the ‘half-life’ time.

Record your results in the Lab Report section.
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Lab Report - Activity GS17: Half-Life of a Radioactive Substance

What Do You Think?

The purpose of this activity is to determine the half-life  of a radioactive substance. How can
you use a nuclear sensor (like a Geiger-Müller tube) to determine the half-life of a substance?

Data Table

Initial Count counts per second

Half-Life minutes

Questions

1. How does your value of half-life time for the Barium-137 compare to the accepted value
(about 2.6 minutes)?

2. How long will it take for counts from the Barium-137 to decrease to 1/4th of the original
counts?
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Activity GS18: Understanding Motion – Position vs. Time
(Motion Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Linear motion GS18 Understand Motion.DS G18 Understanding Motion G18_MOTN.SWS

Equipment Needed Qty Equipment Needed Qty
Motion Sensor (CI-6742) 1 Base and Support Rod (ME-9355) 1

What Do You Think?

What is the relationship between the motion of an object – YOU – and a graph of position and
time for the moving object?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

When describing the motion of an object, knowing where it is relative to a reference point, how
fast and in what direction it is moving, and how it is accelerating (changing its rate of motion) is
essential.

A sonar ranging device such as the PASCO Motion Sensor uses pulses of ultrasound that reflect
from an object to determine the position of the object.

As the object moves, the change in its position is measured many times each second. The change
in position from moment to moment is expressed as a velocity (meters per second). The change
in velocity from moment to moment is expressed as
an acceleration (meters per second per second).

The position of an object at a particular time can be
plotted on a graph. You can also graph the velocity
and acceleration of the object versus time.

A graph is a mathematical picture of the motion of an
object. For this reason, it is important to understand how to interpret a graph of position,
velocity, or acceleration versus time. In this activity you will plot a graph of position in real-
time, that is, as the motion is happening.

SAFETY REMINDER

•  Follow all safety instructions.

•  Keep the area clear where you will be walking.

For You To Do

•  This activity is easier to do if you have a partner to run the computer while you move.

For this activity,     you     will be the object in motion. Use the Motion Sensor to measure your
position as you move in a straight line at different speeds. Use DataStudio or ScienceWorkshop
to plot your motion on a graph of position and time.

The challenge in this activity is to move in such a way that a plot of your motion on the same
graph will “match” the line that is already there.
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PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the
computer, turn on the interface, and turn on the
computer.

2. Connect the stereo phone plugs of the Motion
Sensor to Digital Channels 1 and 2 on the
interface. Connect the yellow plug to Digital
Channel 1 and the other plug to Digital Channel
2.

3. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS18 Understand Motion.DS G18 Understanding Motion G18_MOTN.SWS

• The DataStudio file has a Workbook display. Read the instructions in the Workbook.

• The ScienceWorkshop document has a Graph display of Position versus Time.

• The Graph shows Position and Time values that were entered into the Graph.

• Data recording is set to stop automatically at 10 seconds. In the DataStudio file there is a
‘countdown’ before data recording begins.

PART II: Sensor Calibration and Equipment Setup

•  You do not need to calibrate the Motion Sensor.

1. Set the range select switch on the
Motion Sensor to ‘Far’.

2. Mount the Motion Sensor so that it
is aimed at your midsection when
you are standing in front of the
sensor. Make sure that you can
move at least 2 meters away from
the Motion Sensor.

3. Position the computer monitor so
you can see the screen while you
move away from the Motion
Sensor.

•  You will be moving backwards for part of
this activity. Clear the area behind you
for at least 2 meters (about 6 feet).
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PART III: Data Recording

1. Enlarge the Graph display until it fills the monitor screen.

2. Study the plot of Position versus Time in order to determine the following:

• How close should you be to the Motion Sensor at the beginning? _______ (m)

• How far away should you move? _______ (m)

• How long should your motion last? _______ (s)

3. When you are ready, stand in front of the Motion Sensor.

•  WARNING: You will be moving backward, so be certain that the area behind you is free of obstacles.

4. When everything is ready, start recording data.

• In DataStudio, click ‘Start’. There is a three-second countdown before data recording
begins. The ‘cursor’ on the vertical axis of the Graph will move up and down as you move
forward and backward relative to the sensor. Use the feedback from ‘cursor’ to find your
best starting position.

• In ScienceWorkshop, click ‘REC’. Data recording will begin almost immediately.

• The Motion Sensor will make a faint clicking noise.

5. Watch the plot of your motion on the Graph and try to move so the plot of your motion
matches the Position versus Time plot already there.

If the Motion Sensor is having difficulty picking up the echo, use a notebook as a reflector. Hold
the notebook at the same height as the sensor.

6. Repeat the data recording process a second and a third time. Try to improve the match
between the plot of     your    motion and the plot already on the Graph.

•  The Graph can show more than one run of data at the same time.
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Analyzing the Data

1. Determine the slope of the best-fit line for the middle section of your best position versus
time plot. You may want to resize the graph to fit the data.

• The slope of this part of the position versus time plot is the     velocity     during the selected
region of motion.

2. Determine how well your plot of motion fits the plot that was already in the Graph. (Hint:
In DataStudio, examine the ‘Match Data’ calculation. In ScienceWorskhop, examine the
‘total abs. diff.’ (total absolute difference) and the chi^2 (goodness of fit) terms from the
Statistics area.)

Use your results to answer the questions in the Lab Report section.

--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the ‘File’ menu to save your data for this
activity and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Lab Report - Activity GS18: Understanding Motion – Position vs. Time

What Do You Think?

What is the relationship between the motion of an object – YOU – and a graph of position and
time for the moving object?

Questions

1. In the Graph, what is the slope of the line of best fit for the middle section of your plot?

2. What is the description of your motion? (Example: “Constant speed for 2 seconds followed
by no motion for 3 seconds, etc.”)

3. What would be the physical meaning of a steeper slope on the graph?

4. What would be different about the motion if the slope were negative?
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Activity GS19: Acceleration of a Cart
(Motion Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Linear motion GS19 Accelerate a Cart.DS G19 Cart Acceleration G19_CART.SWS

Equipment Needed Qty Equipment Needed Qty
Motion Sensor (CI-6742) 1 Dynamics Cart (inc. w/ Track) 1
Block (or book) 1 1.2 m Track System (ME-9429A) 1

What Do You Think?

What happens to the acceleration of a cart as it moves up and down an inclined plane?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

A cart on a perfectly level surface is pulled downward by the force of gravity on it. The surface
balances the force of gravity. Since there is no net force up or down on the cart, the cart doesn’t
move.

A cart that is dropped vertically is also pulled downward by the
force of gravity. If you ignore the small amount of air resistance
on the cart, the only force acting on the cart IS gravity. Since
there is a net force pulling downward on the cart, the cart moves
downward. Not only that, it gains speed as it falls. In fact, it
gains speed at a constant rate of 9.8 meters per second each
second! This change in speed is called the acceleration due to
gravity.

FORCE OF GRAVITY PULLS 
DOWNWARD ON THE CART.

LEVEL SURFACE 
SUPPORTS THE CART.

FORCE OF GRAVITY PULLS
DOWNWARD ON THE CART.
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If a cart is on a surface
that is not level but is
not vertical, it is  still
pulled downward by the
force of gravity. What
is different is that part
of the force of gravity
presses the cart against
the track. Another part
of the force of gravity
pulls the cart along the
track. Each part is
called a component of
the force.

(Mathematically, the part of the force of gravity that pulls the cart along the track is mg sin θ,

where m is the mass of the cart, and g is the acceleration due to gravity and θ, is the angle of the
track.)

If you put a cart at the bottom of the track and give it a push up the track, it will slow down as it
goes up the track and speed up as it comes back down the track.

In theory, the acceleration (change in speed) going up the track is the    same     as the acceleration
coming back down the track.

SAFETY REMINDER

•  Follow all safety instructions.

For You To Do

Use a Motion Sensor to measure the motion of a cart that is pushed up an inclined plane. Use
DataStudio or ScienceWorkshop to record the motion and calculate the velocity and acceleration
of the cart as it moves up and down the inclined plane.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the
computer, turn on the interface, and then turn on the
computer.

2. Connect the Motion Sensor’s phone plugs to Digital
Channels 1 and 2 on the interface. Plug the yellow-
banded (pulse) plug into Digital Channel 1 and the
second plug (echo) into Digital Channel 2.

3. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
P07 Accelerate Cart.ds (See end of activity) (See end of activity)

•  The DataStudio file has a Workbook display. Read the instructions in the Workbook.

• Data recording is set so the Trigger Rate for the Motion Sensor is 10 samples per second
(10 Hz).

THE FORCE OF GRAVITY PULLS 
DOWNWARD ON THE CART.

PART OF THE FORCE OF 
GRAVITY PRESSES THE 
CART AGAINST THE TRACK.

PART OF THE FORCE OF 
GRAVITY PULLS THE CART 
ALONG THE TRACK.
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PART II: Sensor Calibration and Equipment Setup

• You do not need to calibrate the sensor for this activity.

1. Place the track on a horizontal surface. Use a block or book at one end of the track to raise
that end.

2 Mount the Motion Sensor at the high end of the track. Put a mark on the track 15 cm from
the Motion Sensor.

Preparing to Record Data

1. Before recording any data for later analysis experiment with the Motion Sensor to make
sure it is aligned and can “see” the cart as it moves.

2. Place the cart on the low end of the track (i.e., the end opposite to the Motion Sensor).

3. When everything is ready, start recording data.

4. Give the cart a firm push up the track so the cart will move up the inclined plane    toward    
and then    away from      the Motion Sensor.

•  BE CAREFUL! Don’t push the cart so firmly that it gets closer than 15 cm to the sensor.

Remember: The minimum distance between the cart and the Motion Sensor should be 15 cm.

5. Stop recording when the cart returns to the bottom of the track.

•  You may want to rescale the Graph.

6. If the plot of data is not smooth, check the alignment of the Motion Sensor and repeat the
above procedure until the plot is smooth.

7. Erase your sample run of data.
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PART III: Data Recording

1. Prepare to measure the motion of the cart as it moves toward the Motion Sensor and then
back down the track. Place the cart at the low end of the track.

2. When everything is ready, start recording data. Give the cart a firm push toward the
Motion Sensor. Continue collecting data until the cart has returned to the bottom of the
track.

•  If the data points do not appear on the graph, check the alignment of the Motion Sensor and try again.

Optional

• Set the track to a steeper angle (e.g., 10 degrees) and repeat the data recording.

Analyzing the Data

1. In the Motion Sensor’s plot of     velocity    , use the cursor to select the region of the plot that
shows the cart’s motion    after    the push and     before     it stopped at the bottom of the track.

2. Use the Graph display’s built-in analysis tools to apply a linear curve fit.

• Hint: In DataStudio, select ‘Linear’ from the ‘Fit’ menu. In ScienceWorkshop, click the
‘Statistics’ button and then select ‘Curve Fit, Linear Fit’ from the ‘Statistics’ menu

( ).

3. The slope of the best-fit line is the average acceleration. Record the value in the Data
Table.

4. In the Motion Sensor’s plot of    acceleration    , select the region of the plot that corresponds to
the cart’s motion    after    the push and     before     it stopped at the bottom of the track.

5. Use the ‘Statistics’ tool to find the mean value of the acceleration as measured by the
Motion Sensor for your selected region. Record the mean of the acceleration in the Data
Table.

Record your results in the Lab Report section.
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Lab Report - Activity GS19: Acceleration of a Cart

What Do You Think?

What happens to the acceleration of a cart as it moves up and down an inclined plane?

Data Table

Item Value

acceleration (slope) m/sec2

acceleration (mean) m/sec2

Questions

1. Describe the position versus time plot of the Graph display. Why does the distance begin at
a maximum and decrease as the cart moves up the inclined plane?

2. Describe the velocity versus time plot of the Graph display.

3. Describe the acceleration versus time plot of the Graph display.

4. Is the acceleration of the cart going up the track the same as the acceleration of the cart
coming down the track? Why or why not?

Optional: How did the acceleration change when the track became steeper?
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--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the ‘File’ menu to save your data for this
activity and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Activity GS20: Newton’s Second Law - Push / Pull a Cart
(Force Sensor, Motion Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Motion GS20 Push Pull a Cart.DS G20 Push-Pull a Cart G20_PUSH.SWS

Equipment Needed Qty Equipment Needed Qty
Economy Force Sensor (CI-6746) 1 Dynamics Cart (inc. w/ Track) 1
Motion Sensor (CI-6742) 1 1.2 m  Track System (ME-9429A) 1
Balance (SE-8723) 1

What Do You Think?

The purpose of this activity is to find the relationship between a force pushing or pulling a cart,
the mass of the cart, and the acceleration of the cart. Can erratic pushing and pulling of the cart
show the relationship?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Isaac Newton described the relationship of acceleration to net force and mass of an object as
follows:

The acceleration of an object is directly proportional and in the same direction as the net force on
the object, but inversely proportional to the mass of the object.

a
F
m
net=

• For this activity you will be verifying Newton’s Second Law in the form m
F
a
net= .

where m is the mass of the object, Fnet is the net force (push or pull) on the object, and a is the
acceleration of the object.

The first part of Newton’s statement
means that the      more     net force, the      more    
acceleration for a given amount of mass.

The second part of Newton’s statement
means that the      more     mass, the    less   
acceleration for a given amount of net
force.

Net Force:
Push or Pull

Acceleration:
 Directly depends on the
amount of net force.

The more net force, the more
acceleration for a given
amount of mass.

Net Force
Push or Pull

Acceleration:
Inversely depends on the
amount of mass.

The more mass, the less
acceleration for a given
amount of net force.
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SAFETY REMINDER

• Do not let the cart hit the Motion Sensor.

• Follow directions for using the equipment.

For You To Do

For this activity, push and pull a Dynamics Cart back-and-forth on a level Dynamics Track. Use
the Motion Sensor to measure the motion of a cart, and the Force Sensor to measure the force
you exert on the cart. Use DataStudio or ScienceWorkshop to calculate the acceleration of the
cart as it moves. (Hint: The slope of the graph of force versus acceleration is the mass of the
moving object.)

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer,
turn on the interface, and turn on the computer.

2. Connect the Motion Sensor’s phone plugs to Digital
Channels 1 and 2 on the interface. Plug the yellow-
banded (pulse) plug into Digital Channel 1 and the
second plug (echo) into Digital Channel 2.

3. Connect the DIN plug of the Force Sensor to Analog
Channel A.

4. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS20 Push Pull a Cart.DS G20 Push-Pull a Cart G20_PUSH.SWS

• The DataStudio document has a Workbook display. Read the instructions in the Workbook.

• The ScienceWorkshop document has a Graph display of Force versus Acceleration.

• Data recording is set at 100 Hz for the Force Sensor and the Trigger Rate for the Motion
Sensor is 20 times per second.

• The calibration for the Force Sensor has been changed so that a     push     to the left is negative
and a     pull    to the right is positive.

PART II: Sensor Calibration and Equipment Setup

• You do not need to calibrate the Motion Sensor.

• To calibrate the Force Sensor, refer to the description in the introduction of this manual.

1. Place the track on a horizontal surface. Level the track by placing the cart on the track. If
the cart rolls one way or the other, use the adjustable feet at one end of the track to raise or
lower that end until the track is level and the cart does not roll one way or the other.

2. Mount the Force Sensor onto the accessory tray of the cart.

3. Measure and record the mass of the cart plus Force Sensor in the Data Table in the Lab
Report section.

4. Position the Motion Sensor at the left end of the track. Place the cart on the track so the
hook end of the Force Sensor points away from the Motion Sensor. The cart must remain a
minimum distance away from the sensor (15 cm for the Motion Sensor II). Put a mark on
the track at the minimum distance from the Motion Sensor (15 cm).
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Trial Run of Data

1. Before recording data for later analysis, record a trial run with the Motion Sensor to make
sure it is aligned and can “see” the cart as it moves.

2. Place the cart on one end of the Dynamics Track. Press the    tare button     on the side of the
Force Sensor to zero the Force Sensor.

3. Firmly grasp the hook of the Force Sensor and pull and push the Force Sensor to make the
cart move back and forth. Make sure the cart does not come too close to the Motion
Sensor.

4. Start recording data. (Click ‘Start’ in DataStudio or ‘REC’ in ScienceWorkshop.)

5. After about 10 seconds, stop recording data.

6. Adjust the position of the Motion Sensor if necessary.

PART III: Data Recording

1. Prior to recording each data run, press the tare button on the side of the Force Sensor to
zero the Force Sensor.

2. After the Force Sensor has been zeroed, begin pulling and pushing on the hook of the
Force Sensor to make the cart move back and forth.

3. Start recording data.

4. Push and pull the cart back and forth four or five times, then stop the recording.

• Run #1 will appear in the Data list. If the data points do not appear on the graph, check the
alignment of the Motion Sensor and try again.

Analyzing the Data

1. Click-and-draw a rectangle around the region of the force versus acceleration plot that
shows the movement of the cart. Release the mouse button, and the area will be
highlighted.

2. Select the Linear curve fit.

• In DataStudio, click the ‘Fit’ menu button ( ). Select ‘Linear’.

• In ScienceWorkshop click the ‘Statistics’ button to open the Statistics area on the right side

of the Graph. In the Statistics area, click the Statistics Menu button (). Select ‘Curve
Fit, Linear Fit’ from the Statistics Menu.

3. Record the slope of the linear fit in the Data Table in the Lab Report section.

Record your results in the Lab Report section.
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--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown
When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the ‘File’ menu to save your data for this
activity and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Lab Report - Activity GS20: Newton’s Second Law – Push/Pull a Cart

What Do You Think?

The purpose of this activity is to find the relationship between a force pushing or pulling a cart,
the mass of the cart, and the acceleration of the cart. Can erratic pushing and pulling of the cart
show the relationship?

Data Table

Item Value

Mass of cart and Force Sensor (measured) kg

Mass of cart & Force Sensor (slope) kg

Questions

1. Why does the slope of the force versus acceleration plot equal the object’s mass?

2. What is the percentage difference between the actual and experimental mass? Remember,

percent difference = theoretical − actual
theoretical

× 100%



General Science Labs with Computers   Student Workbook
GS20: Newton’s Second Law - Push /Pull a Cart 012-06654B

p. 162 ©1999 PASCO scientific GS20



Name _____________________ Class ______________ Date _________

GS21 ©1999 PASCO scientific p. 163

Activity GS21: Conservation of Energy – PE to KE
(Motion Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Energy GS21 Conserve Energy.DS G21 Conserve Energy G21_ENER.SWS

Equipment Needed Qty Equipment Needed Qty
Motion Sensor (CI-6742) 1 Masses ~2 kg
Balance (SE-8723) 1 Meter stick 1
Base and Support Rod (ME-9355) 1 Ruler, metric (15 cm) 1
Block 1 1.2 m Track System (ME-9429A) 1
“C” clamp 1 Tape 1 roll
Dynamics Cart (inc. w/ Track) 1

What Do You Think?

How well is energy conserved when the elastic potential energy of a spring is transformed into
kinetic energy of a moving cart?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Potential energy is sometimes called
stored energy. A compressed spring has
stored potential energy called elastic
potential energy. Kinetic energy is called
the energy of motion. An object in
motion has kinetic energy.

The amount of force that a spring can
push with depends on how far it is
compressed and how strong the spring is
(called the spring constant). Likewise,
the amount of elastic potential energy
(stored energy) a spring has depends on
how far it has been compressed and the
spring constant.

ELASTIC POTENTIAL ENERGY: 
ENERGY STORED IN THE 
COMPRESSED SPRING.

KINETIC ENERGY: ENERGY 
OF MOTION OF THE MOVING 
CART

WHEN THE COMPRESSED SPRING IS RELEASED 
IT PUSHES THE CART AWAY.

A spring that is compressed a distance x from its normal position has an amount of elastic
potential energy given by:

PEelastic = 1
2

kx2

where PEelastic stands for “elastic potential energy”, k is the spring constant and x is the distance
that the spring is compressed.

The amount of kinetic energy that an object has depends on how much mass it has and how fast
it is moving. The formula for kinetic energy is:

KE = 1
2

mv2

where KE stands for “kinetic energy”, m is the mass of the object, and v is the speed of the
object.
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If energy is conserved, the elastic potential energy in the compressed spring will be completely
transformed into kinetic energy when the spring pushes an object of mass m.

SAFETY REMINDER

• Do not let the cart hit the Motion Sensor.

• Follow directions for using the equipment.

For You To Do

In the     Pre-Lab     for this activity, measure the spring constant of the plunger spring in a dynamics
cart. Put heavy masses on the end of the plunger to force the spring to compress. Measure the
amount of distance that the spring compresses. Use DataStudio or ScienceWorkshop to make a
Graph of force and position that will give you the value of the spring constant k.

In the     Procedure     for this activity, use the Motion Sensor to measure the motion of a cart after it is
pushed by the plunger spring as the spring de-compresses. Use DataStudio or ScienceWorkshop
to record the motion and display the initial velocity and maximum kinetic energy of the cart.

Use your data to compare the measured kinetic energy to the calculated elastic potential energy.

Pre-Lab

Equipment Setup and Data Recording

The dynamics cart has a spring-
loaded plunger that can be used to
push the cart to get it moving. The
plunger has three notches so the
plunger spring can be compressed to
three different distances.

PLUNGER

END CAP

PLUNGER 
RELEASE PIN

DYNAMICS CART

ACCESSORY 
TRAY

When the plunger spring is fully compressed,
the end cap is even with the end of the cart.
When it is not compressed at all, it goes out
about 3 cm.

1. Put the dynamics on end with the
plunger at the top. Place the 15-cm
metric ruler on the side of the cart and
line up the 0 cm mark on the ruler with
the end cap of the plunger. Tape the
metric ruler to the side of the cart.

TAPE THE 15 cm 
RULER TO THE SIDE 
OF THE 
ACCESSORY TRAY.

LINE UP THE 0 cm 
MARK ON THE 
RULER WITH THE 
END CAP OF THE 
PLUNGER.
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2.     Carefully     add masses on top of the
plunger until the plunger spring is
almost fully compressed. Add up the
total mass that it took to compress the
spring. Use the ruler to measure the
position of the end cap. Record the total
mass and the position in the Data
Table.

• You may need to steady the dynamics
cart and the pile of masses to keep them
from leaning.

CAREFULLY ADD 
MASSES TO THE 
PLUNGER UNTIL IT IS 
ALMOST FULLY 
COMPRESSED.

3. Remove approximately one-fourth of
the mass you used in the previous step.
Measure the new position of the end
cap. Record the amount of mass and
the position in the Data Table.

4. Repeat the previous step. Remove
another one-fourth of the original mass
(so one-half the original mass
remains). Measure the new position of
the end cap. Record the amount of
mass and the new position in the Data
Table.

5. Remove another one-fourth (so one-
fourth remains). Measure the position.
Record the amount of mass and the
new position in the Data Table.

6. Remove the final amount of mass.
Remove the metric ruler from the cart.

7. In the Data Table, convert the
positions from centimeters to meters
(divide by 100).

REMOVE ABOUT ONE-
FOURTH OF THE 
MASS ON THE 
PLUNGER.

MEASURE THE 
NEW POSITION OF 
THE END CAP.
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8. Convert the mass from grams to kilograms (divide by 1000). Convert from mass to force
by mutlitplying the mass in kilograms by 9.8 newtons per kilogram (the strength of
gravity at Earth’s surface).

Pre-Lab: Data Table

Position (cm) Position (m) Mass (g) Mass (kg) Force (N)

All mass

3/4 mass

1/2 mass

1/4 mass

no mass 0 0 0 0 0

Pre-Lab: Analyze the Data

1. Use DataStudio or ScienceWorkshop to create a graph of Force versus Position in order to
determine the spring constant from your data.

In         DataStudio    , do the following:

• Open the file titled ‘GS21 Conserve Energy.DS’

• In the Table display, type in your recorded values for position in meters and force in
newtons. (Use the <tab> or <return> key to move from one cell to the next.) After you are

done, click the ‘Edit Data’ tool ( ). ‘Data’ will appear in the Summary list.

• Drag ‘Data’ to the Graph icon in the Display list.

• In the Graph display, select ‘Linear’ from the ‘Fit’ menu.

• The value of the slope is the spring constant, k.
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In        ScienceWorkshop       ,    do the following:

• Click the ‘Notes’ window button in the Experiment Setup
window to open a blank Experiment Notes window. You
can import data into ScienceWorkshop using the
Experiment Notes window.

• Type in your recorded values for position in meters and
force in newtons. Use the following format:

first number <TAB> second number <RETURN>

• In this case, the first number is the value of position and the
second number is the value of force. (Note: The numbers in the example are “made up”.
Your numbers will probably be different.)

• Use the cursor to highlight your numbers in the Experiment Notes window, or click the
‘Edit’ menu and pick ‘Select All’.

• Click the ‘Edit’ menu and select ‘Copy’.

• Click the Experiment Setup window to make it active. Click the ‘Edit’ menu and select
‘Paste’.

• The ‘Enter Data Cache Information’ window will
open.

• Type in ‘Spring Constant’ for the ‘Long Name’,
‘Spring’ for the ‘Short Name’, and ‘N’ for
‘Units’. Click ‘OK’ when you are done.

• The ‘Short Name’ appears in the Data list in the
Experiment Setup window.

• Click the ‘Display’ menu and select ‘New
Graph’. The Graph display will show your data,
but you may need to rescale the Graph in order to
see it.

• Click the ‘Statistics’ button to open the Statistics area on the right side of the Graph. Click
the ‘Autoscale’ button to rescale the Graph to fit the data.

• Click the ‘Statistics Menu’ button ( ). Select ‘Curve Fit, Linear Fit’ from the Statistics
menu. The Statistics area will show the formula of a line, the constant a1, and the slope a2.
The slope is the spring constant, k, of your plunger spring.

2. Record the value of your spring constant, k, in the Lab Report section.
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Procedure

Remember, use the Motion Sensor to measure the motion of a cart just after it is pushed by the
plunger spring as the spring de-compresses. Use DataStudio or  ScienceWorkshop to record and
display the motion and the kinetic energy of the cart. Compare the measured kinetic energy to
the calculated elastic potential energy.

PART I: Computer Setup

1. Connect the Motion Sensor stereo phone plugs to Digital
Channels 1 and 2 on the ScienceWorkshop interface. Put the
yellow-banded phone plug into Digital Channel 1. Put the
other phone plug into Digital Channel 2.

2. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS21 Conserve Energy.DS G21 Conserve Energy G21_ENER.SWS

• Note: ‘GS21 Conserve Energy.DS’ may already be open because it was used during the
Pre-Lab.

• The document opens with a Graph display. The DataStudio document also has a Table
display and a Workbook display. Read the instructions in the Workbook display.

PART II: Sensor Calibration and Equipment Setup

Sensor Calibration

• You should calibrate the Motion Sensor so it can use an accurate measurement of the speed
of sound in air. You will need a meter stick and a flat surface that can be used as a target to
reflect the pulses from the Motion Sensor.

1. Place the track on a horizontal surface. Put the cart near the middle of the track and level
the track by raising or lowering one end so the cart will not roll one way or the other.
Remove the cart when the track is level.

2 Put the Motion Sensor at one end of the track. Place a flat surface (such as a book) exactly
one meter away from the Motion Sensor. Adjust the target so that it can reflect the pulses
from the Motion Sensor.
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3. In the DataStudio Setup window, double-click the sensor’s icon. Result: The Sensor
Properties window opens.

4. Click the ‘Motion Sensor’ tab. Result: The calibration window opens and the sensor
begins to click a few times per second.

5. In the ScienceWorkshop Experiment Setup window, double-click the Motion Sensor icon.
Result: The Calibration window opens.

6. Calibrate the software.

• First , make sure that the sensor is one meter from the target.

• Second, click the ‘Calibrate’ button in the Motion Sensor window. Result: The software
calculates the speed of sound based on the calibration distance (one meter) and the round
trip time of the pulse and echo

7. Click ‘OK’ to return to the Experiment Setup window.
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Equipment Setup

1. Clamp a block onto the table next to the end stop at one end of the track.

• The block will keep the track from sliding one way when the plunger spring pushes the cart
the opposite direction.

2. Put the Motion Sensor at the other of the track.

3. Put a pencil mark on the edge of the track 15 cm in front of the Motion Sensor.

4. Measure the mass of the cart. Record the mass m in the Lab Report.

5. Measure the length of the
plunger relative to the end
cap of the dynamics cart.
Record the plunger length x
in the Lab Report.

6. Fully compress the plunger
spring on the cart, and lock
the spring in position by
pulling the end of the
plunger bar upward slightly so one of its notches will ‘catch’ on the metal rail inside the
cart’s end cap.

7. Put the cart on the track so the end of the plunger bar is against the end-stop.

PART III: Data Recording

1. Start recording data. (Click ‘Start’ in DataStudio or click ‘REC’ in ScienceWorkshop.)

2. Use the end of a pencil or similar object to tap down on the plunger release pin.

• Avoid getting your hand in the way of the pulses from the Motion Sensor.

• The cart will be pushed away from the end-stop by the plunger spring.

3. Stop recording data when the cart gets about 15 cm from the Motion Sensor.

• Catch the cart so it doesn’t run into the Motion Sensor.

• Run #1 will appear in the Data list in the Experiment Setup window.

4. Repeat the data recording process two more times.

Optional: Data Recording – Cart and Extra Mass

1. Put a mass bar in the accessory tray of the cart and measure the mass of the cart plus bar.
Record the mass in the Lab Report.

2. Repeat the data recording process as in Part III.

Ending the Activity (See the section after Questions)

X = DISTANCE THAT THE PLUNGER 
SPRING IS COMPRESSED

RULER
CART
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Analyzing the Data

1. Use DataStudio or ScienceWorkshop to calculate and display the kinetic energy of the cart.

In         DataStudio    , do the following:

• Open the ‘Calculator’ window. The window already has a calculation of kinetic energy
based on a ‘Cart Mass’ of 0.4904 kg.

• Enter the value of the mass of your cart under ‘Cart Mass’ in the ‘Calculator’ window.
Click ‘Accept’ to record the change you made.

• In the Graph of Kinetic Energy, use the built-in analysis tools to find the maximum KE.

(Hint: Use the ‘Smart Tool’ to find the maximum KE.)

In        ScienceWorkshop    , do the following:

• Open the ‘Experiment Calculator’ window.

• In the formula area, type 0.5 and then

click the ‘multiplication’ button ( ).

• Type the value for the mass of your cart
(0.5009 in the example), and click the
‘multiplication’ button again.

• Click the ‘INPUT Menu’ button

( ). Select ‘Digital 1, Velocity (v).

• Type ̂ 2, which means to square the speed, after @1.v
(the symbol for Digital 1, Velocity (v)).

• Type ‘Kinetic Energy’ in the Calculation Name area. Type
‘KE’ in the Short Name area. Type ‘J’ in the Units area.

• Click the equals button (=), or press <enter> or <return>
on the keyboard.
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• Click the Graph display to make it active.

• Click the ‘Add Plot’ menu button ( ) at the bottom of the Graph and select
‘Calculations, Kinetic Energy’. The Graph will show Velocity and Kinetic Energy for the
data from Run #1.

• Use the built-in analysis tools to find the maximum kinetic energy.

(Hint: Click the ‘Statistics Menu’ button in the Statistics area of the plot of      Kinetic Energy    .
Select ‘All Of The Above’ from the Statistics Menu.)

2. Record the values of the maximum kinetic energy in the Lab Report.

3. Calculate the elastic potential energy based on k and x. Record the value in the Lab Report.

Record your results in the Lab Report section.

CLICK-AND-DRAW 
A RECTANGLE
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Lab Report - Activity GS21: Conservation of Energy – PE to KE

Data Table

Item Value

Mass (cart) kg

Spring constant “k” N/m

Plunger length “x” m

Run # 1 2 3 Average

KE (J) J

Elastic Potential Energy = PEelastic = 1
2

kx2= _______ J

Questions

1. What is the difference between your value for the average kinetic energy and the elastic
potential energy?

2. Which energy was larger in each case, the elastic potential energy or the kinetic energy of
the cart?

3. What are possible reasons for the differences, if any?



General Science Labs with Computers   Student Workbook
GS21: Conservation of Energy - PE to KE 012-06654B

p. 174 ©1999 PASCO scientific GS21

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select Quit from the File menu to end the activity.

2. You can select Save or Save As… from the File menu to save your data for this activity
and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Activity GS22: Heat vs. Temperature
(Temperature Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Energy GS22 Heat v Temperature.DS G22 Heat v. Temperature G22_TEMP.SWS

Equipment Needed Qty Chemicals and Consumables Qty
Temperature Sensor (CI-6505A) 1 Styrofoam cup with lid 1
Graduated cylinder, 100 mL 1 Water 300 mL
Heating resistor, 10 Ω, 1 W 1
Power supply, DC, 10 W (SE-9720) 1
Protective gear 1

(*such as the heating resistor that is part of the PASCO CI-6514 Thermodynamics Kit)

What Do You Think?

What is the relationship between heat, thermal energy, and temperature?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Heat is energy in transit between two or more objects. When the energy is inside an object, it is
sometimes called internal energy or thermal energy. The thermal energy in an object is the total
kinetic energy of all the particles that make up the object.

Temperature is a measure of the    average    kinetic energy of all the particles in the object.
The     number    for the temperature of an object doesn’t tell you much about the actual
kinetic energy of a particle inside the object. The number comes from a    temperature
scale    such as the kind found on a common thermometer.

A thermometer measures temperature by means of the expansion and contraction of a
liquid, usually mercury or colored alcohol. The reason that this works is that the liquid in
a thermometer expands or contracts in a predictable, repeatable way when it gains or
loses thermal energy. For example, the mercury in a thermometer always expands to the
same level when the end of the thermometer is in boiling water. It always shrinks to the
same level when the end of the thermometer is in ice-cold water. The number on the
temperature scale is a way to make comparisons. If we say that a certain liquid has a
temperature of 0˚ C, it means that the mercury in a thermometer put into this liquid
would shrink to the same level as it did when the thermometer was put into ice-cold
water.

The amount of thermal energy in an object is related to temperature, but temperature by itself
can’t tell you have much thermal energy is in an object. For example, a bed of glowing coals in a
fireplace might have a temperature of 600 ˚C while a single spark from the fire might have a
temperature of 2000˚ C. The single “hot” spark gives off very little heat while the bed of
relatively “cool” coals gives off a large amount of heat. The difference between the bed of coals
and the single spark has to do with both the temperature    and     the quantity of matter.

Identical thermometers in two pots of water on a hot stove
will show     different    temperatures even if the pots have been
on the stove for the same time if the    amount    of water in one
pot is different than the amount in the other. 
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SAFETY REMINDERS

•  Wear protective gear.

•  Follow directions for using the equipment.

•  Be sure that the heating resistor is in the water before you turn
on the power supply.

For You To Do

Use the Temperature Sensor to measure the temperature of 100 mL water as a heating resistor
heats it for a set amount of time. Then use the sensor to measure the temperature of 200 mL of
water as the same resistor heats it for the same amount of time. Both measurements start at the
same temperature.

Use DataStudio orScienceWorkshop to record and display the data. Compare the final
temperature of the 100 mL sample of water to the final temperature of the 200 mL sample of
water.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to
the computer, turn on the interface, and turn
on the computer.

2. Connect the DIN plug of the Temperature
Sensor into Analog Channel A on the
interface.

3. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS22 Heat v Temperature.DS G22 Heat v. Temperature G22_TEMP.SWS

•  The DataStudio document has a Workbook display. Read the instructions in the
Workbook.

•  The ScienceWorkshop document opens with a Graph display of Temperature versus Time,
a Digits display of Temperature, and a Table display of Temperature.

•  Data recording is set for 1 second per measurement, a ‘Start Condition’ = Channel A at
0.20 volts, and a ‘Stop Condition’ = Time at 600 seconds (or 10 minutes).
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PART II: Sensor Calibration and Equipment Setup

•  You do not need to calibrate the Temperature Sensor.

1. If you have a lid that will fit over the top of the cup, make one hole in the lid for the
Temperature Sensor, and a second hole in the lid for the heating resistor.

2. Put 100 mL of water in the foam cup.

•  NOTE: Start with water that is about two degrees below 20 ˚C. The program will begin
recording data when the water warms up to 20 ˚C.

3. Connect the banana plugs of the heating resistor into the output jacks of the power supply.

4. Put the heating resistor through its hole in the lid.
Submerge the resistor in the water.

5. Put the Temperature Sensor through its hole in the
lid of the cup.

•  CAUTION: Be sure the resistor is submerged in
water when the current is flowing through it.
Otherwise it can burn up!

PART III: Data Recording

1. Set the DC power supply to output 10 volts. The current through the resistor will be 1 amp.
Turn on the power supply.

2. Start recording data. (Click ‘Start’ in DataStudio or click ‘REC’ in ScienceWorkshop.)
Data recording     begins    when the temperature of the water reaches 20 ˚C.

•  Watch the Digits display to keep track of the temperature.

IMPORTANT: While the power supply is ON, gently swirl the water in the cup so the water will
be heated evenly.

3. Data recording stops automatically at ten minutes. When data recording stops, turn off the
DC power supply.

4. Remove the sensor and heating resistor from the cup. Pour out the 100 mL of warmed
water.

5. Put 200 mL of water into the cup. Use water that is about two degrees below 20 ˚C.

6. Put the sensor and heating resistor back into the cup.

7. Turn on the power supply.

8. Start the second measurement. Data recording     begins    when the temperature of the water
reaches 20 ˚C.

9. Watch the Digits display to keep track of the temperature.

• IMPORTANT: While the power supply is ON, gently swirl the water in the cup so the
water will be heated evenly.

10. Data recording stops automatically at ten minutes. When data recording stops, turn off the
DC power supply.

11. Remove the sensor and heating resistor from the cup. Pour out the 200 mL of warmed
water.
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Analyzing the Data

1. Set up the Graph to show statistics such as Minimum and Maximum.

•  Hint: In DataStudio, click ‘Statistics’ ( ) in the Graph toolbar. In ScienceWorkshop,
click the ‘Statistics’ button to open the Statistics area on the right side of the Graph. Then
click the ‘Statistics Menu’ button.

2. Set up the Table to show statistics such as Minimum and Maximum

3. Record the Minimum and Maximum temperatures for the first run of data.

4. Record the Minimum and Maximum temperatures for the second run of data.

5. Record the amount of water used for each run.

6. Find the change in temperature for each run and record it.

Record your results in the Lab Report section.

--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the ‘File’ menu to save your data for this
activity and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Lab Report - Activity GS22: Heat vs. Temperature

What Do You Think?

What is the relationship between heat, thermal energy, and temperature?

Data Table

Item Run #1 Run #2

Amount of Water mL mL

Temperature (maximum) ˚C ˚C

Temperature (minimum) ˚C ˚C

Change in Temperature ( ∆T) ˚C ˚C

Questions

1. What is the change in temperature for the 100 mL of water in Run #1?

2. What is the change in temperature for the 200 mL of water in Run #2?

3. How does the change in temperature for Run #1 compare to the change in temperature for
Run #2?

4. Did the 100 mL of water receive the same, more than, or less thermal energy than the 200
ml of water? Why?

5. Why is the final temperature for the 200 mL of water different than the final temperature
for the 100 mL of water?



General Science Labs with Computers   Student Workbook
GS22: Heat vs. Temperature 012-06654B

p. 180 ©1999 PASCO scientific GS22



Name _____________________ Class ______________ Date _________

GS23 ©1999 PASCO scientific p. 181

Activity GS23: Heat Transfer
(Temperature Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Energy GS23 Heat Transfer.DS G23 Heat Transfer G23_HEAT.SWS

Equipment Needed Qty Equipment Needed Qty
Temperature Sensor (CI-6505A) 2 Thermal insulation pads 2
Aluminum can, black (TD-8570A) 1 Tongs (for handling cans with hot water) 1
Aluminum can, plain (TD-8570A) 1 Protective gear PS
Fan (optional) 1 Consumables Qty
Heat lamp (optional) 1 Water, hot (90˚C) 800 mL

What Do You Think?

Parts of robot spacecraft are painted black while other parts are left unpainted. Part of the reason
is that unpainted sections of the spacecraft hull absorb energy more slowly than sections that are
painted black. Do you think the reverse is possible, will an unpainted aluminum can emit energy
faster or slower than a black colored aluminum can?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Heat is energy in transit. Heat transfer happens when two
objects are at different temperatures.

Heat is transferred in three ways: conduction, convection,
and radiation . When an aluminum can full of hot water sits
in a room, the water loses heat by conduction through the
aluminum sides (by direct contact with cooler molecules), by
convection as air molecules collide with the aluminum, and
by radiation as electromagnetic waves are emitted from the
can’s surface.
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SAFETY REMINDERS

•  Wear protective gear.

•  Follow directions for using the equipment.

•  Wear gloves and use tongs when handling the cans with hot
water in them.

For You To Do

In this activity, put hot water into two aluminum cans, one unpainted and the other painted black.
Use the Temperature Sensors to measure the temperature of the water in each can as it cools. Use
DataStudio or ScienceWorkshop to record and display the temperatures for each can.

Examine the plot of temperature versus time to find can transfers heat fastest.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the
computer, turn on the interface, and turn on
the computer.

2. Connect one Temperature Sensor to Analog
Channel A. Connect the second Temperature
Sensor to Analog Channel B on the interface
box.

3. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS23 Heat Transfer.DS G23 Heat Transfer G23_HEAT.SWS

•  The DataStudio document has a Workbook display. Read the instructions in the
Workbook.

•  The ScienceWorkshop document opens with a Graph display showing plots of Temperature
vs. Time for each Temperature Sensor. .

•  Data recording is set for one measurement each 10 seconds and a ‘Stop Condition’ = Time
at 900 seconds (15 minutes).
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PART II: Sensor Calibration and Equipment Setup

•  You do not need to calibrate the Temperature Sensors.

1. Prepare the two aluminum cans
(one unpainted and one painted
black). Heat approximately 800
milliliters of water to 90˚ C, but
don’t fill the cans with water yet.
Place each can on an insulated pad.
Keep the cans away from drafts.

2. Fill each can to the same level with
hot (90 C) water (approximately
200 ml). Put Temperature Sensor A
into the unpainted can and
Temperature Sensor B into the black can.

PART III: Data Recording

1. When you are ready, start recording data. Data points will begin to appear in the graph
every 10 seconds.

2. Swirl the water in the cans continuously for 15 minutes. Data collecting will stop
automatically at 15 minutes.

Analyzing the Data

1. Set up your Graph to show statistics

•  Hint: In DataStudio, click ‘Statistics’ ( ) in the Graph toolbar. In ScienceWorkshop,
click the Statistics button to open the Statistics area on the right side of the Graph. Then
click the Statistics Menu button.

2. Record the maximum y value as the Maximum temperature. Record the minimum y value
as the Minimum temperature.

Record your results in the Lab Report section.

--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the ‘File’ menu to save your data for this
activity and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Lab Report – Activity GS23: Heat Transfer

What Do You Think?

Parts of robot spacecraft are painted black while other parts are left unpainted. Part of the reason
is that unpainted sections of the spacecraft hull absorb energy more slowly than sections that are
painted black. Do you think the reverse is possible, will an unpainted aluminum can emit energy
faster or slower than a black colored aluminum can?

Data Table

Can Maximum temperature Minimum temperature

Unpainted ˚C ˚C

Black ˚C ˚C

Questions

1. Which can cooled down faster?

2. When the cans are cooling, which processes transfer heat? Which process do you think is
dominant?

3. When a can is cooling, does it cool faster at the beginning of the experiment or toward the
end of the experiment? Why?
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Optional: Save Your Data

NOTE: You may want to save the original experiment and data before beginning the optional activities.

Optional: Cooling With A Fan

Repeat the experiment but put a fan next to the cans so the air blows equally on each of the cans.
Turn on the fan and begin recording data.

Optional: Heating With A Lamp

Fill the cans with room temperature water. Put the Temperature Sensors in each can as before.
Place a heat lamp near the cans so that the cans are equally illuminated. Turn on the lamp and
begin recording data.

Optional Questions

1. How much faster does each can cool when the fan is on? (To compare the cooling times,
find out how much time it took for each can to cool from about 85 ˚C to 80 ˚C with and
without the fan. Divide the cooling time without the fan by the cooling time with the fan
for each can.)

2. When the can is cooling with the fan, what processes transfer heat? Which process is
dominant?

3. Which can heated faster?

4. When the can is being heated with a lamp, which processes transfer heat? Which process is
dominant?
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Activity GS24: Pressure vs. Temperature
(Pressure Sensor, Temperature Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Gas laws GS24 Pres and Temp.DS G24 Pressure & Temp G24_PAT.SWS

Equipment Needed Qty Equipment Needed Qty
Pressure Sensor (CI-6532A) 1 Tongs 1
Temperature Sensor (CI-6505A) 1 Tubing, plastic (w/sensor) 1
Beaker, 1 L 1 Turkey baster 1
Connector, rubber stopper (w/sensor) 1 Protective gear PS
Coupling, quick-release (w/sensor) 1 Other Qty
Flask, Erlenmeyer, 125 mL 1 Glycerin 1 mL
Hot plate (for hot water bath) 1 Ice, crushed 1 L
Rubber stopper, one-hole 1 Water 3 L

What Do You Think?

What is the relationship between the pressure of a gas and the temperature of a gas if its volume
remains constant as the temperature changes?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Solid, liquid and gas are the most common
states of matter found on this planet. The only
difference among all these states is the
amount of movement of the particles that
make up the substance.

Temperature is a measure of the relative
movement of particles in a substance because
temperature is a measure of the average
kinetic energy of the particles. In a gas at
high temperature, the molecules of gas move
around very fast. In a gas at lower
temperature, the molecules do not move as
rapidly.

Pressure is a ratio of the force applied to a
surface divided by the area of the surface.

The pressure from our atmosphere is about
100,000 newtons per square meter (14.7
pounds per square inch). This is because the
weight of air above a one square meter surface is 100,000 newtons (or about 10 tons).

For a gas in a container, molecules collide with the inside surface of the container. Each colliding
molecule exerts force against the surface.



General Science Labs with Computers   Student Workbook
GS24: Pressure vs. Temperature 012-06654B

p. 188 © 1999 PASCO scientific GS24

If the molecules in a high temperature gas move fast, they have more speed (on average) when
they collide with the inside surface of the container. Molecules in a lower temperature gas have
less speed when they collide. The force exerted by the high-speed colliding molecules is greater
than the force exerted by the low-speed molecules.

A pressure gauge on a container of hot gas will measure a different pressure than a gauge on a
container of cooler gas, assuming that the volume of gas is the same in both containers.

SAFETY REMINDERS

•  Wear protective gear.

•  Follow directions for using the equipment.

•  Be very careful when you heat water.

For You To Do

Start Heating the Water Bath

• Put about 600 mL of water into a large beaker and put the beaker on a hot plate. Start to heat
the water to almost boiling. Check the water bath occasionally as you set up the rest of the
equipment.

Use the Pressure Sensor to measure the pressure inside a flask and use the Temperature Sensor to
measure the temperature of the water bath in which the flask is immersed. Use DataStudio or
ScienceWorkshop to plot the pressure and temperature data onto a graph. Use the graph to
determine the relationship of pressure and temperature.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer,
turn on the interface, and turn on the computer.

2. Connect the DIN plug of the Temperature Sensor to Analog
Channel A on the interface. Connect the DIN plug of the
Pressure Sensor to Analog Channel B on the interface.

3. Open the file titled as shown;

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS24 Pres and Temp.DS G24 Pressure & Temp G24_PAT.SWS

• The file has displays of the gas pressure and the temperature of the water bath.

• The DataStudio file also has a Workbook display. Read the instructions in the Workbook.

• Data recording is set at one measurement every 10 seconds.
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PART II: Sensor Calibration and Equipment Setup

You do not need to calibrate the sensors.

Set Up the Equipment

• For this part you will need the following: glycerin, quick-release coupling, connector,
plastic tubing, rubber stopper, flask, and Pressure Sensor

1. Put a drop of glycerin on the barb end of a
quick release coupling. Put the end of the
quick release coupling into one end of a
piece of plastic tubing (about 15 cm) that
comes with the Pressure Sensor.

2. Put a drop of glycerin on the barb end of the connector. Push the barb
end of the connector into the other end of the plastic tubing.

3. Fit the end of the connector into the one-hole rubber stopper.

4. Push the rubber stopper firmly into the flask.

5. Align the quick-release coupling on the end of the plastic tubing with
the pressure port of the Pressure Sensor. Push the coupling onto the
port, and then turn the coupling clockwise until it clicks (about one-
eighth turn).

CONNECTOR
(640-030)

RUBBER
STOPPER

Plastic TubingQuick-release
Coupling

Connector
(640-030)

Pressure
Sensor
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PART III: Data Recording

1. Carefully remove the beaker from the hot plate. Turn off the hot plate.

2. Put the flask into the beaker of hot water. Use
tongs to hold the flask down in the water.

3. Put the Temperature Sensor into the hot water.

4. When you are ready, record pressure and
temperature measurements.

• (Hint: Click ‘Start’ in DataStudio or ‘REC’ in
ScienceWorkshop.)

5. Watch the Digits display to check the pressure
and temperature.

6. Add ice to the hot water to lower the
temperature.

7. As the ice melts, add more to the water. Use the
turkey baster to remove extra water so the level in the container stays about the same.

8. Continue to add ice to the water until the temperature reaches about 20˚ C, and then stop
recording data.

Analyzing the Data

1. Use the Graph display to determine whether or not the relationship of
pressure and temperature is linear.

• In DataStduio, click ‘Fit’ and select ‘Linear’ from the menu. In
ScienceWorkshop, click ‘Statistics’ and select ‘Curve Fit, Linear Fit’
from the ‘Statistics Menu’.

• If the relationship is linear, the data will fit a straight line closely. In DataStudio, if the
coefficient ‘r’ (coefficient of linear regression) is close to 1, the relationship is linear. In
ScienceWorkshop, if the chi^2 value is close to zero, the relationship is linear.

2. Use the Graph display’s built-in statistics to find the minimum and maximum temperature
and the minimum and maximum pressure.

3. Use your observations and data to answer the questions in the Lab Report.

Record your results in the Lab Report section.

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this activity.
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.

Pressure
Sensor
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Lab Report - Activity GS24: Pressure versus Temperature

What do you think?

What is the relationship between the pressure of a gas and the temperature of a gas if its volume
remains constant as the temperature changes?

Data Table

minumum maximum

Temperature   ˚C ˚C

Pressure kPa kPa

Questions

1. What happens to the pressure as the temperature drops?

2. Based on the Graph of Pressure vs. Temperature, what is the relationship between the
pressure of a gas and the temperature of a gas that has a constant volume?

3. If a gas is inside a closed container and the temperature of the gas increases, what do you
predict will happen to the pressure of the gas?
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Activity GS25: Endothermic and Exothermic Reactions
(Temperature Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Chemistry GS25 Endo and Exo React.DS G25 Endo-Exo Reactions G25_ENDO.SWS

Equipment Needed Qty Chemicals and Consumables Qty
Temperature Sensor (CI-6505A) 1 Citric acid (H3C6H5O7), 1.5 Molar 30 mL

Balance (SE-8723) 1 Hydrochloric acid (HCl), 0.5 Molar 30 mL
Beaker, 250 mL 1 Baking soda (NaHCO3) 10.0 g

Graduated cylinder, 50 mL 1 Magnesium ribbon (Mg) 20.0 cm
Protective gear PS Styrofoam cup 1

Weighing paper 1

What Do You Think?

Many familiar chemical reactions involve the release of energy, such as combustion. Are there
any chemical reactions that involve the absorption of energy?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Many chemical reactions give off energy. Chemical reactions that release
energy are called exothermic reactions. These reactions often require a small
amount of energy to get started.

Some chemical reactions absorb energy and are called endothermic reactions.
The first-aid device called a ‘cold pack’ uses a type of endothermic reaction.
Ammonium nitrate mixes with water when the inner seal inside the cold pack is
broken. As the ammonium nitrate dissolves, a chemical reaction takes place and the temperature
of anything in contact with the pack – such as a sprained ankle – goes down.

You will study one exothermic and one endothermic reaction in this activity.

First, you will study the reaction between citric acid solution and baking soda. An equation for
the reaction is:

H3C6H5O7(aq) + 3 NaHCO3(s) ---> 3 CO2(g) + 3 H2O(l) + Na3C6H5O7(aq)

Next, you will study the reaction between magnesium metal and hydrochloric acid. An equation
for this reaction is:

Mg(s) + 2 HCl(aq)---> H2(g) + Mg Cl2 (aq)

SAFETY REMINDERS

•  Wear protective gear while handling chemicals.

•  Follow directions for using the equipment.

•  Dispose of all chemicals and solutions properly.

For You To Do

Use the Temperature Sensor to measure the change in temperature of a chemical reaction that
releases energy. Then measure the change in temperature of a chemical reaction that absorbs
energy. Use DataStudio or ScienceWorkshop to record and analyze the data.
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PART I: Computer Setup

1. Connect the ScienceWorkshop interface
to the computer, turn on the interface,
and turn on the computer.

2. Connect the Temperature sensor’s DIN
plug into Analog Channel A on the
interface.

3. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS25 Endo and Exo React.DS G25 Endo-Exo Reactions G25_ENDO.SWS

•  The DataStudio file has a Workbook display. Read the instructions in the Workbook.

•  The ScienceWorkshop document has a Graph display of Temperature versus Time.

• Data recording is set for one measurement per second. Data recording stops automatically
at 250 seconds (about 4 minutes).

PART II: Sensor Calibration and Equipment Setup

You do not need to calibrate the sensor.

1. Place a Styrofoam cup into the 250 mL beaker as shown in the diagram. Put 30 mL of 1.5
Molar citric acid into the cup. Place the Temperature Sensor into the citric acid solution.

2. Weigh out 10.0 g of solid baking soda on a piece of weighing paper.
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PART IIIA: Data Recording - Reacting Citric Acid and Baking Soda

1. Get ready to record data. The Temperature Sensor must be in the citric acid solution for a
few seconds before you begin recording data.

2. When everything is ready, start recording data.

3. After about 20 seconds, add the baking soda to the citric acid solution.

4. Gently stir the solution with the Temperature Sensor to ensure good mixing.

5. Record data until a minimum temperature has been reached and temperature readings
begin to increase or let the computer automatically end it after 250 seconds.

6. Dispose of the reaction products as directed by your teacher. Rinse the cup.

PART IIIB: Data Recording - Reacting Magnesium and Hydrochloric Acid

1. Measure out 30 mL of HCl solution into the Styrofoam cup. Place the Temperature Sensor
into the HCl solution.

2. Obtain a 20.0 cm piece of shiny magnesium metal from the teacher.

3. Get ready to record data. Note: The Temperature Sensor must be in the HCl solution for a
few seconds before you begin recording data.

4. When everything is ready, begin data recording.

5. After about 20 seconds, add the magnesium ribbon to the acid solution.

6. Gently stir the solution with the Temperature Sensor to ensure good mixing.

7. Record data until a maximum temperature has been reached and temperature readings
begin to decrease or let the computer automatically end it after 250 seconds.

8. Dispose of the reaction products as directed by your teacher. Rinse the cup.

---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘Fil’e menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Analyzing the Data

1. Set up your Table display so it shows both runs of data (that is, Run #1 for Citric Acid and
Baking Soda and Run #2 for Magnesium and Hydrochloric Acid).

•  Use the Table’s analysis tools to find the minimum and maximum values for temperature
for Run #1. Hint: Look at the graph to determine if the minimum or maximum occurred
first. Record the initial temperature. Record the other as the final temperature.

2. Find the minimum and maximum values for temperature for Run #2. Look at the graph to
determine if the minimum or maximum occurred first. Record this value as the initial
temperature in the Data Table. Record the other as the final temperature.

3. Calculate the temperature change for each reaction by subtracting the initial temperature
from the final temperature.

Record your results in the Lab Report section.
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Lab Report - Activity GS25: Endothermic and Exothermic Reactions

What Do You Think?

Many familiar chemical reactions involve the release of energy, such as combustion. Are there
any chemical reactions that involve the absorption of energy?

Data Table

Run #1: Citric Acid - Baking Soda Run #2: Hydrochloric Acid - Magnesium

Final temperature (°C)

Initial temperature (°C)

Temperature change (°C)

Questions

1. Which reaction had a negative temperature change (∆T)? Is the reaction endothermic or
exothermic? Explain.

2. For each reaction, describe three ways you could tell a chemical reaction was taking place.

3. Which reaction took place at a greater rate? Explain your answer.
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Activity GS26: Freezing and Melting of Water
(Temperature Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Phase change GS26 Freeze Melt Water.DS G26 Freeze & Melt Water G26_MELT.SWS

Equipment Needed Qty Chemicals and Consumables Qty
Temperature Sensor (CI-6505A) 1 Ice, cube 12 - 15
Base and Support Rod (ME-9355) 1 Salt 40 mL
Beaker, 500 mL 1 Water 500 mL
Clamp, Buret (SE-9446) 1
Clock 1
Graduated cylinder, 100 mL 1
Slit stopper 1
Stirring rod 1
Test tube 1
Protective gear PS

What Do You Think?

How does the freezing temperature of water compare to the melting temperature of ice? Are they
the same or not?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

When a substance changes from solid to liquid or vice versa,
or from liquid to gaseous or vice versa, the substance goes
through a phase change. Freezing temperature is the
temperature at which a substance turns from liquid to solid.
For example, the temperature at which liquid water turns into
solid ice is the freezing temperature of water.

Melting temperature is the temperature at which a
substance turns from a solid to a liquid. For example, the
temperature at which solid ice turns into liquid water is the melting temperature of ice.

These temperatures are characteristic physical properties of a substance

SAFETY REMINDERS

•  Wear protective gear while handling chemicals.

•  Follow directions for using the equipment.

•  Dispose of all chemicals and solutions properly.

For You To Do

Use the Temperature Sensor to measure the change in temperature of a sample of water as it
freezes in an ice water bath. Then measure the change in temperature as the frozen water melts
after being removed from the water bath. Use DataStudio or ScienceWorkshop to record and
analyze the data.
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PART I: Computer Setup

1. Connect the ScienceWorkshop interface to
the computer, turn on the interface, and turn
on the computer.

2. Connect the DIN plug of the Temperature
Sensor into Analog Channel A of the
interface.

3. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS26 Freeze Melt Water.DS G26 Freeze & Melt Water G26_MELT.SWS

• The DataStudio file has a Workbook display. Read the instructions in the Workbook.

• The ScienceWorkshop file has a Digits display, a Graph display, and a Table display of
Temperature versus Time.

• Data recording is set for one measurement per 30 seconds. Data recording stops
automatically at 1800 seconds (30 minutes).
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PART II: Sensor Calibration and Equipment Setup

You do not need to calibrate the sensor.

1. Set up the equipment as shown. Put about 100 mL of water and 5 or 6 ice cubes into a 500-
mL beaker.

2. Put 5 mL of water into a test tube. Set up the test tube so it is above the ice water bath at the
beginning.

3. Place the Temperature Sensor into a slit stopper and place the stopper in the test tube so the
end of the sensor is in the water inside the test tube.

PART IIIA: Data Recording for Freezing

1. When everything is ready, start recording data. Then lower the test tube into the ice-water
bath. (The computer will record data for a total of 30 minutes.)

2. Soon after lowering the test tube, begin to add salt to the beaker while stirring with a
stirring rod. Add salt until the temperature goes down to about –5 ˚C.

Note: Continue to stir the ice-water bath during this part of the procedure.

3. Gently but continuously move the sensor during the first 10 minutes of this part.

Be careful to keep the sensor in, and not above, the ice as it forms.

4. When 10 minutes have gone by, stop moving the sensor and allow it to freeze into the ice.

Observe how the ice forms in the test tube as the water freezes.

Add more ice cubes to the beaker as the original ice cubes get smaller.

5. Continue recording data until the data recording stops automatically at 30 minutes.

6. Keep the test tube submerged in the ice-water bath for now.

Temperature
Sensor

Clamp
Slit stopper

Test Tube

Beaker

Ice Cubes
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PART IIIB: Data Recording for Melting

1. Get ready for a second run of data recording.

2. Start recording data. Then raise the test tube and fasten it into position above the edge of
the beaker.

3. Do not move the sensor during this part of the procedure. (Let it stay in the ice.)

4. Dispose of the ice water in the beaker as directed.

5. Put about 250 mL of warm water in the beaker and get ready to place the beaker under the
test tube. When 10 minutes have passed, lower the test tube and its contents into this
warm-water bath.

6. When 15 minutes have passed, stop the data recording.

Analyzing the Data

1. Set up your Table display so it shows both runs of data (that is, Run #1 for freezing and
Run #2 for melting).

Hint: Drag data runs to the Table display in DataStudio  to add data runs to the Table. Use the ‘Add
Column’ menu in ScienceWorkshop  to add data runs to the Table.

2. Set up your Graph display so it shows both runs of data.

(If desired, rescale the Graph to fit the data.)

Record your results in the Lab Report section.

---------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘Fil’e menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this activity.
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Lab Report - Activity GS26: Freezing and Melting of Water

What Do You Think?

How does the freezing temperature of water compare to the melting temperature of ice? Are they
the same or not?

Questions

1. What happened to the water temperature during freezing? What happened to the water
temperature during melting?

2. According to your data and graph, what is the freezing temperature of water?

Hint: Use the Smart Tool in DataStudio or the Smart Cursor in ScienceWorkshop  in order to determine
the coordinates at any particular point.) What seems to be the melting temperature? Express your
answers to the nearest 0.1 C.

3. How does the freezing temperature of water compare to its melting temperature?

4. What happens to the kinetic energy of the water in the test tube during each of the
following parts of the activity? (Does it increase, decrease, or remain the same?)

a. when temperature changes at the beginning and end of Part IIIA

b. when temperature remains constant in Part IIIA

c. when temperature changes at the beginning and end of Part IIIB

d. when temperature remains constant in Part IIIB
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Activity GS27: Chemical Equilibrium
(Pressure Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Rate of reactions C18 Equilibrium.DS C19 Chemical Equilibrium C19_CHEM.SWS

Equipment Needed Qty Equipment Needed Qty
Pressure Sensor (CI-6532A) 1 Tubing (w/sensor) 1
Connector, rubber stopper (w/sensor) 1 Protective gear PS
Coupling, quick release (w/sensor) 1 Chemicals and Consumables Qty
Flask, 250 mL 1 Glycerin 1 mL
Graduated cylinder 1 Soda water, cold 100 mL
Rubber stopper, one-hole 1 Soda water, warm 100 mL

What Do You Think?

The purpose of this activity is to find out if a system in chemical equilibrium is sensitive to
temperature. For example, will    cold     soda water or      warm      soda water reach chemical equilibrium
faster?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

The process of chemical equilibrium is dynamic. The term dynamic means
that even though no macroscopic chemical changes are noticeable,
microscopic chemical changes are occurring constantly.

In any chemical reaction, the substances that react (called the reactants)
combine with each other to form products. A general reaction could be
written:

A  +  B   ======>   C

The equation states that “chemical A reacts with chemical B at a set rate to produce C”. This is a
kinetic reaction which proceeds in only one direction. This is not a system in equilibrium.

Suppose that chemical C breaks down at certain rate to reform chemicals A and B. This is also a
reaction in only one direction so the system is not in equilibrium.

C  ======> B + A

When the two reactions are combined and the rate of the forward reaction equals the rate of the
reverse reaction the two opposing reactions are said to be at equilibrium.

A +  B <=======> C

Carbonic acid decomposes to form carbon dioxide and water in the following equilibrium
system:

H2CO3(aq) <=======> CO2(g)  +  H2O(aq)

carbonic acid     carbon dioxide   water

The carbon dioxide then reacts with water to reform carbonic acid. The forward reaction occurs
every time you open a soda bottle or pour soda into a glass. The carbonic acid decomposes to
form the ‘fizz’ that we associate with most soft drinks.



General Science Labs with Computers   Student Workbook
GS27: Chemical Equilibrium 012-06654B

p. 206 © 1999 PASCO scientific GS27

When you cap the bottle, the carbon dioxide gas begins to re-dissolve in the soda water to reform
carbonic acid. If the reverse reaction (called reformation ) also takes place inside a closed
container, the pressure inside the container will stop increasing. The reactions still occur at the
microscopic level but there is no evidence of any macroscopic change. You will know when the
carbonic acid/carbon dioxide system has reached equilibrium when there is no further change in
the pressure in the soda bottle.

SAFETY REMINDERS

•  Wear protective gear.

•  Follow directions for using the equipment.

•  Handle and dispose of all chemicals and solutions properly.

For You To Do

Use the Pressure Sensor to measure the change in pressure inside a rigid container as a small
amount of soda water decomposes. Use DataStudio or ScienceWorkshop to record and display
the data. Compare the data collected for cold soda water to the data collected for warm soda
water.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn
on the interface, and turn on the computer.

2. Connect the Pressure Sensor’s DIN plug into Analog Channel
A on the interface.

3. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
C18 Equilibrium.DS C19 Chemical Equilibrium C19_CHEM.SWS

• The DataStudio file has a Graph display of pressure versus time. Read the instructions in
the Workbook display.

• The ScienceWorkshop document has a Graph display of pressure versus time.

• Data recording is set for one measurement per second.
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PART II: Sensor Calibration and Equipment Setup

You do not need to calibrate the sensor.

Set Up the Equipment

• For this part you will need the following: glycerin, quick-release coupling, connector,
plastic tubing, rubber stopper, flask, graduated cylinder, and warm (room temperature)
soda water.

1. Put a drop of glycerin on the barb end of a
quick release coupling. Put the end of the
quick release coupling into one end of a
piece of plastic tubing (about 15 cm) that
comes with the Pressure Sensor.

2. Put a drop of glycerin on the barb end of
the connector. Push the barb end of the connector into the other end
of the plastic tubing.

3. Fit the end of the connector into the one-hole rubber stopper.

4. Put 100 mL of warm (room temperature) soda water in the flask.
CONNECTOR

(640-030)

RUBBER
STOPPER

Plastic TubingQuick-release
Coupling

Connector
(640-030)



General Science Labs with Computers   Student Workbook
GS27: Chemical Equilibrium 012-06654B

p. 208 © 1999 PASCO scientific GS27

PART IIIA: Data Recording – Warm Soda Water

1. Put the rubber stopper firmly into the top of the flask.

2. Align the quick-release coupling on the end of the plastic tubing with the pressure port of
the Pressure Sensor. Push the coupling onto the port, and then turn the coupling clockwise
until it clicks (about one-eighth turn).

3. When everything is ready, begin data recording. (Hint: Click ‘Start’ in DataStudio or
‘REC’ in ScienceWorkshop.)

What do you predict the graph of pressure versus time will look like?

• Observe the change in pressure as the carbonic acid decomposes in the flask.

4. Continue collecting data for about 6 minutes and then stop recording data.

5. Slowly remove the rubber stopper from the bottle. Disconnect the quick-release coupling
from the Pressure Sensor.

6. Dispose of the soda water. Rinse the flask with cold water.

PART IIIB: Data Recording – Cold Soda Water

1. Put 100 mL of cold soda water in the flask. Put the rubber stopper firmly into the top of the
flask.

2. Align the quick-release coupling on the end of the plastic tubing with the pressure port of
the Pressure Sensor. Push the coupling onto the port, and then turn the coupling clockwise
until it clicks (about one-eighth turn).

3. When everything is ready, begin data recording.

How will the graph of the cold soda water differ from the graph of the room temperature soda water?

4. Continue collecting data for about 6 minutes and then stop recording data.

5. Slowly remove the rubber stopper from the bottle. Disconnect the quick-release coupling
from the Pressure Sensor.

6. Dispose of the soda water. Rinse the flask.
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Analyzing the Data

1. Use the built-in statistics tools in the Graph display to find the minimum and maximum
values for pressure for each run of data.

• Hint: In DataStudio, click the ‘Statistics menu’ button ( ) in the display toolbar. The
legend in the Graph display will show the minimum and maximum pressure.

• Hint: In ScienceWorkshop, click the ‘Statistics’ button ( ) to open the statistics area.

Click the ‘Statistics menu’ button ( ) in the statistics area and select Minimum and
Maximum from the menu.

2. Record the values in the Lab Report section.

3. Use the built-in analysis tools in the Graph display to find the slope of the pressure versus
time.

• Hint: In DataStudio, use the cursor to select a region of the plot of pressure. Click the ‘Fit

menu’ button ( ) in the display toolbar and select ‘Linear’ from the menu.

• Hint: In ScienceWorkshop, use the cursor to select a region of the plot of pressure. Click the
‘Statistics menu’ button in the statistics area and select ‘Curve Fit, Linear Fit’ from the
menu.

4. Record the slope of each run of data as the rate of decomposition.

Record your results in the Lab Report section.



General Science Labs with Computers   Student Workbook
GS27: Chemical Equilibrium 012-06654B

p. 210 © 1999 PASCO scientific GS27

Ending the Activity

Equipment Clean Up

• Check with your instructor about cleaning and putting away the equipment for this activity.

• Check with your instructor about disposing of the chemicals that you used in the activity.
DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘Fil’e menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this activity.
the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Lab Report - Activity GS27: Chemical Equilibrium

What Do You Think?

The purpose of this activity is to find out if a system in chemical equilibrium is sensitive to
temperature. For example, will    cold     soda water or      warm      soda water reach chemical equilibrium
faster?

Data Table

Trial Pressure (maximum) Pressure (minimum) Slope

Warm soda water kPa kPa

Cold soda water kPa kPa

Questions

1. Is there a difference in the rate to reach equilibrium?

2. What is the relationship of temperature to the rate to reach equilibrium?

3. Explain what is happening on a molecular level.
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Activity GS28: Light Intensity vs. Distance
(Light Sensor, Motion Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Optics GS28 Light vs Distance.DS G28 Light vs. Distance G28_LTVD.SWS

Equipment Needed Qty Equipment Needed Qty
Light Sensor (CI-6504A) 1 Dynamics Cart (inc. w/ Track) 1
Motion Sensor (CI-6742) 1 Reflector (e.g., index card) 1
Base and Support Rod (ME-9355) 1 Tape 1 roll
Basic Optics Light Source (OS-8517) 1 1.2 m Track System (ME-9429A) 1

What Do You Think?

What is the relationship between light intensity and the distance from a light source?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

The light from a point light source spreads out uniformly in all
directions.

The light intensity is a measure of how much light energy covers a
certain amount of area.

The intensity at a given distance r from the light will be equal to the
power output (amount of energy per second) of the light divided by
the surface area of the sphere through which the light has spread.

Since the area of the sphere varies as the square of its radius, r , the
intensity should vary as 1/r2 (one divided by the distance squared).

I = 1
r 2

If light intensity and distance
have a     direct    relationship, their
formula might be y = ax, where
a is a constant. If light intensity
and distance have an    inverse    
relationship, their formula
might be xy = b, where b is a
constant. If light intensity and
distance have an    inverse square   
relationship, their formula
might be x2y = c, where c is a
constant.

Light
Bulb

1 unit of area
1 unit of light

4 units of area
1/4 unit of light

9 units of area
1/9 unit of light

16 units of area
1/16 unit of light
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Here are three examples:

Direct Relationship Inverse Relationship

Inverse Square Relationship

SAFETY REMINDER

• Follow directions for using the equipment.

For You To Do

Use the Light Sensor to measure the intensity of light as a light source moves slowly away from
the Light Sensor. Use the Motion Sensor will measure the position of the light source as it
moves.

Use DataStudio or ScienceWorkshop to record and display the light intensity versus the position.
Use the graph of light intensity vs. position to find out what kind of relationship light intensity
has to distance: direct, inverse, or inverse square.
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PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the
computer, turn on the interface and then turn on the
computer.

2. Connect the Motion Sensor stereo phone plugs to
Digital Channels 1 and 2 on the interface. Put the
yellow-banded phone plug into Digital Channel 1.
Put the other phone plug into Digital Channel 2.

3. Connect the Light Sensor’s DIN plug into Analog
Channel A on the interface.

4. Open the file titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS28 Light vs Distance.DS G28 Light vs. Distance G28_LTVD.SWS

• The document opens with a Graph display of light intensity (%) vs. position (m). The
DataStudio document also has a Workbook display. Read the instructions in the display.

PART II: Equipment Setup and Sensor Calibration

Equipment Setup

1. Set up the track. Place the track on a horizontal surface and level the track.

2. Set up the cart and Light Sensor.

• Tape a vertical reflector (such as an index card) onto the cart so the Motion Sensor’s signal
is able to reflect from the reflector.

• Put the Light Sensor in the accessory tray at one end of the cart. Use tape to secure the
sensor in place.

3. Set up the light source.

• Place the light source on its side at one end of the track.

• Arrange the light source so the ‘Point Source’ opening on one side of the light source is at
the same level as the port on the Light Sensor and points toward the sensor.

4. Set up the Motion Sensor. Use a support rod to position the Motion Sensor so it can
measure the motion of the cart as it moves down the track.

PASCOscientific

300Interface

ANALOG CHANNELS

Science
Workshop™

Interface

500

scientific

PASCO

Science W
orkshop™

DATA LO G G ING
INSTRUCTIO NS

Light
Source

Reflector



General Science Labs with Computers   Student Workbook
GS28: Light Intensity vs. Distance 012-06654B

p. 216 ©1999 PASCO scientific GS28

Sensor Calibration

1. Set the GAIN switch on the top of the Light Sensor to ‘1’.

2. Turn on the light source. Turn off the room lights.

3. In the Setup window, double-click the Light Sensor icon. Result: In DataStudio, the
‘Sensor Properties’ window opens. Click the ‘Calibrate’ tab. In ScienceWorkshop, the
‘Sensor Setup’ window opens.

• The current value of the voltage from the Light Sensor appears under ‘Current Reading’ (in
DataStudio) or next to ‘Cur Value’ (in ScienceWorkshp).

4. Prepare to calibrate. Put the port of the Light Sensor as close to the light source opening as
possible.

• If the voltage reading is under 4.9 volts, calibrate the software. In DataStudio, click the
‘Take Reading’ button under the ‘High Point’ column. In ScienceWorkshop, click the
‘Read’ button at the right end of the ‘High Value’ row.

• If the voltage reading is 4.9 volts or higher, slowly move the cart with the Light Sensor
away from the light source until the reading drops to 4.9 volts. Hold the cart at that
position while you make a mark on the track next to one end of the cart. Calibrate the
software. In DataStudio, click the ‘Take Reading’ button under the ‘High Point’ column.
In ScienceWorkshop, click the ‘Read’ button at the right end of the ‘High Value’ row.

5. Click ‘OK’ to return to the Experiment Setup window.
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PART III: Data Recording

• Put the Motion Sensor at least 15 cm from the starting position of the cart and aim the
sensor at the reflector on the cart.

1. When you are ready, start recording data. (Click ‘Start’ in DataStudio or ‘REC’ in
ScienceWorkshop).

2. Slowly and steadily pull the cart with the Light Sensor away from the light source. (Note:
Keep your hand out of the way so the pulses from the Motion Sensor to not reflect from it.)

3. Stop recording data when the cart reaches the end of the track.

• Run #1 will appear in the Data list in the Experiment Setup window.

4. Turn off the light source.

Analyzing the Data

1. Click the Graph to make it active.

2. Click the ‘Scale to Fit’ button in DataStudio or the ‘Autoscale’ button ( ) in
ScienceWorkshop to rescale the Grraph to fit the data.

Use your results to answer the questions in the Lab Report section.

--------------------------

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘File’ menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this activity
and the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.
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Lab Report - Activity GS28: Light Intensity vs. Distance

What Do You Think?

What is the relationship between light intensity and the distance from a light source?

Questions

1. Describe how your Graph looks:

2. Based on your Graph, what is the relationship between light intensity and distance: direct,
inverse, or inverse square?
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Activity GS29: Induction – Magnet through a Coil
(Voltage Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Electromagnetism GS29 Induction.DS G29 Induction - Magnet G29_INDU.SWS

Equipment Needed Qty
Voltage Sensor (CI-6503) 1
Coil 1
Bar magnet, alnico (EM-8620) 2

(*such as on the AC/DC Electronics Lab (EM-8656) board, or the Basic Electricity Board (EM-
8622) or the Coils and Core Set (SF-8616)

What Do You Think?

The purpose of this activity is to measure the voltage created in a coil by a magnet dropping
through the center of the coil. Will the voltage be different if the magnet falls faster through the
same coil?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Connect a coil of wire to a sensitive meter that can measure tiny
amounts of electric current. Set the coil so you can move a bar
magnet back and forth through the center of the coil. When the bar
magnet moves through the coil, the sensitive meter will show that a
current is flowing through the coil. The current flows through the
wire of the coil because the magnet caused (induced) a voltage.

The amount of voltage depends on how many turns of wire are in the
coil, and the rate at which the magnet is moved back-and-forth
through the coil of wire. In other words, the more turns of wire in the
coil, the more voltage it puts out. The faster the magnet moves
through the coil, the more voltage the coil puts out.

The direction of the voltage (positive or negative) depends on which
end of the magnet (called the magnetic pole) is going through the coil of wire, and in which
direction. A bar magnet has both a north magnetic pole and a south magnetic pole. If the bar
magnet falls through the coil of wire, the voltage will be positive when one end of the bar
magnet moves through the coil, and negative when the other end of the bar magnet moves
through the pole.

Both ends of a magnet usually have the same magnetic strength. If you put the north end of the
magnet into the coil, it should create the same voltage as when you put the south end of the
magnet into the coil, assuming that you put both ends into the coil with the same speed. If one
end of the magnet moves faster, it produces more voltage. However, because the magnet moves
faster, the amount of time that it is in the coil is shorter.

The amount of voltage multiplied by the amount of time that the voltage lasts is called the flux .
If a magnet moves slowly, the voltage is low, but the amount of time is longer. If the magnet
moves quickly, the voltage is  higher, but the amount of time is shorter.

Theoretically, the amount of flux produced by a magnet moving slowly is the same as the
amount of flux produced by the same magnet when it moves quickly.
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SAFETY REMINDERS

•  Follow directions for using the equipment.

For You To Do

Use the Voltage Sensor to measure the voltage induced in the coil by a magnet as the magnet
falls through the coil. Use DataStudio or ScienceWorkshop to record and display the induced
voltage. Use the plot of voltage versus time to find out whether the flux created by one end of the
magnet is the same as the flux created by the other end of the magnet.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on
the interface, and turn on the computer.

2. Connect the Voltage Sensor DIN plug into Analog Channel A.

3. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS29 Induction.DS G29 Induction - Magnet G29_INDU.SWS

•  The DataStudio document has a Workbook display. Read the instructions in the
Workbook.

•  The ScienceWorkshop document opens with a Graph display of Voltage vs. Time and a
Meter display of Voltage.

4. Data recording is set at 200 Hz (200 measurements per second), ‘Start Condition’ =
Channel A = 0.05 V, and ‘Stop Condition’ = Time at 0.5 seconds.
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PART II: Sensor Calibration and Equipment Setup

• You do not need to calibrate the Voltage Sensor.

1. Put alligator clips on the ends of the voltage sensor leads.

2. Attach a voltage sensor lead to one component spring next to the inductor coil on the
circuit board. Attach the other lead to the other component spring next to the coil.

3. Arrange the circuit board so the corner with the coil is beyond the edge of the table and a
magnet dropped through the coil can fall freely.

The bar magnet will be dropped through the coil. Make sure that the magnet does not strike the
floor, or it may break.

Part III: Data Recording

1. Hold the magnet so that the south end is about 2 cm above the coil.

2. Start recording data. Let the magnet drop through the coil.

•  Data recording begins when the magnet falls through the coil and the induced voltage
reaches 0.05 volts.

•  Data recording ends automatically after 0.5 seconds.

3. Repeat data recording, but release the magnet from about 5 cm above the coil so the
magnet falls through the coil faster.

TO
CHANNEL A
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COIL

VOLTAGE
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CLIPS
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Analyzing the Data

1. Set up your Graph so it shows the area between the curve of voltage and the X-axis.

•  Hint: In DataStudio, select Area  from the Statistics menu in the Graph toolbar.

•  Hint: In ScienceWorkshop, click the Statistics button to open the Statistics area on the right
side of the graph. In the Statistics area, click the Statistics Menu button. Select Integration
from the menu.

2. In the Graph display, use the cursor to click-and-draw a rectangle around the    first peak     of
the voltage plot.

•  The Statistics will show the area under the curve for the first peak.

3. Record the value of Integration for the first peak.

4. Repeat the process to find the area under the    second peak    . Record the value.

5. Repeat the data analysis for the second run of data (magnet falling faster).

Record your results in the Lab Report section.

Ending the Activity

Equipment Clean Up

• Check with your instructor about putting away the equipment for this activity.

Computer Shutdown

When you have finished, you have several options.

1. You can select ‘Quit’ from the ‘Fil’e menu to end the activity.

2. You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this
activity. the changes you’ve made to the document.

• The original document is “locked”, so you should give     your    document a new filename.

3. If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the
document for the next activity.
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Lab Report - Activity GS29: Induction - Magnet through a Coil

What Do You Think?

The purpose of this activity is to measure the voltage created in a coil by a magnet dropping
through the center of the coil. Will the voltage be different if the magnet falls faster through the
same coil?

Data Table – Run #1

Peak Integration

First V*s

Second V*s

Data Table – Run #2

Peak Integration

First V*s

Second V*s

Questions

1. Is the first peak of flux (V*s) equal to the second peak of flux?

2. Why is the second peak taller than the first peak?

3. Why are the peaks in opposite directions?

4. How does the voltage in the second run compare to the voltage in the first run?
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Optional

Repeat the data recording and data analysis procedures for the following optional setups:

•  Tape two bar magnets together so both south ends are together.

•  Re-arrange the two bar magnets so that the south end of one is with the north end of the
other.
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Activity GS30: Photoelectric Effect
 (Voltage Sensor)

Concept DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
Nature of light GS30 Photoelectric Effect.DS G30 Photoelectric Effect G30_PHOT.SWS

Equipment Needed Qty Equipment Needed Qty
Voltage Sensor (CI-6503) 1 Optics & Alignment Kit (AP-9369) 1
Photoelectric Head (AP-9368) 1 Mercury Vapor Light (OS-9286) 1

What Do You Think?

The purpose of this activity is to measure the voltage produced when different colors of light fall
on a photoelectric tube and to find out the relationship between the wavelength of light and the
amount of voltage it produces. What do you think is the relationship between the wavelength
(color) of light and the amount of voltage it produces?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

White light (such as sunlight) is a
mixture of all the colors of light in
a rainbow. You can see the colors
of light in a rainbow by shining
white light through a prism. Each
color of light travels in a slightly
different path through the prism,
so the colors spread away from
each other when they come out of
the prism.

Red light travels through the
prism with the least amount of
change in its direction. Blue light travels through the prism and changes its direction by a greater
angle. This change in direction of the different colors of light is called dispersion. It is caused by
refraction .

Refraction happens when light is traveling through something and then meets something new. If
the light is at an angle to the boundary between the old region and the new region, the light must
change its direction as it goes through the new region.

Each color of light in the rainbow has a different amount of energy. Each color also has a certain
wavelength. Blue light has a    shorter    wavelength than red light. If a color of light that has the
right amount of energy strikes a metal surface, the light can knock electrons out of the metal.

This is called the photoelectric effect because the bits of energy that make up light are called
photons, and photons with the right amount
of energy can knock electrons out of the
metal surface (“photon-electron” or
photoelectric effect).

When electrons get knocked out of the
metal by photons of light, the metal can
produce a voltage. The amount of voltage
depends on the number of electrons that get
knocked out of the metal. The number of

WHITE
LIGHT BLUE LIGHT

RED LIGHT

PRISM

PHOTONS OF THE RIGHT ENERGY
CAN KNOCK ELECTRONS OUT OF

THE PLATE OF METAL.

PHOTONS THAT DO NO HAVE THE
RIGHT ENERGY, NO MATTER  HOW

BRIGHT, CANNOT KNOCK ELECTRONS
OUT OF THE PLATE OF METAL.
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electrons depends on the energy of the light. The energy of the light depends on the wavelength.
The color of the light tells you whether the wavelength is long or short.

Albert Einstein knew the relationship between the color of light (or its wavelength) and the
amount of energy in the light. He used the relationship between color and energy to explain the
photoelectric effect (for which he won the Nobel Prize).

Does a short wavelength color like blue light have more energy, or does a long wavelength color
like red light?

SAFETY REMINDERS

•  Follow directions for using the equipment.

•  Be careful not to touch the mercury vapor light source after it gets hot.

For You To Do

Use the Voltage Sensor to measure the voltage produced by the photoelectric effect.

Use DataStudio or ScienceWorkshop to record and display the voltage produced by each color of
light you measure. Use a plot of voltage versus wavelength (color) to find the relationship
between the voltage and the wavelength. Determine the relationship between the color of light
(the wavelength) and the amount of voltage the light produces.

PART I: Computer Setup

1. Connect the ScienceWorkshop interface to the computer, turn on
the interface, and turn on the computer.

2. Connect the Voltage Sensor DIN plug into Analog Channel A.

3. Open the document titled as shown:

DataStudio ScienceWorkshop (Mac) ScienceWorkshop (Win)
GS30 Photoelectric Effect.DS G30 Photoelectric Effect G30_PHOT.SWS

•  The DataStudio document has a Workbook display. Read the instructions in the
Workbook.

•  The ScienceWorkshop document opens with a Graph display of Voltage vs. Wavelength
and a Meter display of Voltage.

•  Data recording is set at 10 Hz. You will enter the wavelength of each color of light into
DataStudio using ‘Manual Sampling’ or into ScienceWorkshop using ‘Keyboard
Sampling’ with Parameter = Wavelength (color) and Units = nm.

•  The ‘Default Data’ numbers under ‘Wavelength’ in the DataStudio Table are the
wavelengths of the colors of light from a mercury light source. The colors of are as
follows: violet, blue, green, and yellow.

•  This table shows the wavelength for each color:

Color Wavelength Color Wavelength

violet 404.656 green 546.074

blue 435.835 yellow 576.960
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PART II: Sensor Calibration and Equipment Setup

•  You do not need to calibrate the Voltage Sensor.

 NOTE: Read the instruction manual that comes with the PASCO Photoelectric Effect
Apparatus before you do the equipment setup.

1. Install the two 9 volt batteries that come with the Photoelectric Apparatus into the battery
compartment on the apparatus.

2. Put the Photoelectric Apparatus onto the support base assembly.

3. Put the light block into the slot on the back of the mercury vapor light source.

4. Put the coupling bar assembly onto the bottom of the slot on the front of the mercury vapor
light source.

5. Put the light aperture assembly in the middle of the slot on the front of the mercury vapor
light source.

• Be sure that the light aperture assembly is lined up with the opening on the front of the
light source.

6. Put the lens/grating assembly onto the ends of the horizontal rods on the light aperture
assembly.

7. Put the hole at the end of the support base assembly over the pin on the end of the coupling
bar assembly.8. Put the Voltage Sensor banana plugs into the output jacks on the side of
the Photoelectric Apparatus.

9. Turn on the light source so it has time to warm up before you make measurements.
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Part III: Data Recording

Color Wavelength (nm)

violet 404.656

blue 435.835

green 546.074

yellow 576.960

1. Adjust the position of the Photoelectric Apparatus so that only the violet color light from
the mercury light source goes through the slot on the front of the apparatus and shines on
the photodiode tube inside.

2. Turn on the Photoelectric Effect Apparatus. Press the PUSH TO ZERO button on the side
of the apparatus.

3. Start recording data. In DataStudio, the ‘Start’ button changes to a ‘Keep’

button .

• Note: For ScienceWorkshop instructions, see the page at the end of the activity.

4. When the voltage stops going up, click ‘Keep’
to record the voltage in the Table next to the
wavelength of violet light.

•  The Table in DataStudio will show the value
of voltage for violet light in the first row.

5. Adjust the position of the Photoelectric
Apparatus so that only the blue color light
goes through the slot on the front of the
apparatus and shines on the photodiode tube
inside.

6. Click ‘Keep’ to record the value of voltage for blue light.

7. Put the green filter on the front of the Photoelectric Apparatus. Adjust the apparatus so that
only the green light goes through the slot and shines on the photodiode tube inside.

8. Click ‘Keep’ to record the value of voltage for green light.

9. Replace the green filter with the yellow filter. Adjust the Photoelectric Apparatus so that
only the yellow light goes through the slot and shines on the photodiode tube inside.

10. Click ‘Keep’ to record the value of voltage for yellow light.

11. Stop data recording

12. Turn off the Photoelectric Effect Apparatus and the light source. Remove the yellow filter.

CAUTION! The light source can be very hot. Let it cool down before you take the
apparatus apart.
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Analyzing the Data

1. Set up the Graph to show a ‘Linear’ curve fit for the voltage and wavelength data.

•  Hint: In DataStudio, select ‘Linear’ from the ‘Fit’ menu. In ScienceWorkshop, click the
‘Statistics’ button to open the Statistics area on the right side of the graph. Click the
‘Autoscale’ button to rescale the graph to fit the data. In the Statistics area, click the
‘Statistics Menu’ button. Select ‘Curve Fit, Linear Fit’ from the menu.

Answer the questions in the Lab Report section.

Ending the Activity

• Check with your instructor about putting away the equipment for this activity. Remember;
wait until the light source cools down before taking the apparatus apart.
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Data Recording ( ScienceWorkshop )

1. When you are ready, start recording data. In ScienceWorkshop, the Keyboard Sampling
window will open. Adjust its position on your screen so you can also see the Digits display
of temperature.

• The Keyboard Sampling window will open. Move it so you can see the
Digits display of Voltage at the same time.

• It may take a few moments for the voltage to reach its maximum
value.

2. When the voltage stops going up, type in the wavelength for
violet light. Click Enter  to record your typed in value.

• The Keyboard Sampling window will show your first value in the Data
list.

3. Adjust the position of the Photoelectric Apparatus so that only
the blue color light goes through the slot on the front of the apparatus and shines on the
photodiode tube inside.

4. Type in the wavelength for blue light in the Keyboard
Sampling  window. Click Enter  to record your value.

5. Put the green filter on the front of the Photoelectric
Apparatus. Adjust the apparatus so that only the green light
goes through the slot and shines on the photodiode tube
inside.

6. Type in the wavelength for green light and click Enter  in the
Keyboard Sampling  window.

7. Replace the green filter with the yellow filter. Adjust the Photoelectric Apparatus so that
only the yellow light goes through the slot and shines on the photodiode tube inside.

8. Type in the wavelength for yellow light and click Enter  in the
Keyboard Sampling  window.

• Your Keyboard Sampling window will show four wavelengths in the
data list.

9. Click Stop Sampling .

• The Keyboard Sampling window will disappear. Run #1 will appear in
the Data list in the Experiment Setup window.

10. Turn off the Photoelectric Effect Apparatus. Remove the
yellow filter.
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Lab Report - Activity GS30: Photoelectric Effect

What Do You Think?

The purpose of this activity is to measure the voltage produced when different colors of light fall
on a photoelectric tube and to find out the relationship between the wavelength of light and the
amount of voltage it produces. What do you think is the relationship between the wavelength
(color) of light and the amount of voltage it produces?

Questions

1. Based on your Graph, is the relationship between voltage and wavelength direct, inverse,
inverse square, or something else?

2. Which color produces the highest voltage?

3. Which color produces the lowest voltage?

4. Based on your data, what is the relationship between wavelength (color) and energy of the
photons?
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